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Scheduling with the Planner Views

Day-Timer Organizer has three planner views which display your schedule, things to do, upcoming 
activities, and a diary of completed tasks, calls, and expenses:

Daily Planner View - shows entries for a particular date

Weekly Planner View - shows all information for a week

Monthly Planner View - shows all information for an entire 
month

Unlike a paper planner, Day-Timer Organizer allows you to switch easily between daily, weekly, monthly 
and list views of your meetings and tasks.    You can switch instantly from big picture planning where you 
need to see a complete month display reviewing today's schedule, simply by clicking on the button for the
desired view.

When you switch from one view to another, all of your data is displayed in the new format, as appropriate.

Displaying Different Dates in Planner Views

Customizing the Display in the Planner Views

Adding Schedule Entries

Using Search Options

Scheduling Shortcuts

Printing



Managing To Do Lists

One of the handiest features of Day-Timer Organizer is its ability to help manage your list of to do items:

· current and overdue tasks, 

· multi-day schedules, 

· scheduled entries without times, 

· follow-ups, 

· etc.

In a paper system, for example, uncompleted tasks must be manually rewritten on the next day's 
schedule page.    With Day-Timer Organizer, uncompleted tasks are automatically carried forward, 
ensuring that no task is overlooked.    In addition, you can request that advance notice be provided at 
specified advance intervals to ensure that deadlines don't take you by surprise.

Tasks:
Adding a Task

Modifying a Task

Completing a Task

Advanced Task Management Features

Other To-Do List Entries:

In addition to tasks, multi-day entries, schedule entries without times and entries with followups will be displayed 
on the To-Do pane of the planner window.

Viewing the To-Do List

Viewing To Do List Items

Understanding the Display of To Do Items

Shortcuts for Managing To Do List Entries

Managing the To-Do List

Rescheduling with the Mouse

Using Search Options

Using the Task List View

Totalling Time and Expenses



Maintaining Your Address Book

Day-Timer Organizer is a powerful yet easy to use contact manager.    For each contact, it accommodates
2 addresses, up to 6 phone numbers, 4 e-mail/Web addresses, 35 pages of notes, up to 12 custom fields,
and an unlimited number of related meetings, tasks, and phone calls.

To view your address book, click on the Address Book button .

Adding an Address

Modifying an Address

Deleting an Address

Copying an Address to your Word Processor

Finding a Name

Organizing Your Address Book

Internet Access

Copying an Address to your Word Processor

Using Search Options

Printing

Sharing Entries With Others

Using the WinFax Interface



Making and Tracking Phone Calls

Day-Timer Organizer helps you manage phone calls more effective.    You can use the phone log to track 
important information on calls including date, time, duration and notes.    If you have a modem, Day-Timer 
Organizer can also dial phone numbers for you.

Setting Up to Make Calls

Dialing from your Address Book

Logging a Call

Viewing Phone Calls

Dialing Phone Numbers Embedded in Notes Text



Taking Notes

Notes can be created in two ways:

· the Notes field of entries can be used to type notes as you work on an entry

· a Note entry can be created in the Notebook view

Adding New Entries

Updating Entries

Deleting Unwanted Entries

Copying Entries to the Clipboard

Copying Text from the Clipboard into   Day-Timer Organizer  

Viewing Your Notes Entries as a List

Sorting Notes

Controlling Entry Display

Viewing the Full Text of Notes

Editing Note Text

Accessing Web Addresses Embedded in Notes Text

Dialing Phone Numbers Embedded in Notes Text



Tracking Expenses

Expenses are displayed on the planner views as well as on the ExpenseOrganizer view.    Expenses are 
shown in the Diary & Work Record pane of the daily planner view.

You can record travel expenses, entertainment expenses, and a wide variety of other expense types.    
You can group expenses by project or client, and instantly add up expenses for any project or time period 
you choose.

You can also tally time you spent on meetings, tasks, and phone calls for any project or client.    When you
provide an hourly rate, Day-Timer Organizer will multiply the time you spent by this rate to compute costs 
for any project or client. 

Day-Timer Organizer tracks two major types of expense items:

· unsubmitted expenses

· submitted expenses 

This allows you to easily manage current and outdated expense records.    

Recording an Expense

Marking Expenses as Submitted

Viewing Your Expenses

Modifying an Expense Entry

Deleting an Expense Entry

Search and Repositioning

Totaling Time and Expenses

Printing Expense Reports



Viewing Timelines and Global Lists

Day-Timer Organizer has two views that display multiple entry types in a single unbroken list 
format¾Timeline and Global views.

The Timeline view shows all date-related entries in chronological order.    It displays every occurrence of 
recurring activities, providing a complete picture as you scroll through time.    It presents an unbroken, 
easy-to-read list of activities, and is therefore sometimes more convenient than the Daily, Weekly, or 
Monthly planner views.

The Global view shows all entries (schedule, tasks, addresses, notes, phone calls, expenses, and 
messages), with recently added or modified entries at the top of the list.    Unlike the Timeline view, the 
Global view includes non-dated items (such as addresses, notes, and tasks).    This makes it ideal for 
finding everything which applies to a topic.

Viewing Timelines

Global View

Adding New Entries

Updating Entries

Deleting Unwanted Entries

Finishing Entries

Searching for Entries

Copying Entries to the Clipboard

Attaching Files to Entries



Personalizing Day-Timer Organizer

Day-Timer Organizer allows you to customize your software in a variety of ways.    

Using the Setup Menu

Many of the commands that allow you to personalize the features of Day-Timer Organizer are grouped in 
the Setup menu.    Customization options are listed below:

User Preferences lets you control week display format, alarm snooze behavior, business hours, conflict checking,
category display, password security, screen fonts, button bar layouts, and notification 
messages for schedule & task entries (multi-user database only).

Startup Screen lets you set the way Day-Timer Organizer looks when you start it (Day-Timer Organizer's size 
and position, views you want open, and size, position, and search settings for each view).

Telephone lets you adjust local area code, communications port, modem settings, frequently used dial 
codes, and DDE (dynamic data exchange) links to selected telephone systems.

Categories lets you create and maintain a list of categories for cross-referencing related information; 
allows you to set up default assignments and searches.

Assignees/Users lets you create and maintain a list of names, groups, and resources to whom entries may be 
assigned; allows you to set up default assignments and searches.

Expense Types lets you customize the list of expense types which applies to the current database.

Custom Fields lets you select names for custom database fields (Day-Timer Organizer allows up to twelve 
custom fields per entry type).

Holidays lets you select one or more countries whose holidays you wish to display, and customize the 
holiday list for any country.

Database lets you set passwords and adjust the start of your fiscal or calendar quarter.    In a multi-user 
database (workgroup system), this command also lets the Supervisor control database access 
and privilege levels.

Other Personalizing Commands

Turning On/Off Help Balloons
Saving View Settings

Saving Your Printing Settings



Printing

Before you Print:
Choosing Paper

Printer Setup

Handling Paper for Double Sided Printing

Printing:

To print from Day-Timer Organizer, click on the  button on the button bar at the top of the window or 
select Print from the File menu.    The Printing Options dialog box will appear.

Important:    Unless you have previously saved the settings, the default values displayed on the 
Printing Options dialog box reflect the settings within the Printing Options window, not the view 
that was displayed before starting to print.    

Choosing the Print Style

Setting Planner Page Options

Setting Address and Phone Book Options

Printing Mailing Labels

Printing Envelopes

Printing Rotary Cards

Printing Lists

Choosing the Data to Print
Setting Paper Options
Printing Double Sided Forms
Choosing an Alternate Font

Making It Print:    Using the Button Controls

Saving Your Printing Settings



Exchanging Data with Other Systems

This topic describes how to exchange data between your Day-Timer Organizer system and other systems
(e.g. other Day-Timer Organizer users, other organizer software programs, word processors, and external
e-mail systems).    You can import information from other systems into Day-Timer Organizer or export your
data to other systems for use with mailings or other purposes.    

How Data is Stored and Exchanged

Exchanging Data with Other External Systems

ASCII File Formats

Exchanging Data Through the Clipboard

Converting Data from other Day-Timer Databases

Connecting to External E-mail

Coordinating Data Between a Portable Computer and the Central Database



What Does Day-Timer Organizer Do?
Day-Timer Organizer is an integrated software program that complements your paper organizer, helping 
you to 

· schedule your time

· maintain contact information

· coordinate projects

· review the progress and completion of tasks, and

· track expenses. 

Developed by Day-Timers, the leader in paper-based organizers, Day-Timer Organizer combines the 
ease and take-it-with-you convenience of your paper-based organizer with the power of your computer.    
At your computer or away, you've never been so organized, so easily!

Day-Timer Organizer for Workgroups    includes additional features to

· schedule meetings and allocate tasks between several individuals

· send messages between users, and

· share key data such as contact information or notes.

Note that Day-Timer Organizer for Workgroups allows Macintosh and Windows workstations to share a 
common multi-user database over a network.



About the Online Help
This online help system is a complete manual for Day-Timer Organizer. It describes how to use all of the 
features of Day-Timer Organizer.    For installation instructions and a quick introduction to Day-Timer 
Organizer, consult the Getting Started Guide.

Related Topics:
Common Technical Questions

Technical Notes

Technical Support



Using the Day-Timer Organizer Help System
There are three main methods for receiving information about the features of Day-Timer Organizer:

· Balloon help - When you move your mouse pointer onto a button, a balloon will appear describing
the function of that button.    By default, when Day-Timer Organizer is installed, the balloon help 
feature is enabled.    If balloon help is not displayed, you can turn this feature back on by issuing 
the Help...Show Help Balloons command.    If balloon help is enabled, you can turn the feature 
off by choosing the Help...Hide Help Balloons command. 

· Online help - A complete electronic version of this manual is available through the Help menu and
can be referenced at any time.    The Help...Index command displays the main table of contents 
for the online help.    You can also press the F1 key to display the help system.    The help system 
follows the standard Windows conventions for finding information.    For more information about 
using the help system, you can choose the Help...How to Use Help command from the Windows
Program Manager.

· Status Bar - When you click on a pull-down menu item or press the mouse button down while the 
pointer is on a button, a brief description of the function appears in the status bar at the bottom of 
the screen.    To learn what each menu item does, hold down the mouse button as you drag the 
highlight across menu items.    Help text will appear on the status bar at the bottom of the Day-
Timer Organizer window.    For information about button functions, you may click on the button 
and view help text on the status bar at the bottom of the Day-Timer Organizer window.    If the 
status bar is not visible, you can turn it on with the Window...Status command.

· Time Management Tips - A collection of helpful time management tips from the experts are 
available for display in a popup window that will appear each time you start Day-Timer Organizer. 
To disable the popup display, use the Help...Display Pop-up command and deselect the Show 
popup at startup selection box.



Navigating

Selecting and Moving Between Views

Choosing Actions

Using the Menus

The Status Bar

Drag and Drop Shortcuts

Keyboard Commands



Selecting Dates and Times

Setting Dates and Times in   Day-Timer Organizer  

Selecting Dates

Setting the Date Format

Selecting Time Intervals

Adjusting a Time by a Time Interval



Views
The button bar at the top of the main screen allows you to display any view at any time.

¨ Daily Planner - shows items related to the selected date (including your schedule, to do list, upcoming 
activities and deadlines, and a work diary and record of completed tasks, phone calls and expenses).

¨ Weekly Planner - shows information related to the selected week (your schedule, tasks, contacts and notes 
with follow-up dates).

¨ Monthly Planner - shows all information related to the selected month (schedule, tasks, contacts with 
follow-up dates, and notes with follow-up dates).

¨ Group Scheduler - shows time blocked out for individuals, groups, or shared resources (such as a vehicle 
or conference room).

¨ Task List - shows jobs which must be completed by you or other individuals or groups.
¨ Address Book - shows names, addresses, telephone numbers, and supplementary notes about your 

personal and business contacts.
¨ Phone Calls - shows the date, time, and duration of calls you have made and received
¨ Notebook - shows free-form text items, such as notes, facts, ideas, plans, lists, and reports.
¨ Expenses - displays and tallies expenses you have recorded by project or by time period.
¨ Timeline - shows all date or time-related activities in chronological order, regardless of entry type.
¨ Global List - shows all dated and undated entries, regardless of type.    This makes it ideal for gathering all 

information about a subject.
¨ Messages (network version only) - shows messages between network users, including automatic 

Schedule/Task notification.



Choosing Actions
The buttons on the Actions button bar vary according to the currently active view.

¨  - creates a new entry of any type

¨  - changes the currently selected entry(s)

¨  - removes the currently selected entry(s)

¨  - completes the currently selected entry(s)

¨  - copies the current entry to the clipboard

¨  - prints planner pages, address and phone books, forms (mailing labels, envelopes, rotary cards) and 
lists

¨  - dials, times and logs a phone call

You can customize the buttons that are available on the Actions button bar.    This is particularly important
if you have a smaller size of screen and not all of the default buttons can be displayed at once.    To adjust
the button display, use the Setup...User Preferences command and choose the Button Bar option.



Using the Menus
To pull down (or retract) a menu, click on the menu title.    To select a menu item, click on that item.    
Menu commands are shown in bold in the on-line help with the menu name followed by an ellipsis (...) 
followed by the command.    For example, the Print command on the File menu is described as 
File...Print.



The Status Bar
The status bar shows:

¨ Current date and time

¨ Incoming message indicator (multi-user database only)

¨ Number of entries selected (e.g. for a modify operation)

¨ Database name (and user name if multi-user database)

¨ Name of current user (multi-user database only)

¨ Text editor (if active) line, column, and insert/overstrike settings

¨ Read-only indicator, RO (you can view but not modify this multi-user database entry)

When making menu selections, the status bar changes to display a description of the currently selected 
command.



Drag and Drop Shortcuts
Day-Timer Organizer makes extensive use of drag and drop shortcuts to simplify a variety of tasks.    

For example, to delete an item, you can drag it onto the  button.

To mark a task as completed, simply drag it onto the  button.
To reschedule an event, drag it to a new day or time.
To remove a column from the display, drag it off the window.    For example, when displaying the 
Expenses view, you might remove the date column by clicking on it and then dragging it to the side, off 
the edge of the window.
As you work with Day-Timer Organizer, you will discover that these shortcuts make it simpler to quickly 
accomplish routine chores.



Keyboard Commands
Day-Timer Organizer provides keyboard equivalents for most of its commands.    

Keyboard commands follow the standard Windows convention whereby the Alt key activates the menus.   
Underlined letters on buttons indicate that the button can be selected by holding down Alt and tapping the
underlined letter.    

For more information about using the keyboard to work in Windows, consult your system documentation.

Pulldown menu Alt + underlined letter

Select menu item Underlined letter

Exit Alt + F4

Close view Ctrl + F4

Entries:

Copy Ctrl + C

New entry Ctrl + N

Modify Ctrl + M

Phone dialer Ctrl + P

Delete entry Del

Searching:

    by word Ctrl + W

    by assignee Ctrl + A

    by category Ctrl + Y

Clear search Ctrl + S

Custom search Ctrl + Z

Find date or 
address

Ctrl + F

Apply last search Ctrl + L

TimeScan Ctrl + T

Text Editing:

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Find text Ctrl + F



Replace Ctrl + R

Delete word Ctrl + Del or Ctrl + Backspace

Delete line Ctrl + L

Insert date Ctrl + D

Insert time Ctrl + T

Insert indent Ctrl + I

Phone dialer Ctrl + P

Grow/shrink text 
window

Ctrl + G

Save entry Ctrl + Enter



Working with View Windows
Day-Timer Organizer displays information in various views.    There are views for each of the information 
entry types listed below, plus integrated views (daily planner, weekly planner, monthly planner, timeline, 
and global list) where multiple information types are presented together.    

Day-Timer Organizer views display the seven distinct types of entries that you can create:

¨ Schedule items for individuals, groups, or shared resources (e.g. appointments, meetings, etc.)

¨ Tasks to be completed by you or others (e.g. events, chores, projects)

¨ Addresses, with names, phone numbers, and extensive notes

¨ Notes, which store facts, ideas, plans, lists, or reports

¨ Phone Calls, which record information about incoming and outgoing calls

¨ Expenses, which keep track of your expenditures

¨ Messages between users (multi-user database only)

Related Topics:
Opening a View Window
Saving View Settings
Controlling the Contents of List Views
Opening Multiple View Windows
Tiling Windows
Cascading Windows
Drag and Drop Between Views
Moving a View Window
Resizing a View Window
Changing Window Sizes with the Minimize/Maximize Buttons
Closing a Single View Window
Closing All Windows



Opening a View Window
To open a view, click on the desired view's button on the View button bar.    You can open multiple views 
at the same time without losing your place (you can have the Address Book, Task/To-Do List, and Daily 
Planner open simultaneously).    You can also drag and drop information between views to create new 
schedule or task entries.

To open a second copy of any view, hold down the Shift key while you open the second copy.    You can, 
for example, open one daily planner showing your activities, and another showing others' activities.



Saving Viewing Settings
To save viewing settings, including window size and position and entry size, select the Save Settings 
command on the View menu.



Controlling the Contents of List Views
Several of the Day-Timer Organizer views list specific types of entries:    task list, address list, phone log, 
notebook, expense list, timeline and global lists.    You can control which fields are displayed on the list 
and adjust the size allowed for each column.    

To remove a column from the display, click and hold on the header at the top of the column and drag the 
column above the view window.    The cursor will change to a trash can to indicate that the column will be 
removed.    You can then release the mouse button.

Note that removing the column from the display does not delete the data or change the 
information stored in your database.    Rather, it simply adjusts what is currently displayed on this 
view.

To change the width of a column, move the cursor to the boundary mark on the header line.    The cursor 
will change to indicate that you are in resizing mode.    You can then drag the boundary to the desired new
location.

To add a column to the display, click on the  icon in the upper right corner to display a pull-down menu
of available items.    You can display any of the fields from the template for the entry type as well as any of
the custom fields for that entry type.
To move a column, simply click on the column title and drag the column to a new location.
Note that you can also print lists with your selected columns in any order.    This is discussed in Printing.



Opening Multiple View Windows
Each time you open a view in Day-Timer Organizer, a new sub-window will appear in the main Day-Timer
Organizer window.    If you open several views, there may be several windows open.

If you click on a view and there is already a window open for that view, that view window will be moved to 
the front of your display.    You can then make changes in any of the view windows and the changes will 
be saved correctly.    If you wish to have two copies of a view window at once, hold down the Shift key 
while you click on the view button, and a second window will be opened.

You can move to a different view window by clicking on the edge of the desired window or use the 
Window menu to choose another open view window.    The active window will have the title bar 
highlighted.



Tiling Windows
When you have multiple windows open, the windows usually cascade over each other.    You can choose 
the Window...Tile command to request that the windows appear beside each other, as side by side tiles.



Cascading Windows
When you have multiple windows open, the default is that the windows cascade over each other.    If you 
arranged the windows some other way, you can choose the Window...Cascade command to request that
the windows revert to the cascaded display.



Drag and Drop Between Views
If you have more than one view open at once, you can transfer information between them by simply 
dragging an entry to the desired location.    For example, if you click on a contact name in the address 
book and drag it onto your schedule, a new schedule entry will be created for a meeting with that contact. 
Dragging that address to the To Do list will create a follow-up within that entry.



Moving a View Window
To move a view, click on the title bar at the top of the view window and hold down the mouse button while 
you drag it to the desired location.



Resizing a View Window
To resize a view, position the mouse cursor over a corner or side of the window and hold down the mouse
button while you drag it to the desired size.



Changing Window Sizes with the Minimize/Maximize Buttons
Minimize and Maximize buttons on the upper right corner of each view window let you shrink or grow the 
window.    Maximizing a Day-Timer Organizer window increases the amount of information it can display.   
Minimizing a window changes it to an icon.



Closing a Single View Window
To close the active view window (or any window), 

Windows 3.x:    double click on the Control Box in the upper left corner of that window. 

Windows 95:    click in the close box in the upper right corner of that window.



Closing All Windows
When you have multiple windows open, you can close them all with the Window...Close All command to 
request that all of the sub-windows be closed.



Working with Entries
You can create seven types of entries in Day-Timer Organizer:

· schedule items (meetings, time allocated to specific projects, appointments, etc.)

· tasks

· names and addresses in the address book

· expense items

· phone call log entries

· personal notes providing additional free-form details about your schedule or projects

· messages (multi-user database only)

Creating and managing any of these entries is very similar.    To work with entries, you will usually use the 
Actions button bar.

Related Topics:
Adding New Entries
Updating Entries
Finishing Entries
Deleting Unwanted Entries
Copying Entries to the Clipboard
Attaching Files to Entries



Adding New Entries

To add an entry, click on the  button or press Ctrl N on the keyboard.    You do not need to be 
displaying the view for the entry that you wish to add.    For example, you can create entries in the 
address book while viewing the daily planner.

After you click on the  button, a pull-down menu will appear that will allow you to select the type of 
entry that you wish to create.
Once you have selected an entry type, a template for that entry will appear so that you can type the 
details.
From any view (except global view), you can double click on an empty entry and an adding template for 
that entry type will appear.    So for example, you can add tasks from the To Do list, or make address book
entries from the address book.

Related Topics:
Editing Note Text



Updating Entries
To change an existing entry, you can simply double click on that entry.    Alternately, if you have an entry 

highlighted, you can click on the  button.
You will then be given a template similar to the one that you used to add the entry and you can change 
any of the values that you wish.
When you click on OK, the updates will be saved.



Finishing Entries
Day-Timer Organizer keeps entries on your screen and carries them forward until you have marked them 
as finished.    For example, to do items will be carried forward to the next day until you indicate that they 

have been completed.    To finish an entry, click on the entry on any View screen, then click on the  
button.    Next, click on Yes to confirm that you want to mark the entry as finished. 
To finish multiple entries at the same time, press the Ctrl key while you click on each entry (to select a 
range of adjacent entries, click on the first entry, then press the Shift key while you click on the last entry).



Deleting Unwanted Entries

To delete an existing entry, click on the unwanted entry, then click on the  button or press the Del 
key on the keyboard.
You will be prompted to confirm that you wish to delete the entry.    

Once an entry is deleted, it cannot be retrieved in any way.    If you later change your mind, you 
must create the entry again.



Copying Entries to the Clipboard
You may want to use the data from a Day-Timer Organizer entry (e.g. a contact's address information) in 

another application.    To do this, click on the entry to select it and click on the  button to copy the 
entry to the system clipboard.    You can then retrieve the information in another application by using the 
Edit...Paste command.



Attaching Files to Entries
You can attach files created in other applications (e.g. word processing documents or spreadsheets) to 
any entry.    This makes it easy to view and access files related to a schedule entry, address entry, etc.

To attach a file to an entry, open the entry template, then click on the Attachments tab.    Click on the 
Attach button to specify the file name to attach.    The next dialog box allows you to specify a file name 
using the standard Windows conventions.    If you need help choosing the file, consult your Windows 
documentation.

When you click on OK, the file name will appear in the Attached Files box.    For example, there might be
two files attached, an Excel spreadsheet and a Word document.

In global list view, entries with attachments will be displayed with the



icon.

Related Topics:
Viewing Attachment Files
Removing Attached Files



Viewing Attachment Files
When an attached file name is highlighted, the icon for the program will appear at the right to indicate that
this file was made in the corresponding application.    You can click on the Launch button to run the 
application and view the document.

If no icon is displayed, there is no associated application for that file type.    Associated applications are 
set in Windows, and you should consult the Windows documentation to learn how to associate a file with 
a particular application.



Removing Attached Files
When a filename is highlighted, you can click on Detach and the file name will be removed from the 
attachments list.

Detaching a file does not delete the file.    Rather, it simply removes the link to the file in Day-Timer 
Organizer.



Setting Dates and Times in Day-Timer Organizer
The date and time displayed on the status bar is taken from the system time.    To change the system 
time, consult your Windows documentation.    By default when you open a planner view, the current date 
is displayed and if your system clock has an incorrect date, you will not see the correct date displayed.

Throughout Day-Timer Organizer, you will need to specify dates and times for scheduled events, follow 
ups, etc.    Day-Timer Organizer has several flexible methods for quickly specifying dates and times.    

As an example, consider the process of creating a schedule entry.    If you are displaying the Daily 
Planner view and the appropriate date is displayed, you can simply double click on the desired time in the
Schedule pane.    When the schedule entry is created, it will have the correct date and start time.    
However, you will probably need to set the ending time.    And if you did not have the appropriate date 
displayed, you would also need to reset the date.    

You can simply type a new date and start/end times, or you can use the  and 

 icons to the right of the date and time fields to choose the date and time.



Selecting Dates

Setting Dates from the Calendar
Setting the Date Format



Setting Dates from the Calendar
Click on the  icon next to the date field in the entry template, then click on the desired calendar date 
from the resulting window.

Alternately, you can simply type a new value into the date field.    If you type a date instead of clicking on 
the calendar, Day-Timer Organizer's smart date recognition logic (described below) can accept a wide 
variety of date formats.

Related Topics:
Typing the Date
Weekday
Time Interval



Typing the Date
As an alternative to selecting the date from the calendar, you can type the date into the appropriate field.   
Simply enter the date in your standard format¾month, day and year is the standard format in the United 
States; day, month, year is more common in Europe.    Dates with no year are assumed to be in the future
unless they fall 90 days or less before the current date.    Month, day, and year may be separated by 
blanks, dashes, slashes, or commas.    

Day-Timer Organizer has smart date recognition and recognizes most typed formats such tu for Tuesday 
or 2w for 2 weeks from today.



Weekday
A date may also be entered as a weekday.    If a weekday is not preceded by "this", "next", or "last", the 
next occurrence is assumed.    Weekdays may be represented by a single letter unless there is ambiguity 
(Tuesday/ Thursday, Saturday/Sunday), in which case two letters are needed.    Weeks start on Sunday 
(this can be set to Monday if desired, as described in    Setting User Preferences).



Time Interval
You may enter a time as the time remaining until its occurrence.    For example, "2h" means 2 hours from 
the current time.

To adjust an existing time, type a time interval preceded by a Plus (+) or Minus (-) sign to designate 
whether incrementing or decrementing.    This adjustment feature, coupled with the ability to modify 
multiple entries at once, makes it easy to reschedule large projects.



Setting the Date Format
You may choose between month/day format and day/month format.    This is a setting that you specify 
through the operating system.    Consult your computer operating manual for more instructions.

You may also wish to specify whether the week is to begin on Sunday (as in the U.S.) or on Monday (as is
done in Europe).    This is described in Setting User Preferences.



Selecting Time Intervals

Setting the Time
Setting the Time Formats



Setting the Time
To set the time in an entry, click on the  icon , then click on the desired time, then click on OK.    For 
greater precision, hold down the mouse button while you drag to the desired time.    To move through 
time, click on the left and right scroll arrows.    The ending time may be set in the same way.
Alternately, you can simply type a new time into the desired field.    Day-Timer Organizer recognizes a 
wide range of time formats.    If am or pm is not specified, Day-Timer Organizer will assume the time falls 
between 7:00am and 7:00pm.



Setting the Time Formats
Day-Timer Organizer can interpret and display time in either standard or 24-hour formats.    This is a 
setting that you specify through the operating system.    Consult your computer operating manual for more
instructions.



Adjusting a Time by a Time Interval
You may adjust an existing time of day by typing a time interval preceded by a Plus (+) or Minus (-) sign 
(e.g. +20m means 20 minutes).



Closing Day-Timer Organizer
To terminate the Day-Timer Organizer program, 

· Windows 3.1:    double click on the Control Box in the upper left corner of the window.      
· Windows 95:    click in the Close box in the upper right corner of the window.

Alternately, you can select the File...Exit command from the pull-down menus.



A Note on Data Storage
As you become more familiar with Day-Timer Organizer, you will entrust it with more important 
information.    An important feature of Day-Timer Organizer is its automatic saving feature.    When you 
enter data and click on OK, that data is automatically saved.    If your computer crashes while you are 
entering data, only the last entry will be lost.

In general, you should close Day-Timer Organizer correctly.    But if you forget or if your computer 
crashes, no data will be lost and the integrity of your existing data will always be protected.

We strongly recommend that you back up your database regularly as described in Backing Up Your
Data.    

Related Topics:
Setting Up the Day-Timer Organizer Database
Characteristics of Single-User Databases
Additional Features of Multi-User Databases
Managing Database Files



Setting Up the Day-Timer Organizer Database
When Day-Timer Organizer is installed, a set of data files, called a database is automatically created.    
Day-Timer Organizer can work with two different types of databases:

single-user Can be accessed by only one user at a 
time; this is the default type of database 
created when you install a single-user copy
of Day-Timer Organizer on a computer 
system.

multi-user Can be accessed by many users 
simultaneously.    This is the standard type 
of database for network access.

Characteristics of Single-User Databases
While you are accessing a single-user database, no other user can access that data.    Because only one 
user is permitted, single user databases do not track user names and privileges.    In a single user 
database, you can still create assignees and assign tasks to them.    However there is only one schedule 
and one set of data that is accessible to anyone who accesses the database.

You can protect the database with a password to prevent unauthorized use.    Once the database is 
accessed, however, all of the data is accessible.



Additional Features of Multi-User Databases
Multi-user databases maintain user names and privileges and acknowledge two special users, the 
Supervisor and Guest.    The user Guest is provided to allow non-members to access any data you want 
them to.    The database manager is a special privilege that is assigned to a user.

Multi-user databases also offer

· individual data areas for each user (schedule, address book, phone log, notes, expenses, etc.); 
users' data is private unless explicitly shared with other users

· the ability to send messages to other users

· the ability to arrange events that fit with several users' schedules

Related Topics:
Sharing Entries With Others

Sending Internal Messages

Coordinating Tasks with Notification Messages

Proxying for Other Network Users

Assigning Entries to Others

Group Scheduling



Managing Database Files
In general, you will use the database that was created at installation.    You should be sure to back up the 
data regularly as described in Backing Up Your Data.    If you have special requirements, you may want to 
have multiple databases or work with single-user databases that are owned by individuals on standalone 
computer systems.    Creating new databases and switching between databases is described in Working 
with Databases.    



Categorizing Your Information
Categories help you cross-reference related information.    A category may be a grouping of entries related
to a project, event, or any topic you choose.    Any entry may be filed under as many categories as you 
wish.    The Category Search option lets you view all entries assigned to a category.

Groups of categories make it easy to sort and view your choices.    A law firm, for example, might create a 
category for each of its clients, letting users click on a category group called Clients to retrieve the client 
list quickly.

Related Topics:
Setting Up a Category List
Modifying a Category
Deleting a Category

Assigning an Entry to a Category

Searching by Category
Setting a Default Category Assignment
Setting Default Category Search

Printing a List of Categories



Assigning an Entry to a Category
When you are creating or editing an entry, you can assign an entry to one or more categories by clicking 
on the Category button.    Day-Timer Organizer will show a list of categories, with a check mark by each 
category to which the entry is currently assigned.

To select or deselect a category, simply click on it.    When selection is complete, then click on OK.

To clear the current category assignment, click on the None button.    To add a category at assignment 
time, click on the Add button.

Related Topics:
Categories in the Single User Version
Categories in the Workgroup Version



Assigning Categories in the Single User Version
The single user version of Day-Timer Organizer allows you to create a list of up to 240 categories and 16 
category groups.    Groups appear at the top of your list and are marked with a  symbol.



Assigning Categories in the Workgroup Version
Day-Timer Organizer for Workgroups provides a shared category list (visible to all users) of up to 700 
categories and 48 category groups.    In addition, each network user has a personal category list (visible 
only to them) of up to 240 categories and 16 groups.    Groups appear at the top of shared and personal 
lists.



Setting Up a Category List
To create or modify a list of categories, pull down the Setup menu and select Categories.    Day-Timer 
Organizer will display your current category list (which initially is empty).

The category list contains both individual categories and groups of categories.    For example, you might 
have categories for mutual fund information, real estate and 17th century drawings, as well as a category 
group called investments which included the three categories.

Related Topics:
Adding a Category
Adding Category Groups
Shared vs. Private Categories (multi-user database only)
Printing a List of Categories



Adding a Category
To add a category, begin by select the Setup...Categories command.    Alternately, you can simply click 
on the Category button when adding or editing another entry (e.g. an address or task).    In either case, 
click on the Add button.    You must then choose from the pull-down menu whether this is a category or a 
category group.    Click on Category to create a new category.    

Type a name (up to 20 characters).    You may also type a description, which will be displayed whenever 
you move the mouse cursor over this category (this field helps users remember what categories mean).    
If this category is to be a member of an existing category group, click on the Assign to Groups button 
and choose the group(s) of which it is a member.

When finished, click on OK.



Adding Category Groups
A category group allows you to collect several individual categories.    For example, if you work on several 
projects for two different departments, you might have a category for each project and a category group 
for each department.    

To add a category group, begin by select the Setup...Categories command.    Alternately, you can simply 
click on the Category button when adding or editing another entry (e.g. an address or task).    In either 
case, click on the Add button.    Choose Category Group from the pull-down when you are adding, then 
click on the Choose Members button and click on each category you want to make a member of this 
group (you may change membership at any time).    When finished, click on OK.

Category groups appear at the top of your list and are marked with a  symbol.
Any category you add will be automatically included in your default search (entries you see when no 
search is set - see Setting Default Category Search).    If you prefer not to view entries for this category 
unless you search for them, click on the Default Search Show button, deselect the new name, and then 
click on the Default Search Set button.



Shared vs. Private Categories (multi-user database only)
Day-Timer Organizer for Workgroups lets you designate the new category or group as personal or 
shared.    Shared categories are visible to all users, but personal categories are private to each user.    The
adding process is the same except that you must select whether the category is personal or shared when 
you create it.

Any user may add or delete their own personal categories, but only the supervisor or the database 
manager (or designated alternate) may add or delete shared categories.



Modifying a Category or Category Group
To change the characteristics of a category or category group (e.g. name, description, or membership 
settings), begin by select the Setup...Categories command.

To modify a category, click on that category or group in the Category Setup dialog box.    Next, click on 

the  button, and make desired changes.
To change a category group's name, description, or membership settings, click on the group in the 
Category Setup dialog box.    Another dialog which will allow you to click on the group check box to select

the group itself (rather than members), and click on OK.    Next, click on the  button, and make the 
desired changes.
To change an item from a category to a group (or vice versa), or from Personal to Shared (or vice versa),
delete the item and re-add it.



Deleting a Category

To delete a category, click on that category in the Category Setup dialog box, then click on the  
button.

In order to delete a category:

¨ there must be no entries assigned to that category

¨ it must not be part of your (or any other network user's) default assignment (see Setting a Default 
Category Assignment); you will be warned if you try to delete such a category

To find out whether there are entries assigned to a category you wish to delete, open the Global view and 
search by that category.    (Searching is described in detail in Searching.)    If you find entries, you may 
either delete them or reassign them (the Select All option on the Edit menu selects and then 
Edit...Modify Entry lets you reassign or delete multiple entries).



Setting a Category Default Assignment

When you add a Day-Timer Organizer entry, it will have no category assignment unless you click on the 
Category button and assign it to a category.    If you wish, however, you may set a default category 
assignment for new entries.

To begin, select the Setup...Categories command.    Then to view your default assignment, click on 
Default Assignment Show in the Category Setup dialog box.    Day-Timer Organizer will show selection 
check marks next to each category in your default assignment.

To set your default assignment, click on categories or groups you wish to select (or deselect) for default 
assignment, and then click on the Default Assignment Set button.



Printing a List of Categories
From the Category Setup dialog box, simply click on the Print button to print a list of categories.    You will 
see a standard print dialog box and when you click on OK, the list will be printed on the selected printer.



Assigning Entries to Others
Day-Timer Organizer lets you schedule meetings for others, delegate tasks, or assign addresses and 
notes to different users.    You may assign any entry to as many individuals, groups, or resources (e.g. 
conference rooms) as you wish, and you can search for entries by assignee.

Day-Timer Organizer is available in both single user and workgroup versions.    If you are using the single-
user version of Day-Timer Organizer, this is useful for helping you keep track of who has been assigned 
to work on specific tasks.

You can assign entries to:
An Assignee Other people; if you have a multi-user system, these

assignees will be notified that you have assigned 
something to them.

An Assignee 
Group

A group of people; for example, you might create a 
note item for minutes of a QA meeting and assign it 
to the QA task team (a group consisting of several 
assignees).    Assignees can be members of as 
many groups as you like.

Additional Assignees for Workgroup Users

Day-Timer Organizer for Workgroups allows multiple users to share a database.    Anyone you schedule 
for a meeting or assign a task with the network version will be automatically notified of the assignment, 
and will see the meeting or task on their Day-Timer Organizer screens.

An activity assigned to a group need be entered only once, yet it will appear on the agenda of each group 
member if you are using Day-Timer Organizer for Workgroups.    You can assign entries to assignees and 
asignee groups as for the single user version, but also to the following:

A Resource Some resource that you wish to schedule; for 
example, you might be able to schedule a 
conference room, a special projector, company 
vehicles, portable computers that are loaned to 
individuals, etc.

A Resource 
Group

A group of resources; for example, you might 
schedule an in-house workshop and allocate all of 
the conference rooms for that use.

A User Another network user; if you have a multi-user 
system, these assignees will be notified that you 
have assigned something to them.    Only the 
Supervisor can create users because they are 
visible to all Day-Timer Organizer users that are 
sharing a multi-user database.

A User Group A group of people, similar to assignee groups.      
Only the Supervisor can create user groups 
because they are visible to all Day-Timer Organizer 
users that are sharing a multi-user database.

Related Topics:
Assigning an Entry to Someone Else



Assignee Lists in the Single User Version
Assignee Lists in the Network Version
Setting Up an Assignee List
Adding a Name or Group
Changing a Name
Deleting a Name
Setting Default Assignment



Assigning an Entry to Someone Else
When you create a new entry, the Assign To value is initially set to your user name.    To assign an entry 
to someone else, click on the Assign To button on the entry template.    Day-Timer Organizer will show a 
list of names, with a check mark by each current assignee.

To clear the current assignment (normally your name), click on the None button.

To select or deselect a name, click on it.    Names that have check marks displayed beside them are 
currently selected.

To add a name to the list, click on the Add button.

When selection is complete, click on OK.



Assignee Lists in the Single User Version
The single user version of Day-Timer Organizer allows you to create a list of up to 64 names and 16 
groups to which entries may be assigned.    Groups appear at the top of your assignee list.



Assignee Lists in the Workgroup Version
Day-Timer Organizer for Workgroups  provides a shared assignee list (visible to all users) of up to 720 
individuals and 48 groups.    In addition, each network user may have a personal assignee list (visible only
to them) of up to 64 names and 16 groups (such as family members or friends).    Groups appear at the 
top of shared and personal assignee lists.



Setting Up an Assignee List
To create or modify a list of individuals and groups to whom entries may be assigned, pull down the 
Setup menu and select Assignees/Users.    Day-Timer Organizer will display your current assignee list 
(which initially will include only you).    You may then add a name or group.



Adding a Name or Group

To add a name, group, or resource, click on the  button in the Assignee Setup dialog box.  
From the pull-down menu, select Assignee or Assignee Group.
Type a name (up to 12 characters).    You may also type a Description, which will be displayed whenever 
you click on this item.
If adding a group, click on the Assignee Group selection from the pull-down menu when beginning to 
add the entry, then click on the Choose Members button and click on each person who will be a member 
of the new group (you may easily change this later).    When a member is selected, a check mark will 
appear beside their name.    When finished, click on OK.
Any name you add will be automatically included in your Default Search (entries you see when no search
is set - see Setting Default Assignee Search).    If you prefer not to view entries for this name unless you 
search for them, click on the Default Search Show button, deselect the new name, and then click on the 
Default Search Set button.

Workgroup Version Differences
Day-Timer Organizer for Workgroups lets you designate the new name as personal or shared.    Shared 
assignees are visible to all users, but personal assignees (e.g. family members or friends) are private to 
each user.

Any user may add or delete personal assignees, but only the database manager (or other designated 
user) may add or delete shared names.

Day-Timer Organizer for Workgroups allows you to choose from

Personal Assignee

Personal Assignee Group

Resource

Resource Group

User

User Group

The last four are shared information.    The Personal Assignee/Groups cannot be seen by other users, 
even if the entry itself is shared.



Changing a Name
To change an individual's name, description, or membership settings, click on that name in the Assignee 
Setup dialog box.    Next, click on the Modify button, and make desired changes.

To change a group's name, description, or membership settings, click on the group name in the Assignee
Setup dialog box.    Click on the group check box to select the group itself (rather than or in addition to 
members), and click on OK.    Next, click on the Modify button, and make desired changes.

To change an item from a name to a group (or vice versa), or from personal to shared (or vice versa), 
delete the item and re-add it.



Deleting a Name
To delete a name, click on that name in the Assignee Setup dialog box, then click on the Delete button.

In order to delete a name:

¨ there must be no entries assigned to that name

¨ it must not be part of your (or any other network user's) default assignment (see Setting Default 
Assignment)

¨ it must not be associated with a network user.

To find out whether there are entries assigned to a name you wish to delete, open the Global view and 
search by that name.    If you find entries, you may either delete them or reassign them (the Select All 
option on the Edit menu lets you reassign or delete multiple entries).



Setting Default Assignment
When you add a Day-Timer Organizer entry, it will automatically be assigned to you unless you click on 
the Assign To button and assign it to someone else.

If you are a secretary or administrative assistant who normally works with another person's entries, you 
may wish to reset your default assignment option to that person or people.

To view your default assignment, click on Default Assignment Show in the Assignee Setup dialog box.  
Day-Timer Organizer will show selection arrows next to each name in your default assignment.

To reset your default assignment, click on names or groups you wish to select (or deselect), and then click
on the Default Assignment Set button.



Searching and Repositioning
Day-Timer Organizer's searching capabilities help you find data quickly.    Searching narrows your 
viewing focus, filtering out entries which do not conform to your search settings.    A complete list 
of search options is available on the Search menu.    Not all searching options are available from all 
views, as appropriate.

In addition to search options, Day-Timer Organizer provides commands which let you reposition the 
display.    Unlike search options, which filter out non-conforming data, repositioning options move the 
display to the desired location. 

You may use any search option separately, or you may combine search options for pinpoint precision.

The scope of a search is limited to the active view window.    This lets you have multiple windows open - 
each with a different search.

If there are entries which do not fit on screen, use the scroll bar to view them.    To advance the daily, 
weekly, and monthly planner view to the next date which contains entries conforming to the current 
search, use the TimeScan option.

For the broadest possible search, select the global list view, which displays all Day-Timer Organizer 
entries (schedule, tasks, addresses, notes, expenses, phone calls, and messages), whether or not they 
are date-related.

Related Topics:
Clearing Search Settings
Copying Search Settings
Saving Search Settings
Using Boolean Operators

Button Search Type Effect
By Word or Word 
Beginning

shows entries containing 
selected words (or word 
beginnings) in any note, 
address, or custom fields

By Assignee shows entries assigned to 
selected users, individuals, 
groups, or resources; you can 
also specify a Default Assignee 
Search

By Category shows entries filed under 
selected categories; you can 
also specify a Default Category 
Search

By Priority shows tasks within selected 
range of priorities

Custom shows entries that match the 
criteria set by the user (address 
list only)

By Entry Type shows only entries of the 
selected type (schedule, task, 
address, note, expense, phone 



call, or message)
By Call Status shows phone log entries by 

status (such as all calls you did 
not complete)

By Expense Type shows expenses of any selected
type (such as Entertainment)

Clear Search Settings clears all previous search 
settings

Repositioning Options:
Button Option Effect

TimeScan on daily, weekly, or monthly 
planner, scans for next (or 
previous) date with entries 
conforming to search settings.

Find Date

Find Other (Name, 
Organization, Zip Code)

In views sorted by date:
repositions view to selected date
In views sorted by other field:
repositions address book to the 
name, organization, or zip code 
(depending on sort setting) 
beginning with characters you 
type

Clearing Search Settings
Search settings remain in effect until you either clear them or close the view to which they apply.    When 
you activate a search, its button on the button bar looks as though it is pressed down.    This serves as a 
reminder that the search is still active.

Important: If you forget to clear search settings, entries which would otherwise be displayed may appear 
to be missing.

To clear all search settings for the active window, click on the  button on the Search button bar.    
Alternately, you can select Clear Search from the Search menu.
If there are multiple search settings in place, you may clear one search setting without affecting others by 

selecting the setting you wish to clear and clicking on  in that search's dialog box.



Copying Search Settings
Search settings in each view are independent of those in other views.    This lets you open a new view 
without losing your place in the previous one.    To copy your search settings from a previous view into the 
current view, select Apply Last Search from the Search menu.



Saving Search Settings
To save your search settings, select the Save Settings command on the View menu and click on the 
Include Search button.    This will save the search settings so that they are automatically applied when 
you start Day-Timer Organizer.    You must then Clear Search Settings explicitly or re-save your settings 
when you no longer wish the search to be applied.



Performing Custom Searches

In the Address List view, a simple way to search is to click on the   button on the Search button bar 
or choose the Search...Custom Search command.    From the dialog box, fill in the value to be searched 
for, in the appropriate field.
When you click on OK, the screen will change to show only data that matches your search criterion.
The custom search feature is a very powerful way to search by any combination of values in any fields.

Related Topics:
Clearing Search Settings
Copying Search Settings
Using Boolean Operators
Saving Search Settings



Searching for Words

To find all entries containing words beginning with any characters you type, click on the  button, type 
the desired character(s), and click on OK.    Note that you must type at least two characters or the search 
will assume that you are looking for whole words (e.g. the words "a" or "I").
Day-Timer Organizer will scan for all entries in the active view containing words beginning with these 
characters in the note, address, or custom fields.    Keyword search is not case sensitive    capital letters 
are not distinguished from small letters.

Related Topics:
Partial vs. Whole Words
Searching for Multiple Words
Changing a Word Search Setting
Finding Search Text in Entries

Speeding Up Word Search

Clearing Search Settings
Copying Search Settings
Using Boolean Operators
Saving Search Settings



Partial vs. Whole Words
By default, Day-Timer Organizer scans for entries which contain any words beginning with characters you
type.    To search for whole words only (e.g. find "cat" but not "catastrophic"), click on the Whole Word 
check box.



Searching for Multiple Words
You can combine words using the and, or, and not operators.    To search for entries containing either 
"attorney" or "lawyer" but not "patent", type "attorney or lawyer not patent".    For grouping purposes, 
words on the left take precedence over those on the right.    This means that "Alan and Bob or Chris" is 
interpreted as "Alan and Bob" or "Chris", rather than "Alan" and "Bob or Chris".    To achieve the latter 
meaning, use parentheses to designate "Alan and (Bob or Chris)".



Changing a Word Search Setting
To revise an existing word search setting, reselect the Word search option and enter new text.    Previous 
text will disappear as soon as you type the first character of its replacement (to edit the previous text, 
move the cursor prior to typing).    To retrieve search text you typed earlier, click on the down arrow to the 
right of the text field and select text.



Speeding Up Word Search
As you accumulate text in your database, word search time may become unacceptably long.    This 
happens because Day-Timer Organizer uses an index for searching which periodically should be updated
to speed searching.

Whenever Day-Timer Organizer detects that your text search time could be shortened, it will notify you 
that you need to reindex your text in the Word Search dialog box.    Reindexing can cut search time 
dramatically (to just a few seconds, no matter how large your database), and you may also choose to 
reindex periodically (without being prompted by Day-Timer Organizer) by selecting Speedup Text Search
from the Tools menu.

Text indexing will increase the size of your database by approximately 20 percent, but is well worth it for 
most users (and nearly imperative for large network databases).    An additional index file will also be 
created in the database files directory.

Text indexing is time-consuming, and should be done during a lunch hour or overnight.    Although you can
press Esc to interrupt indexing at any time without losing your progress, you will not notice a search 
speedup until indexing finishes.    Do not turn your computer off while indexing is in progress.



Finding Search Text in Entries
To find your search text in any entry, double click on the entry, then press the right mouse button over the 
Notes field.    Select Find Text, in the popup menu, then click on the Find Next button in the dialog box.    

Day-Timer Organizer will show the first occurrence of the search text.    If the search box obscures the 
text, click on the title bar and hold down the mouse button while you drag it to the desired location.    To 
find the next occurrence, click on the Find Next button again.



Searching by Category
Category search lets you view entries by topic.    If, for example, you file sales-related entries under 
category Sales, searching by this category lets you view these entries quickly.    A category may be a 
grouping of the entries associated with a project, event, or any topic you choose.

To search for entries assigned to one or more categories, click on the  button.    Day-Timer Organizer 
will present a list of categories.    If there are categories which do not fit in the window, you may click on 
the horizontal scroll bar to view them.
To select or deselect a category, click on that category.    When selection is complete, click on OK.

Related Topics:
Selecting or Clearing All Categories
Viewing Current Search Settings
Groups of Categories
Using Boolean Operators

Clearing Search Settings
Copying Search Settings
Saving Search Settings



Selecting or Clearing All Categories
To set selection check marks for all categories, click on the All button.    To clear selection check marks for
all categories, click on the None button. 



Viewing Current Search Settings
To view current search settings, click on the Show Search button, and then on OK.    This is useful if you 
have forgotten what search settings are currently in effect or if you are using saved settings that were set 
at a previous time.



Groups of Categories
Groups of categories are designated by a group icon.    If you select a group, Day-Timer Organizer will 
present a list of member categories.

To select any member of a category group, click on it.    To select all member categories, click on the All 
button.    To search for entries assigned to the group itself, click on the group check box in the upper left 
corner.



Using Boolean Operators
When you search by multiple values, Day-Timer Organizer finds entries assigned to any of the specified 
values.    To find entries assigned to every value, click on the Boolean button and select All of selected 
items.    To find entries not assigned to any selected category, click on the Boolean button and select 
None of the selected items.



Setting Default Category Search

Default Search is the combination of categories whose entries you normally wish to view.    If a category 
is excluded from your default search, entries assigned only to this category will be filtered out until you 
request to view them with the Search By Category option.

To view your default search, click on the Default Search Show button in the Category Setup dialog box.   
Day-Timer Organizer will show selection arrows next to each category and group included in your default 
search.

To reset your default search, click on categories or groups you wish to select (or deselect), and then click 
on the Default Search Set button.    To set or clear selection arrows for all categories, click on All or 
None buttons.    When you click on a group, Day-Timer Organizer will present a list of members (to select 
the group itself, click on the group check box at the upper left corner of the members box).



Searching by Assignee/User
When you search by assignee, Day-Timer Organizer displays entries assigned to the individual(s) or 
groups you select.

To search by assignee, click on the  search button, or select Search By Assignee/User from the 
Search menu.    Day-Timer Organizer will present a list of individuals, groups, and resources.    If there are
items which do not fit in the window, you may click on the horizontal scroll bar to view them.
To select or deselect a name, click on that name.    When selection is complete, click on OK.

Related Topics:
Selecting or Clearing All Assignees
Viewing Current Search Settings
Selecting a Group
Using Boolean Operators

Clearing Search Settings
Copying Search Settings
Saving Search Settings



Selecting or Clearing All Assignees
To set selection arrows for all names, click on the All button.    To clear selection arrows for all names, 
click on the None button. 



Viewing Current Search Settings
To view current search settings, click on the Show Search button, and then on OK.    This is useful if you 
have forgotten what search settings are currently in effect or if you are using saved settings that were set 
at a previous time.



Selecting a Group
If you select a group (designated by a  icon), Day-Timer Organizer will present a list of members.    To 
find entries assigned to any member (including entries assigned to any group to which they belong), click 
on that member.    To select all members, click on the All button.
To find entries assigned to the group itself, click on the group check box in the upper left corner.    



Using Boolean Operators
When you search by multiple names, Day-Timer Organizer finds entries assigned to Any of the selected 
items.    To find entries assigned to every selected name, click on the Boolean button and select All of 
the selected items.    To find entries not assigned to any selected name, click on the Boolean button and
select None of the selected items.



Setting Default Assignee Search
Until you specify otherwise, searching works on the default search, which is initially set to search for all 
individuals and groups.    If you are using Day-Timer Organizer for both your own activities and those of 
others, you might set the default search to display only your own entries, filtering out everyone else's 
entries until you request to view them with Search By Assignee/User.

To view your default search, click on the Default Search Show button in the Assignee Setup dialog box. 
Day-Timer Organizer will show selection arrows next to each name and group included in your default 
search.

To reset your default search, click on names or groups you wish to select (or deselect), and then click on 
the Default Search Set button.    To set or clear selection arrows for All individuals and groups, click on 
All or None buttons.    When you click on a group, Day-Timer Organizer will present a list of members (to 
select the group itself, click on the group check box at the upper left corner of the members box).



Searching by Priority
Searching by priority lets you view tasks with selected priorities.    To search by task priority, click on the

 button.    Day-Timer Organizer will prompt you first for the highest priority desired, and then for the 
lowest.
You may use Number Based (1-9), Letter Based (A-I), or Hybrid (A1-I9) priorities.    If you use hybrid 
priorities and type a letter without a number, Day-Timer Organizer will find All priorities beginning with that
letter.
To view tasks which have no priorities, select None for both ends of the range.

Related Topics:
Clearing Search Settings
Copying Search Settings
Using Boolean Operators
Saving Search Settings



Searching by Entry Type
In views which can display more than one entry type (daily, weekly, monthly, messages, timeline, and 
global), searching by entry type lets you restrict display to the desired entry types.

To search by entry type, click on the  search button, then click on undesired check boxes, then click 
on OK. 

Related Topics:
Searching by Call Status
Searching by Expense Type

Clearing Search Settings
Copying Search Settings
Using Boolean Operators
Saving Search Settings



Searching by Call Status
When searching by entry type, you can further refine your search to view phone log entries on the basis 

of call status.    To do this, click on the  search button, then click on desired call status check boxes.    
In the example below, Day-Timer Organizer will display phone log entries that may require additional 
action on your part. 

Related Topics:
Clearing Search Settings
Copying Search Settings
Using Boolean Operators
Saving Search Settings



Searching by Expense Type
Another alternative when searching by entry type is to refine the search to view expense entries by type.   

To do this, click on the  search button, then click on undesired expense type check boxes.    In the 
example below, Day-Timer Organizer will display only entertainment expenses.

Related Topics:
Clearing Search Settings
Copying Search Settings
Using Boolean Operators
Saving Search Settings



TimeScan
TimeScan advances the daily, weekly, or monthly planner to the next date containing entries conforming 
to current search settings.    This allows you to set a search filter (e.g. a project name), and then step 
forward or backward through time to find each page which contains conforming entries.    To use this 
feature, set desired search (to find when the PCExpo conference starts, for example, use a Word search 

for PCExpo).    Then click on  or select TimeScan from the Search menu.    To scan forward through 
time, click on Forward.    To scan backward, click on Backward.
As a result of this command, you will be brought to the next day/week/month where an entry occurs.
Note that this simply moves you to the requested time; it does not set a search filter or exclude any data.



Find Date
This option, which is available in all views which are sorted by date, repositions the view to the date you 

choose.    To select this option, click on  or choose Find Date from the Search menu.    You may 
either type the desired date, or click on the date icon and select the date from the calendar with the 
mouse.
As a result of this command, you will be brought to the next day/week/month where an entry occurs.
Note that this simply moves you to the requested time; it does not set a search filter or exclude any data.



Find Name (Organization, Zip Code)
This option (available only in the address book), repositions to the name, organization, or zip code 
(depending on how your address book is sorted) which begins with the characters you type.

To select this option, click on  or choose the Find command from the Search menu and type the first 
few characters of the name, organization, or zip code you want to find.    Whether this command operates 
on Name, Organization, or Zip Code, depends on how the address book is sorted.
As a result of this command, you will be brought to the next day/week/month where an entry occurs.
Note that this simply moves you to the requested time; it does not set a search filter or exclude any data.



Linking Entries
Day-Timer Organizer makes it easy to create links between entries, allowing you to view related entries 
and quickly move between.

Note: In addition to the direct links discussed here, you may create indirect links between related entries 
by filing them under the same category.    

Links between entries may be created either automatically or manually.

Automatic links between entries are created whenever you add an entry via Day-Timer Organizer's drag 
and drop capabilities.    If, for example, you create a meeting by dragging an address to the daily planner's
schedule pane, the address and meeting will be automatically linked (for more information about drag and
drop, see Scheduling Shortcuts).    Automatic links are also created when you add an entry from within the
Meetings or Phone Calls sections of an address entry template (see below).

You may also link two entries Manually.    To do so, proceed as follows:

¨ Click on the first entry to select it on any view screen.

¨ Select Link Entry from the Edit Menu.

¨ Click on the second entry (which need not be on the same view).

To View a list of entries which are linked to a particular entry, double click on the entry, and then click on 
the Linked Entries tab.    To add a new linked entry, click on the New Item button.    To modify or view 
details for any linked entry on the list, click on that entry, then click on the Modify Item button.

To delete any linked entry, click on that entry, then click on the  button.
To sever the link between the current entry and any linked entry, click on that entry, then click on the 
Break Link button.
In the global list view, entries that have links will be displayed with the



icon.

Related Topics:
Displaying Multiple Linked Entries



Displaying Multiple Linked Entries
When working with linked entries, you may need to display more than one view at a time.    Working with 
multiple windows is discussed in Working with View Windows.



Daily Planner View

To display the Daily Planner view, click on the  button.
There are four panes on the Daily Planner window (Schedule, To Do, Upcoming and Diary&Work 
Record).    If there are too many entries to fit in a pane, a scroll bar will appear next to the pane.    To view 

the additional entries, either click on the scroll bar or expand the pane with the Maximize button  at 
the top of the pane.    To restore it to its normal size, click on the Restore button 

.
In addition, you can remove the display of the current month's calendar at the left of the window by 
selecting the View...Hide Calendar command from the menu.    To restore the calendar display, use the 
View...Show Calendar command.

Related Topics:
Schedule Pane
To Do Pane
Upcoming Pane
Diary & Work Record Pane

Adding New Entries
Updating Entries
Finishing Entries
Deleting Unwanted Entries

Displaying Different Dates in Planner Views

Customizing the Display in the Planner Views

Using Search Options

Printing

Scheduling Shortcuts

Saving View Settings



Schedule Pane
The Schedule pane shows entries you have scheduled on the calendar date.    Entries must have a 
beginning and ending time before they will be displayed on this pane and this pane automatically moves 
through time as the day progresses.    To move forward or backward through time, click on the scroll bar 
next to the timeline.    As you drag the thumb on the scroll bar, Day-Timer Organizer will show the time of 
day corresponding to the thumb position.

Note that the time scale on the schedule pane is adjustable and removable (see Adjusting Schedule Time
Scale).

Note that the time and time format displayed on the schedule pane are shown according to the system 
settings (i.e. a 12-hour format or a 24-hour format).    Consult your system documentation for additional 
information.



To Do Pane
The To Do pane shows:

¨ Tasks which are due on the selected calendar date

¨ Address or note entries with Follow-Up set for the selected calendar date

¨ Schedule entries without times (e.g. birthdays)

¨ Any overdue tasks

For more information, see Managing To Do Lists.

If there are too many entries for the space, a scroll bar will appear to allow you to move through the list.    
To enlarge the size of the pane, click on the heading bar of the Diary & Work Record pane and drag it 
down the page.    This will enlarge the To Do pane and shrink the Diary and Work Record pane.



Upcoming Pane
The Upcoming pane shows upcoming activities or deadlines for which Advance Notice has been set.    For
example, a task due October 15 with advance notice set to one week will appear as an upcoming activity 
between October 8 and October 14.

Advance notice may be set for schedule entries, tasks with due dates, and address or note entries which 
have follow-up dates.

To enlarge the size of the pane, click on the heading bar of the Upcoming pane and drag it up the page.   
This will enlarge the Upcoming pane and shrink the Schedule pane.



Diary & Work Record Pane
The Diary & Work Record pane shows things you accomplished during the day, including completed 
tasks, any phone calls you logged, and any expenses you recorded.    Any event that is dragged to this 
pane is considered to be finished and will no longer be carried forward to future days' schedule displays.   
Double clicking on an entry in this pane allows you to adjust or specify the finish date.

All of the current day's expenses will appear on this pane, with submitted expenses marked with an 
asterisk (*).

To enlarge the size of the pane, click on the heading bar of the Diary & Work Record pane and drag it up
the page.    This will enlarge the Diary and Work Record pane and shrink the To Do pane.



Weekly Planner View

To display the Weekly Planner View, click on the  button.    This display shows the current week.
Each day of the week has a pane, similar to the separate panes on the daily planner view.    To view 
additional entries for a specific day, either click on the scroll bar or expand the pane with the Maximize 

button  at the top of the pane.    To restore it to its normal size, click on the Restore button 

.
In addition, you can remove the display of the current month's calendar at the left of the window by 
selecting the View...Hide Calendar command from the menu.    To restore the calendar display, use the 
View...Show Calendar command.

Adding New Entries
Updating Entries
Finishing Entries
Deleting Unwanted Entries

Displaying Different Dates in Planner Views

Customizing the Display in the Planner Views

Using Search Options

Printing

Scheduling Shortcuts

Saving View Settings



Monthly Planner View
To view the Monthly Planner view, click on the  button.    This displays shows an entire month.    The 
calendar can be displayed in 5-day or 7-day format, depending on how you have specified Controlling the 
Display of the Calendar Week .

Adding New Entries
Updating Entries
Finishing Entries
Deleting Unwanted Entries

Displaying Different Dates in Planner Views

Customizing the Display in the Planner Views

Using Search Options

Printing

Scheduling Shortcuts

Saving View Settings



Adding Schedule Entries
To schedule a meeting or block out time for an activity, first click on the     button on the Actions 
button bar.    A pull-down menu will appear that allows you to specify what you wish to add.
Click on Schedule.    Day-Timer Organizer will present a template.    Alternatively, you may use the 
Edit...New Entry command and choose Schedule from the sub-menu.
You can fill in as much or as little information as you wish.    Typically the minimum required information is 

· the correct date

· the start and end time, and 

· a description of the activity that you are scheduling.

Once you have filled in all of the information, click on OK to save the entry.

If you do not enter a time, then the schedule entry will be displayed on the To Do pane of the currently 
selected date, rather than on the schedule.    This is useful for events like birthdays, conferences, trips, 
vacations and project deadlines.

When all of the data has been entered, click on OK to save the entry.

Related Topics:
Editing Note Text

Setting the Date
Setting the Begin and End Time

Editing Note Text

Birthdays and Anniversaries
Trips, Conferences, and Vacations (Multi-Day Events)
Recurring Activities
Pop-Up Alarm
Advance Notice
Purge After 60 Days

Scheduling Activities for Someone Else
Categorizing Your Information
Checking for Schedule Conflicts

Custom Fields 

Linking Entries
Shortcut Buttons



Describing the Activity
You can type up to 35 pages of description in the Notes section.    To Expand the note window (or restore 

it to its normal size), click on the  button at the bottom of the scroll bar.    For a menu of editing 
features, click on the right mouse button when the mouse pointer is positioned over the text or click on the

 icon at the bottom of the scroll bar.



Setting the Date

Click on the     icon next to the date field, then click on the desired calendar date from the resulting 
window.

Alternately, you can simply type a new value into the Event Date field.    Day-Timer Organizer's smart 
date recognition accepts most typed formats, such as "tu" for Tuesday or "2w" for 2 weeks from today.



Setting the Begin and End Time
To set the beginning time, click on the clock next to the Begin Time field  , then click on the desired 
time, then click on OK.    For greater precision, hold down the mouse button while you drag to the desired 
time.    To move through time, click on left and right scroll arrows.    The ending time may be set in the 
same way.
Alternately, you can simply type a new time into the Begin Time and End Time fields.    Day-Timer 
Organizer recognizes a wide range of time formats.    If am or pm is not specified, Day-Timer Organizer 
will assume the time falls between 7:00am and 7:00pm.    Day-Timer Organizer's smart time recognition 
accepts most typed formats, such as "1h" for one hour.



Displaying Different Dates in Planner Views
By default, when you open a planner view, the current day/week/month will be displayed.    You can easily 
change the display to show any day, month or year that you wish to see (the equivalent of flipping pages 
in your paper system).

You can move the display forward or back by one day (Daily Planner view) or one week (Weekly Planner 

view), by clicking on the upper right or upper left page corners  on the planner pages, as shown 
below.

On the Monthly Planner view, you can click on the scroll bar to display different months and years.    Each 
click moves the display by one week.

To move forward or backward by months or years, click on the  or 

 buttons respectively under the planner window.    To return to today's date, click on the Today 
button.

To move through larger time intervals, click on the     button on the Search button bar and type the 
desired date.



Trips, Conferences, and Vacations (Multi-Day Events)

To enter a multiple day event such as a trip or vacation, begin by clicking on the     button and 
selecting Schedule.    From the template, click on the 

 button.    Next, set the Start Date and End Date fields.    
Once you have scheduled the event, it will appear on your schedule on all of the days that you have 
requested.    On the daily planner view, these will be displayed on the To Do pane.    If you wish them to 
appear on the daily schedule, simply create a schedule entry and set it to be recurring.



Recurring Activities
To schedule a recurring activity, when you are creating the entry, simply click on the  button.    Next, 
click on the frequency of recurring activity you want.

¨ Daily events occur every day.

¨ Weekly events occur on one or more weekdays (e.g. Tuesday and Thursday).

¨ Biweekly events occur every other week on one or more weekdays (e.g. Tuesday and Thursday).

¨ Monthly events can be a date (e.g. the first of each month) or an occurrence of a weekday (e.g. 
the 2nd Tuesday of each month).

¨ Quarterly events are similar to monthly events (if your company operates on a fiscal year, you 
can change the quarterly start date as described in Database Setup).

¨ Yearly events can be a date (e.g. April 15) or an occurrence of a weekday in a particular month 
(2nd Tuesday in May).

To confine a recurring activity between Starting and Ending Dates, click on either field and select a date. 
You must specify the start date, but you can leave the end date open (to leave a date open, type "none").

To save your settings, click on OK to return to the entry dialog box.    

Birthdays and Anniversaries

Note that to set a birthday or anniversary, simply create a recurring task and set the Interval to be 
Yearly/Date.    Then specify the date for the event.    You may also wish to request a week's advance 
notice.

Related Topics:
Modifying Recurring Events
Deleting Recurring Events



Modifying Recurring Events

If you want to modify a recurring event on one of the planner views, you can select it and click on the 
button.    From there, you may choose whether you wish to modify all occurrences of the recurring event 
(e.g. to change a weekly staff meeting from Wednesday to Thursday on a permanent basis) or a single 
occurrence (e.g. change next week's meeting but leave the permanent schedule as it is).    If you choose 
single occurrence, type the date of the occurrence you wish to modify.



Deleting Recurring Events

If you select a recurring event and click on the  button to delete it, you may choose between All 
Occurrences or a Single Occurrence.    You may also delete a single occurrence different from the one 
you selected, by selecting the appropriate date.    
The Delete all future occurrences from selected date allows you to set a date and delete all 
occurrences after that date.    For example, if you are changing the weekly staff meeting, effective one 
month from now, you can set the date and delete schedule entries from that time forward.



Pop-Up Alarm
To set a pop-up alarm with audio alert, click on the  button, then click on the desired time.    You can 
set the alarm to happen any time that you like before an event, e.g. 5 minutes, 10 minutes, half an hour, 
or an hour.    For example, you might set an alarm for two hours before a meeting that is in another town 
that requires a lengthy drive.    For a meeting down the hall, you might set a 5 minute alarm.
If Day-Timer Organizer is running (even in a minimized or inactive window), alarm messages will pop up 
over any active program.    Entries with alarms set will be displayed with an alarm icon on the planner and 
list views.    
Note that if you are running a program that is making sounds, you may not hear the alarm.    If your sound 
board is not connected properly, you may not hear the audio alarm, although you will still see the alarm 
window.



Advance Notice
Any activity with Advance Notice set will appear in the Upcoming pane of the Daily Planner view during 
the notification period.    For example, an October 15 event with 1 week's advance notice will appear as 
an upcoming activity between October 8 and October 14.

To set advance notice, open the entry and click on the  button, and select desired notification period 
from the pulldown menu.    
Alternately, you can just type a specific period, for example 4 days.



Purge After 60 Days
Schedule entries normally remain in your database until you explicitly delete them.    To automatically 
discard an entry 60 days after it occurs, click on Purge After 60 Days check box on the template when 
adding or editing schedule entries.



Checking for Schedule Conflicts
Day-Timer Organizer automatically scans for conflicts whenever you save a schedule entry.    If potential 
conflicts are found, they will be presented when you attempt to save the entry (to view conflicts before 
attempting to save the entry, click on the Conflicts tab).

To ignore displayed conflicts and save the entry, click on the OK button.    To update the conflict display 
after changing the original entry, click on the Update Conflicts button.    To reschedule a conflicting entry, 
click on the entry and then on the Modify Conflict button.    To delete a conflicting entry, click on the entry 
and then on the Delete Conflict button.    To discard the new event, click on the Cancel button.

You can disable conflict checking if you wish.



Shortcut Buttons
For your convenience, Day-Timer Organizer provides the following shortcut buttons at the bottom of the 
schedule entry template.
Button Function

save the current entry and add another

save the current entry and add a duplicate copy (which may 
be modified as needed)
delete the current entry

Customizing the Display in the Planner Views
Adjusting the Time Scale
Adjusting Entry Display
Screen Font
Window Size and Position
Adjusting Pane Size
Hiding the Calendar
Saving View Settings
Selecting Entry Types
Zooming In on the Monthly Planner View



Adjusting the Time Scale
By default, the Daily Planner view presents your schedule in 30 minute intervals.    To adjust this scale, 

click on the  buttons at the bottom of the window.    For a compact schedule display with no time 
scale, keep clicking on the leftmost time scale button.

The Monthly Planner view displays a standard North American style 7-day month.    The  
buttons allow you to switch between this display and a display with only the five business days.
Your computer operating system allows you to select whether you wish to use a 12-hour or 24-hour clock. 
Consult your system documentation for more information about customizing this setting.



Adjusting Entry Display

To enlarge or shrink the screen space allotted for each entry, click on the     buttons under the 
window.



Window Size and Position
To change the size of the Daily Planner window, position the mouse cursor over a side or corner of the 
window, then click with the left mouse button and drag to the desired size.    To change the position of the 
Daily Planner window, click on the title bar at the top of the window, hold down the left mouse button while
you drag the window to the desired position.

Note that the changed window size is not part of the saved settings and will revert back to the previous 
size the next time that you start Day-Timer Organizer. 



Adjusting Pane Size
To adjust the height of the Schedule, To-Do, Upcoming, or Diary & Work Record pane, click on the border 
between adjacent panes.    Then hold down the left mouse button while you drag the border up or down.



Hiding/Showing the Calendar
To hide the calendar panel on the Daily and Weekly Planner views, select the Hide Calendar option on 
the View menu.    To view this panel again, select the Show Calendar option from the View menu.



Selecting Entry Types
By default, the planner views display all entry types (schedule, tasks, phone calls, expenses, and any 
address book or note entries with follow-up dates).    To restrict display to one or more selected entry 

types, click on the  button.



Zooming In on the Monthly Planner View
To Zoom on any date to see missing entries or more text, move the mouse pointer to the top of the date 
pane and click when the magnifying glass icon appears.

The day will be enlarged to show more detail.    From this subwindow, you can create, modify or delete 
entries, just as in the other planner views.

To close the zoom box, click on the upper left corner of the box or click somewhere else on the window.



Scheduling Shortcuts 
¨ To quickly schedule a meeting:

position the mouse over any open schedule slot on the Daily or Weekly Planner view and double 
click.    Alternatively, click on the desired Begin Time, then drag the cursor to the desired End 
Time and release the mouse button.

¨ To reschedule a meeting:
click on the meeting, then hold down the mouse button while you Drag it to the desired time (e.g. 
on the Daily Planner view) or date (e.g. on the calendar).

¨ To schedule a meeting with someone in your address book:
open both Address Book and Daily Planner views, use the Window...Tile command to display 
them side by side, click on the desired address, and drag it to the desired time on the schedule 
pane (the meeting will be automatically linked to your address entry).

¨ To set a follow-up date for someone in your address book:
open both Address Book and Daily Planner views, click on the desired address, and drag it to the 
desired date on the calendar.

¨ To change months on the Monthly Planner view:
click on the month tabs at the bottom of the window, or use the fast forward (and reverse) buttons
at the bottom of the window to move by month or year.    You may also use the scroll bar - as you 
drag the scroll bar's thumb, Day-Timer Organizer will display the month corresponding to the 
thumb position.



Understanding the Display of To Do Items
To do items are displayed on the planner views.    Click on  to switch to the Daily Planner view.
Three of the four panes on the Daily Planner view display To Do items:
Pane Displays
To Do Tasks that are due or overdue on the currently 

displayed date.
Upcoming Tasks that are due later, but for which advance

notice was requested
Diary & Work Record Tasks that have been completed

Any task with a due date will appear on the planner view for that date.    Tasks with advance notice set will
appear in the Upcoming pane of the daily planner view before the due date.    Overdue tasks will remain 
on the to do list until completed.

You may also assign tasks to others (e.g. to other workgroup users), and easily search by assignee to 
view delegated tasks.    You may cross-reference tasks by    Category , making it easy to view all 
information related to a project.    You may also prioritize your tasks, which controls their presentation 
order on the daily and weekly planner.



Adding a Task
To add a task, click on the  button on the Actions button bar.    From the resulting pull-down menu, 
select Task.
Day-Timer Organizer will present a template.
You can fill in the fields as you wish.    Typically the minimum information will be 

· the due date

· a description of the task.    

When all your data is entered, click on OK to save the entry.

Related Topics:
Editing Note Text
Setting the Due Date
Setting Task Priority
Specifying Recurring Activities
Setting a Pop-Up Alarm
Requesting Advance Notice
Stopwatch

Categorizing Your Information
Custom Fields
Linked Entries
Attaching Files to Entries

Assigning Entries to Others
Copying Entries to the Clipboard



Setting the Due Date
Entries with due dates appear on the daily, weekly, and monthly planners on that date.    To set a due 

date, click on the     icon next to the due date field, then click on the desired date.

To Clear a due date, click on the date field and use the Delete key.
Day-Timer Organizer's smart date recognition accepts most typed formats, such as 

· "tu" for Tuesday

· "2w" for 2 weeks from today

· "n w" for next Wednesday

· "l m" for last Monday



Setting Task Priority
Tasks with priorities set will be sorted by priority on the planner views.    To set a priority, click on the

 field.    
Use the pull-down menu to select a priority or type one that is familiar to you.    You may use either 
numbers (1-9), letters (A-I), High to Low, or a hybrid style (A1-A9, B1-B9 etc.) for assigning priorities.    
Day-Timer Organizer assumes that priority 1 is more important than priority 3 and priority B is more 
important than priority F.



Shortcuts for Managing To Do List Entries
To quickly add a task to today's To Do list, position the mouse over any open To Do list slot and double 
click.

To reschedule a task from today to tomorrow, click on the task in the To Do list and hold down the mouse 
cursor while you drag it to the Upcoming list.    To reschedule to another calendar date, drag the task to 
that date on the calendar pane.



Viewing To Do List Items
To view your tasks, select any of the views listed below.    To help locate entries pertaining to a particular 
person or topic, you may Search by assignee, category, or word(s) contained in the Notes field.
View Information Displayed

Daily Planner - shows all information related to a date 
(including tasks with follow up dates).
Weekly Planner - shows all information related to a week 
(including tasks with follow up dates).
Monthly Planner - shows all information related to a month 
(including tasks with follow up dates).
Task List - shows your entire task list, including tasks with 
no follow up dates.
Timeline - lists in chronological order all date-related 
activities (including tasks with follow up dates).
Global List - lists all entries including tasks (both with and 
without dates).

Using the Task List View
To view all of your tasks, whether or not they have due dates assigned, click on the  view button.    
Tasks can be sorted by due date or priority.
To move through your task list, use the scroll bar.

Related Topics:
Viewing Finished Tasks
Sorting by Assignee or Category
Controlling Entry Size
Controlling the Display
Saving View Settings
Controlling the Contents of List Views

Searching and Repositioning

Printing



Viewing Finished Tasks

To view finished tasks, click on the  display button on the lower left portion of the task list window.    To
return to your unfinished tasks, click on the 

 button.

Related Topics:
Completing a Task



Setting the Display Order

By default, the list is displayed sorted by date.    This is indicated by the  button on the Display 
button bar.    To reorder the entries by order of priority, click on the 

 button.



Controlling Entry Size
To display more entries on a page, use the  button.    Conversely, the 

 button displays fewer entries per page, with more data per entry.



Controlling the Display
To zoom in on notes in any list view, click on the entry and then on the  button at the bottom of the 
window (to change zoom window size, drag the border up or down).    To scan successive entries, click on
the scroll.    To edit text, click in the text window and make changes.    To save or discard changes, click on
the 

 buttons, respectively.



Modifying a Task
To modify a task, double click on the task on any view screen (or click on the task and then click on the

 button).    When the template appears, click on any field you wish to modify and proceed as you 
would when adding a task .
To modify Multiple Entries at the same time, press the Ctrl key while you click on each entry (to select a 
range of entries, click on the first entry, then press the Shift key while you click on the last entry).    Next, 
click on the Modify button, and select the field(s) you wish to change.
If the task is Recurring, you may choose between All Occurrences of this entry, or a Single 
Occurrence.
When modifying multiple entries, you cannot modify the Notes field, custom fields, linked entries, 
attachments or address information (unavailable fields will be grayed out).
To save your modification, click on the Ok button.



Rescheduling with the Mouse
To quickly change a task's due date, click on the task, and then drag the task to the desired date. In the 
Weekly or Monthly Planner views, you can drag them to the desired date if it is displayed.    Alternately, 
you can drag it to a date on the calendar at the left of the Daily Planner or Weekly Planner view.



Completing a Task
When a task is completed, select the task by clicking on it on any View window.    You may then either 
delete it from your database, or save it as a finished task.

You can mark a task as finished by dragging it onto the  button or by dragging it directly into 
the Diary & Work Record pane of the Daily Planner view.    The task with its notes and associated 
material will remain in the database and can be used for later searches and reports.

To select multiple tasks at the same time, press the Ctrl key while you click on each task.    To select a 
range of adjacent tasks, click on the first entry, then press the Shift key while you click on the last entry.

To delete the selected task(s), click on the  button.    Next, click on Yes to confirm that you want to 
permanently delete the task.    Day-Timer Organizer for Workgroups: if a task was assigned to you by 
another user who did not give you delete rights, use the 

 button described below.

To finish and save the selected task(s), click on the  button.    To view finished tasks, click on the 

 button, then click on the 

 button.
With a recurring task, you may modify All Occurrences, or a Single Occurrence.    When you delete or 
finish the current occurrence, the next occurrence will replace it on your task list.



Advanced Task Management Features
The following advanced features are available when you add or modify a task.

Related Topics:
Recurring Tasks
Pop-Up Alarm
Advance Notice
Stopwatch
Assigning Tasks to Others
Setting Up a Category
Custom Fields
Linked Entries
Shortcut Buttons



Recurring Tasks
To schedule a repeating task, click on the  button on the template.    Next, click on the type of recurring 
task you want.

¨ Daily tasks occur every day.

¨ Weekly and Biweekly tasks occur on one or more weekdays (e.g. Tuesday and Thursday).

¨ Monthly tasks can be on a date (e.g. the first of each month) or an occurrence of a weekday (e.g.
the 2nd Tuesday of each month).

¨ Quarterly tasks are similar to monthly tasks (if your company operates on a Fiscal Year, see 
Database Setup).

¨ Yearly tasks can be on a date (e.g. April 15) or an occurrence of a weekday in a particular month 
(2nd Tuesday in May).

If you set Starting and Ending Dates, the recurring task will not occur outside these dates (to leave 
either date open, type "none").

To save your settings, click on OK.    Recurring entries will be preceded by a  icon on all list view 
screens.



Pop-Up Alarm
To set a pop-up alarm with audio alert on the due date, click on , then click on desired time. 
If Day-Timer Organizer is running (even in a minimized or inactive window), alarm messages will pop up 

over any active program.    Entries with alarms will be displayed with an  icon on all view screens.



Advance Notice
Advance notice gives you time to prepare for upcoming deadlines.    Any task for which advance notice is 
set will appear in the Upcoming pane of Day-Timer Organizer's Daily Planner during the notification 
period.    For example, a task due July 15 with advance notice set to 1 week will appear as an upcoming 
task between July 8 and July 14.

To set advance notice, click on the Advance Notice button, and either select the desired notification 
period from the pulldown menu or type a time. 



Stopwatch
To record time spent on a task for billing or accounting purposes, click on the  button to the right of the 
Time Spent field.    To start or stop the stopwatch, click on the On or Off button, then on OK.    You may 
also adjust Start Date, Start Time, or Time Spent independently.



Shortcut Buttons
For your convenience, Day-Timer Organizer provides the following shortcut buttons at the bottom of the 
task entry template:
Button Function

save the current entry and add another

save the current entry and add a duplicate copy (which may 
be modified as needed)
delete the current entry

finish the current entry without discarding it



Adding an Address
To add an entry to your address book begin by clicking on the  button on the Actions button bar. 
From the pull-down menu, Click on Address.    Day-Timer Organizer will present a template.
From the template, fill in the desired information.      Click with the mouse, or use the Tab key to move 
between fields and skip any fields which do not apply.    When the form is complete, click on OK to save 
the entry.
Note that you do not need to type capital letters for type names and addresses.    Day-Timer Organizer 
will automatically capitalize words for you, to ensure correct formatting.

Related Topics:
Specifying One or More Addresses
Finding Names Quickly
Entering Phone Numbers

Editing Note Text

Internet Access

Controlling Address Display

Setting a Follow-Up Date
Drag and Drop Follow-Up with Contacts
Recurring Follow-Up

Requesting Pop-Up Alarms
Setting Advance Notice

Related Meetings
Drag and Drop Scheduling of Related Meetings
Related Phone Calls

Custom Fields
Shortcut Buttons

Customizing Address Formats for International Addresses



Specifying Multiple Addresses
From within an address entry, you can specify multiple addresses by clicking on either the Work Address
or Home Address tab, then typing the address. When entering the address, you can use 

· Tab to move to the next field

· Shift+Tab to move to the previous field

· Arrows to move between work address, home address, phone numbers, etc. 



Finding Names Quickly in the Address Book
There are two methods for quickly finding names in your address book.    From the address list view,

· click on one of the letter tabs at the right edge to take you to the first name beginning with the 
specified letter

· enter the first few letters of a name into the Find field at the bottom to quickly find a specific name

If you prefer to find an organization or zip code, you can click on one of the sorting buttons at the bottom 
of the screen to sort by that field.    In this case, the Find box allows you to find an organization or zip 
code, rather than a name.



Entering Phone Numbers
From within an address entry, enter phone numbers by first clicking on the Phone Numbers tab.    Then 
click on the desired phone number fields, and type telephone numbers and extensions if applicable.    

If you type a 10-digit phone number, Day-Timer Organizer will reformat it automatically for easy 
viewing once you close the entry.    

Alternately, you may embed parentheses, dashes, or slashes for ease of reading.    To change the label 
on the button in front of any phone number, click on the button and type the desired text.

To assign a Dial Code (e.g. "9" for an outside line) directly to a phone number, click on the  button 
next to that number (for more information on dial codes, see Telephone Settings.



Sorting Your Address Book
Display buttons under the address window control the order in which addresses are displayed.    To 
choose a different order, simply click on the desired button.    The button that corresponds to the sort order
that is currently in effect will be displayed recessed.

Button Sort Value Function
Name sorts by the last name, if present 

(otherwise by organization)
Organization sorts by organization, if available 

(otherwise by name)
Zip Code sorts by zip code

Follow-Up Date sorts by date, displaying only 
addresses with follow-up dates set

Category sorts by category

Finding a Name
To navigate quickly through your address book, click on Letter Tabs on the right side of the address book
window (if there are multiple pages of names starting with a letter, click on the letter tab Multiple Times). 

For greater precision, use the scroll bar.    If you click on the scroll bar thumb and hold down the mouse 
button, the speed box shows the name(s) associated with the thumb position.

Alternatively, click on the     button or select Find Name from the Search menu.    Type the first few 
characters of the desired name, then press Enter.
Regardless of which navigation method you use, positioning and searching is based on the sort order you
have selected. 



Modifying an Address
To modify an address entry or view any of its details, double click on the address on any view screen (or 

click on the address and then click on the  button).    When the template appears, click on any field 
you wish to modify and proceed as you would when adding an address.
To modify multiple entries at the same time, press the Ctrl key while you click on each entry (to select a 
range of entries, click on the first entry, then press the Shift key while you click on the last entry).    Next, 

click on the  button, and select the field(s) you wish to change.    Only a limited number of fields are 
available for modification when modifying multiple entries.



Deleting an Address
To permanently delete an address, click on the address on the Address View window, then click on the

 button (or press the Del key).    Next, click on Yes to confirm that you want to permanently delete the
entry.
To select multiple entries for deletion, press the Ctrl key while you click on each entry (to select a range of
adjacent entries, click on the first entry, then press the Shift key while you click on the last entry).
Note that deleting an address entry from the To Do list deletes the address, not the follow-up.    To 
remove address follow-ups from the To Do list, you should finish the entry, drag it to the Diary & 
Work Record, or modify the address and remove the follow-up.



Copying an Address to the Clipboard
To copy an address to the operating system clipboard, click on the desired address, then click on the 
button.    Not all fields are copied.
To paste the address into your word processor, use the Paste command on your word processor's Edit 
menu.

Related Topics:
MailMerge



Controlling Address Display
The entry size buttons  control the number of lines per address in the Address Book view.    To 
always default to entry size you have selected, choose the Save Settings command from the View 
menu.
To zoom in on notes for any address entry, click on the entry and then on the  button at the bottom of 
the view window (to change zoom window size, drag the border up or down).    To scan successive 
entries, click on scroll bar arrows (or use the Arrow keys).    To edit text, click in the text window and make
changes. 



Follow-Up Date
To set a date on which to contact a person in your address book from within an entry, click on the  
button on their address template, then click on the desired calendar date.    

From the keyboard, you can type in a follow-up date in a variety of ways.    Day-Timer Organizer's smart 
date recognition accepts most formats, such as "tu" for Tuesday or "2w" for 2 weeks from today.
Any name with a follow-up date will appear on the Daily Planner's To-Do list on that date.    If you set 
Advance Notice, the name will appear in the Daily Planner's Upcoming pane before the follow-up date.   
Any follow-up not completed as scheduled will show as Overdue (with date shown in red) until 
completed.

To clear a follow-up date, click on the address entry on any View screen.    Next, click on the  button 
on the button bar.    Do not use the 

 button unless you want to permanently delete the entire address entry.

Alternatively, you may clear the follow-up date by clicking on the  button at the lower left corner of the 
address entry template.



Drag and Drop Follow-Up with Contacts 
To set a follow-up date using Day-Timer Organizer's drag and drop feature, open your Address List and 
any Planner view (Daily, Weekly, Monthly) at the same time, resizing them so both are visible.    Then click
on the desired address and hold the mouse button down while you drag it to the desired date on the 
calendar. 

If you drag an address to the To Do pane of the Daily Planner view, it creates a follow-up.    Dragging the 
name to the schedule pane creates a meeting with that person at the specified time.



Recurring Follow-Up
To set a recurring follow-up date (e.g. every month) from within an entry, click on the     button, and 
select daily, weekly, biweekly, monthly, or yearly follow-up.    The entry will appear in the to do list at the 
appropriate day.



Pop-Up Alarm
To set a pop-up alarm with audio alert on the follow-up date, from within the entry, click on the  button, 
then click on the desired time. 
If Day-Timer Organizer is running (even in a minimized or inactive window), alarm messages will pop up 
over any active program.    Entries with alarms will be displayed with an alarm icon on all view screens.    



Advance Notice
Advance notice gives you time to prepare for upcoming deadlines.    Any follow-up for which advance 
notice is set will appear on the Daily Planner's Upcoming List during the notification period.    For 
example, a July 15 follow-up with advance notice set to 1 week will appear as upcoming between July 8 
and July 14.

To set advance notice from within an entry, click on the     button and select the desired notification 
period from the pulldown menu.    
Alternately, you can simply type the desired notification period.



Notes
Day-Timer Organizer can store up to 35 pages of notes per contact.    To store notes, click on the Notes 
tab and type any additional information you wish to record (notes provide a convenient place to record 
interactions with customers, suppliers, or friends).    Information stored in your notes can be easily located 
later using the Word Search feature.

Related Topics:
Editing Note Text



Related Meetings
Day-Timer Organizer lets you link meetings directly to any entry in your address book.    To view or create 
linked meetings, click on the Meetings tab on the address template.

To add a meeting which is directly linked to the displayed address, click on New Meeting and fill out the 
schedule entry.
 

To modify or delete a linked meeting, click on the Modify Meeting or Delete Meeting button.    To break 
the link between a meeting and the address entry, click on the Break Link button.    



Drag and Drop Scheduling of Related Meetings
To add a meeting which is directly linked to a displayed address using Day-Timer Organizer's drag and 
drop feature, open your Address Book and Daily Planner at the same time (move or resize them so both 
are visible).    Click on the desired daily planner date, and scroll the Daily Planner's Schedule pane so the 
desired meeting time is visible.    Next, click on the address and hold down the mouse button while you 
drag it to the desired position on the schedule pane.

Note that this creates a follow-up and when the action has been completed, you should finish the entry,
drag it to the Diary & Work Record, or modify the address and remove the follow-up.



Related Phone Calls
To view phone calls linked to this contact from within the address entry, click on the Phone Calls tab.    To 
create, modify, or delete a linked phone log entry, click on New Call, Modify Call, or Delete Call buttons.  
 



Shortcut Buttons
Use the following shortcut buttons on the address template to save time:
Button Function

save the current entry and add another

save the current entry and add a duplicate copy (which may 
be modified as needed)
delete the current entry

finish and save the selected entry

Using the WinFax Interface
The address book that you create in Day-Timer Organizer can be used by WinFax PRO (version 4.0 and 
higher) to serve double duty as your WinFax address book.    When you install Day-Timer Organizer, it 
automatically links its address book to the address book list in WinFax PRO.

When you fax from WinFax PRO, simply select Day-Timer Organizer address book from the Phonebook 
menu.    The information that was entered in Day-Timer Organizer (including fax number, contact name, 
company name, voice telephone number, etc.) will be used by WinFax PRO to fill in the cover page and 
fax to the specified phone number.



Customizing Address Formats
By default, Day-Timer Organizer labels address fields to conform to the standard used in the United 
States.    When you add an entry in your address book, the Work Address and Home Address tabs 
display addresses with those labels.    To select different labels, click on the Customize button from the 
address template.

Note that if you customize address format, it does not change all of the address layouts.

Related Topics:
Selecting the Country for Individual Addresses
Selecting a Different Standard (Default) Layout
Defining a new Address Format
Adding Information to an Existing Layout
Changing the Labels for Phone and Email Descriptions
Choosing the Default Display Tab for Address Entries



Selecting the Country for Individual Addresses
To select the address labels for a different country, click on the pull-down for the Address and label 
layout field.    Choose the country that you need for the current address.

If you then click on OK, the current address will be updated to use the selected labels.    For example, if 
you have chosen Canada, the labels will be similar except that you will see fields labelled "Province" and 
"Postal Code" rather than the U.S. "State" and "Zip" fields.



Selecting a Different Standard (Default) Layout
The standard layout is used whenever you add a new address in Day-Timer Organizer.    If you wish to 
change the address layout that is displayed when you enter new names, within an address entry click on 
the Customize button from the Address template.    Then from the Address Customization dialog box, 
click on the Make these settings the default for new entries check box.    This will not change 
addresses that have been entered previously, but any new addresses that are created will be displayed 
with the new format.



Defining a New Address Format
You may want to have an address format for a country that is not available in the standard list.    To define 
a new country format, from the Address Customization dialog box, click on the Add button.

Enter the country name in the Format Name field.    

Setting Up the Appropriate Fields and Labels
The Standard list displays the standard names of all the fields that are available.    The Display Name 
indicates how these fields are labelled on the screen.    For example, if you scroll down, you will see a field
labelled Zip.    This is the U.S. postal code; other countries often label this as a Postal Code or Postcode.   
You can type a new label for this value in the Display Name field and the new label will be used on the 
entry screen.

There are two spare fields labelled with a dot (.) and a comma (,) that you can use to identify additional 
fields such as county, mail stop, rural route number, etc.    Simply replace the (.) and the (,) label with your 
preferred text.

Defining the Address Layout for Printing
The Address Layout box on the right allows you to specify what fields are to be used and their order 
when you print labels or envelopes.    

To add an additional field to the address layout, begin by scrolling the Standard/Display Name box until 
the field is displayed.    Then drag the field name into the Address Layout, to the desired location.

To move a field to a new location, drag it to the desired place within the Address Layout area.

To remove a field, drag it off of the Address Layout area.    The cursor will change to a trash can to 
indicate that the value is about to be removed.

Saving the New Country Definition
Once you have defined the new layout, click on OK to save the definition.    If you wish, you may make 
that country definition your standard (default) layout.



Adding Information to an Existing Layout
If you want to include address information such as county, mail stop, etc. that is not part of the standard 
address, you can define a custom format or alter the current address definition for your country.    To alter 
the current address definition, from the Address Customization dialog box, click on the Modify button.    
Then proceed as you would in adding an entirely new definition.



Changing the Labels for Phone and Email Descriptions
By default, the phone values are labelled as office, fax, mobile, and home numbers.    To change the 
labels that are used to describe these phone numbers, you should be in the address template (i.e. as 
though you were adding a new address).    Click on the Phone Number Descriptions button on the 
Address Customization dialog box.    This will change the current entry only.    To make your new 
definition the default for new entries, use the Make Default command.

Note that the descriptions match the labels that are displayed on the Phone Numbers tab for adding 
addresses.

You can change these descriptions as you wish, and the new descriptions will be displayed.

Alternately, you can click on the button that displays the label (e.g. the Office button on the template 
when adding a phone number to an address) and a dialog box will appear that allows you to enter a new 
label for the button.

When you click on OK, the button label will be updated.

In the same fashion, Day-Timer Organizer  allows you to have up to four e-mail addresses which are 
labelled "Address 1", "Address 2", etc.    To change the label that appears when you click on the e-mail tab
of the template, you can click on the button itself to change a single button.    You will be prompted to 
enter the new label and when you click on OK    the button label will be updated.

Alternately, you can change Email address labels by clicking on the EMail Address Descriptions button 
on the Address Customization dialog box.    For example, you might choose to label the first two EMail 
addresses as Business and Personal.

If you    click on OK to accept this change, the Email Addresses tab will then be displayed.



Choosing the Default Display Tab for Address Entries
By default, when you add a new address, the Phone tab is displayed.    You can choose a different tab 
from the Address Customization dialog box.    This tab will then be displayed when the current address 
is modified.    If you click on the Make these settings the default for new entries check box, the 
selected tab will be displayed whenever a new address is added.



Setting Up to Make Calls
If your computer has a Hayes™ or 100% compatible modem or a TAPI- or TSAPI-compliant phone 
system, Day-Timer Organizer can dial telephone numbers for you.    Even if you do not have a modem, 
you may want to take advantage of Day-Timer Organizer's phone call logging capabilities.

Before dialing for the first time, follow these steps:

¨ Choose Telephone from the Setup menu and check Area Code and Modem Settings (for more 
information, see Telephone Settings).

¨ Make sure your modem is turned on and properly connected to both your computer and the 
telephone line.

¨ If you have a multi-line phone system, verify that a dial tone is available at your modem.

Related Topics:
Using the Speed Dialer
Dialing from the Address Book



Using the Speed Dialer
The Speed Dial feature of Day-Timer Organizer allows you to quickly access and if you have a modem, 
dial frequently used numbers.

Related Topics:
Setting Up Frequently Dialed Numbers
Including the Speed Dial Button on the Button Bar
Dialing



Setting Up Frequently Dialed Numbers
To set up a number for speed dialing, choose the Tools...Speed Dial...Add/Modify List command.    You 
will be prompted for up to twelve name/phone number combinations.

Enter the names and numbers that you wish to have on your speed dialer.    When you click on OK, these 
names will be stored.    You can change your speed dial numbers at any time in the same manner.



Including the Speed Dial Button on the Button Bar

Once you have set up speed dial numbers, you may want to include the     button on the button bar. 
To do that, choose the Setup...User Preferences command and select the Button Bar option.    Click on 
the 

 button to highlight it so that it will be included on the standard button bar.    When you click on OK, 
the button bar will be updated.    Note that if your screen is too small or you already have too many 
buttons displayed, you may not be able to include an additional button.



Dialing
There are two ways to speed dial:

1. Choose the Tools...Speed Dial command from the menu.    The speed dial name/numbers will be
displayed and you can choose the desired name from the submenu.

2. If you have included the  button on the button bar, simply click on it and then choose the 
desired name/number from the pull-down menu.



Dialing from your Address Book
To dial any number listed in your Address Book, proceed as follows:

¨ From the Address List view, click on the person you wish to call.

¨ Click on the     button on the button bar. 
¨ If there are multiple numbers listed for that person, select the desired number.
¨ Once the number and dial code are correct, click on the Dial button. 
¨ When prompted, pick up your handset, then click on either OK (to bypass call logging) or Log 
Call (to create a linked phone call entry).

Related Topics:
Using the Speed Dialer
Dialing from the Address Template
Dialing Numbers Stored in Text
Dialing Other Numbers



Dialing from the Address Template
To dial from within an address book entry, double click on the address and then click on the Phone 
Numbers tab.    Day-Timer Organizer will display the phone numbers.

Click on the  button next to the number you want to dial.    When prompted, pick up your handset, 
then click on either OK (to bypass call logging) or Log Call (to create a linked phone call entry).



Dialing Numbers Stored in Text 
To dial a number in the Notes field of Any Entry (schedule, task, address, note, expense, or message), 
proceed as follows:

¨ Position the mouse cursor at the beginning of the number.

¨ Hold down the mouse button while you drag the cursor to the end of number.

¨ Click on the Right Mouse Button and select Phone Dialer from the menu.

¨ Click on the Dial button.    When prompted, pick up your handset, then click on either OK (to 
bypass call logging) or Log Call (to create a phone call entry for this call).



Dialing Other Numbers
To dial a number not stored in Day-Timer Organizer, click on the Phone Dialer button, and type in the 
desired number or click on the on-screen phone keypad buttons.

To Redial the last number you dialed, click on the Last button.

Once the number and dial code are correct, click on the Dial button.    When prompted, pick up your 
handset, then click on either OK (to bypass call logging) or Log Call (to create a phone call entry).



Logging a Call
You can take advantage of Day-Timer Organizer's phone logging capabilities whether or not you are 
using a modem to dial calls directly through your computer.    If Day-Timer Organizer is dialing a call for 
you, you will be prompted to log the call or to bypass call logging by clicking on OK.    

To manually log a call, you should first select the name of the person you are calling in the Address Book 

view and click on the  button.    You would then click on the Log Call button.    You can also log calls 
to people who are not in the address book.
Day-Timer Organizer will present a phone call template, with most of the required information filled in for 
you.    All you normally need to do is click on the Notes tab and record the details of your conversation.

Alternately, you can click on  and select Phone Call. 
To return to the address without closing out the phone call (e.g. to retrieve or record information), click on 
the Linked Entries tab, then double click on the address displayed there.    To Modify the original 
address entry in this manner, you must have dialed from the address book view (see Dialing from your 
Address Book), rather than from the Phone Numbers section of the address entry template.

If you were unable to make contact, select the appropriate call Status from the pull down list (to 
customize your call status list, see Telephone Setup).

When the call is finished, click on OK to turn off the timer and save the call.

Related Topics:
Editing Note Text

Changing TAPI/TSAPI Settings

Setting the TSAPI Device



Changing TAPI and TSAPI Settings
From the Phone Dialer dialog box, you can change the TAPI and TSAPI settings if you have selected 
TAPI or TSAPI devices.

TAPI:    Enter updated values in the fields provided.

TSAPI:    Click on the Change TSAPI User/Device button.    Do not open this dialog unless you wish 
to change the server name and you have the user name and password available since opening 
this dialog may clear previous settings.

Logging in to a TSAPI Device

Setting the TSAPI Device



Logging into a TSAPI Device
This dialog appears when you have clicked on the Change TSAPI User/Device button on the Phone 
Dialer dialog box OR you have tried to login to a TSAPI device.    You must fill in the values for:

the Server pull-down lists the available telephony servers

Login ID - user name for the telphony server (ask your system administrator for your user name and 
password)

Password  - user password

Remember Password - if this option is set will, Day-Timer Organizer will keep password encoded in the 
INI file

Note that if you return to this dialog by clicking on the Change TSAPI User/Device button, the user
name and password will be cleared and you must re-enter them. 



Setting the TSAPI Device
This dialog appears when you are changing TSAPI settings or if you have not previously specified the 
TSAPI device.    You must specify the telephone device that is being controlled by TSAPI by filling in the 
value of the pull-down or field labelled Controlled Telephone Device.     The value to be inserted should 
be supplied by your administrator, and it is typically the phone extension number.



Viewing Phone Calls to One Person
To view all phone calls linked to an address book entry, double click on that entry, then click on the Phone
Calls tab. 

To create, modify, or delete a linked phone call entry, click on New Call, Modify Call, or Delete Call 
buttons.



Viewing Phone Calls
To view your entire phone log, click on the     view button.
The Phone Calls view presents calls with the most recent calls first.    Entry size and zoom controls 
behave the same as those described in Controlling Address Display.
To view all calls with a particular call status, search by Call Status.    To view calls which apply to a 
person, project, or topic, search by Assignee, Category, or Word.    For more on searching, see 
Searching.

Related Topics:
Selecting the Type of Call to View

Viewing Phone Calls to One Person



Selecting the Type of Call to View
On the Display button bar, there are three buttons that allow you to select what type of phone call should 
appear on the list.

You can click on one of these buttons to display only incoming calls, outgoing calls only or all calls 
respectively.



Viewing Your Notes
To view a list of your separate note entries, click on the  button on the button bar at the top of the 
window.    Recently added notes appear at the top of your list, but you can move a note to any desired 
position.    To move through your notes, use the scroll bar.



Copying from the Clipboard into Day-Timer Organizer
If you have copied information from another application to the clipboard, you can insert that into Day-
Timer Organizer by issuing the Edit...Paste command.    This is most useful when copying text from a 
word processor or from a Web page into Notes in Day-Timer Organizer.



Sorting Notes
By default, notes are sorted by position (recently added notes appear at the top of your list, unless you 
explicitly set their position).    

· To sort by follow-up date (showing only notes flagged for attention), click on the     button, or
select Sort By Date Due from the View menu.    

· To sort by title (alphabetically by the title field of the note), click on the x button or select Sort by 
Title from the View menu.

If you have changed the display order, you can return to viewing the notes by position by clicking on the

 button.



Controlling Entry Display
The     buttons (or keypad Plus and Minus keys) control the number of lines visible per note in the 
Notebook view.
To save viewing settings, including window size and position, sort mode, and entry size, select the Save 
Settings option on the View menu.    Day-Timer Organizer will use these settings each time you open the 
notes view.



Viewing the Full Text of Notes
To expand the text for any note (or restore it to its normal size), click on the note and then on the  
button at the bottom of the window (to change zoom window size, drag the border up or down).    To scan 
successive notes, click on scroll bar arrows (or use the arrow keys).
To edit expanded text, click in the text window.    To save changes, click on the OK button.    To exit the 
note without saving changes, click on the Cancel button.



Editing Note Text
To pull down a menu of word processing options, click with the right mouse button while the pointer is 

positioned over the Notes field of an entry.    Alternately you can click on the  button.    Note that the 
editing menu is not the same as the Edit pull-down menu.
To expand the text for any note (or restore it to its normal size), click on the note and then on the  
button at the bottom of the window (to change zoom window size, drag the border up or down).    To scan 
successive notes, click on scroll bar arrows (or use the arrow keys).

Positioning the Cursor
Inserting and Deleting
Working with Blocks (Cut/Copy/Paste)
Searching and Replacing
Inserting Dates and Times
Setting Indents
Setting Tabs and Display Margins



Positioning the Cursor
Click on the desired cursor position.    To move short distances, use arrow keys.    To move to the 
beginning of the next word, press Ctrl+Right Arrow.    To move to the beginning of the previous word, 
press Ctrl+Left Arrow.

To move to the beginning (end) of the current line, press the Home (End) key once.    To move to the 
beginning (end) of the text on the screen, press the Home (End) key twice.    To move to the beginning 
(end) of all of the text, press the Home (End) key three times.

To move through a long entry a page at a time, click above or below the scroll bar at the right side of the 
screen (or use PgDn and PgUp keys).    Alternately, position the mouse cursor over the scroll box, hold 
down the mouse button, and drag the scroll box to the desired position.    To move through long portions 
of text (either up or down), click on the scroll arrows at either end of the scroll bar.



Text Input - Insert & Delete
Typed characters are inserted at the cursor, moving subsequent text to the right.    To type over existing 
text, press the Ins key to enter overwrite mode.    To return to insertion mode, press the Ins again (this key
toggles between modes).

To delete the character Before the cursor, press the Backspace key.    To delete the character Under the 
cursor, press the Del key.    To delete a Word, press Ctrl+Delete (or Ctrl+Backspace).    To delete to End
Of Line, press Ctrl+L.



Text Input - Block Commands (Cut/Copy/Paste)
Block commands operate on the Windows clipboard, letting you move text from one entry to another 
within Day-Timer Organizer or between Day-Timer Organizer and other programs.    

Note that this process uses the editing menu, which you can use by clicking with the right mouse button 

while the pointer is positioned over the notes field or clicking on the  button.

To mark a block of text (or highlight it), hold down the mouse button while moving the mouse from 
beginning to end of text, then release.    For multi-page blocks, click at the beginning of the block, 
reposition to the end of the block, hold down the Shift key, and click again.

To replace the marked block with new text, simply type new text.    To duplicate the marked block to the 
Windows clipboard, select Copy from the editing menu (click on the right mouse button to view this 
menu).    To delete the marked block, press the Del key.    To delete the text from the document and copy it
to the Windows Clipboard, select Cut from the editing menu. To insert the contents of the clipboard into 
the current document, move the cursor to desired position and select Paste from the Edit menu.



Text Input - Search & Replace
To find a character sequence, select Find Text from the editing menu. 

Normally, Day-Timer Organizer ignores whether the letters are capital or small letters.    However if you 
wish it to distinguish capital from small letters, click on Case.    So for example, if you search for paper, it 
would normally find "Imperial Paper Company", "...and the paper requirements ..." or "The PAPER project 
is...".    However if the Case option is enabled, it would find only entries where the word "paper" appeared 
(and ignore "PAPER" and "Paper").

Set search direction to Down, Up, or From beginning.    To start searching, press Find Next.

To replace existing text with new text, select Replace from the Edit menu, and type old and new text.    To
turn off the verify feature (which checks before each replacement), click on the Verify check box.    To 
distinguish between capital and lower case letters, click on Match Case.    To proceed, click on OK.



Text Input - Date & Time Stamp
To insert the Current Date in your text, select Insert Date from the Edit menu.    To insert the Current 
Time, select Insert Time from the Edit menu.    

To insert any date into your note, first display a calendar by selecting Calendar from the Edit menu.      
Then from the calendar, click on the desired date.



Text Input - Indents
To Indent a paragraph from the current cursor position, select Insert Indent from the Edit menu .    To 
remove indenting, position the cursor at the beginning of the indented text and press the Backspace key.



Text Input - Tabs and Display Margins
To set tabs or expand the right margin, select Tabs and Margins from the editing menu.

To change spacing between Tabs, type new spacing.    By default, Day-Timer Organizer wraps text at the 
window boundary.    To display a table wider than the window, set Word Wrap wider than table width.



Text Input - Phone Dialer
To dial any number in your text, hold down mouse cursor while you drag from the beginning to the end of 
the number, then select Phone Dialer from the Edit menu.



Recording an Expense
To begin creating an expense record, click on the  button on the Button Bar.    From the pull-down 
menu, click on Expense and Day-Timer Organizer will present a dialog box.
You can then fill in the fields and click on OK to add the expense entry.

Related Topics:
Entering Notes with Your Expense Record
Selecting An Expense Date
Selecting Expense Type

Assigning Expenses to Others
Copying Entries to the Clipboard
Attaching Files to Entries

Custom Fields 

Categorizing Your Information

Searching and Repositioning

Linking Entries

Sharing Entries With Others

Totalling Time and Expenses



Entering Notes with Your Expense Entry
In the Notes field, you may include as many details as you wish (Day-Timer Organizer allows up to 35 

pages of text per entry).    To expand the text window (or restore it to its normal size), click on the  
button at the bottom of the scroll bar.    For a menu of editing features, click on the right mouse button 
when the pointer is on the text.

Related Topics:
Viewing Your Notes

Sorting Notes

Controlling Entry Display

Viewing the Full Text of Notes

Editing Note Text



Selecting An Expense Date
Click on the     icon next to the date field, then click on the desired calendar date from the resulting 
window.

Alternately, you can simply type a new value into the Date field.    Day-Timer Organizer's smart date 
recognition accepts most typed formats, such as "tu" for Tuesday or "2w" for 2 weeks from today.



Selecting Expense Type

Click on the arrow selector next to the Type field to pull down a list of expense types, and select the type 
which applies.    If any type you need is not on the list, you may add it, as described in Customizing 
Expense Types.

If you select Entertainment, Day-Timer Organizer will prompt you for Location (name of restaurant or 
establishment), With ( names of people who attended), and Purpose (business purpose for meeting).

If you select Mileage, Day-Timer Organizer will ask for mileage traveled and the reimbursement rate per 
mile (which will be saved for future reference).    The total amount will be calculated automatically.



Marking Expenses as Submitted
To mark an expense entry as submitted (e.g. after you have submitted an expense report to accounting), 

click on the entry on any View screen, then click on the  button.    Next, click on Yes to confirm that 
you want to mark the entry as finished (for your convenience, there is also a Submitted check box on the 
entry template, accessible when you add or modify the entry). 
To finish multiple entries at the same time, press the Ctrl key while you click on each entry (to select a 
range of adjacent entries, click on the first entry, then press the Shift key while you click on the last entry).



Shortcut Buttons
For your convenience, Day-Timer Organizer provides the following shortcut buttons at the bottom of the 
expense entry template:
Button Function

save this expense entry and add another

save this expense entry and add a duplicate copy (which 
may be modified as needed)
delete this expense entry

Viewing Your Expenses
To view expenses, select the  button on the button bar or use the View menu.    Recent expenses 
appear at the top of the list.    To move through the list, click on the scroll bar.    To locate entries for a 
particular person or topic, you may search by assignee, category, or word(s) contained in the text field.

Related Topics:
Viewing Submitted and Unsubmitted Expenses
Entry Display Size



Viewing Submitted and Unsubmitted Expenses
When you add an expense entry, it is unsubmitted unless you indicate otherwise.    After submitting it to 
your accounting office for reimbursement or billing purposes, you may mark it as submitted.
Button Function

display expenses not submitted for reimbursement (the 
default)
display expenses submitted for reimbursement

display all expenses together, in reverse date order (most 
recent expenses appear first)

Entry Display Size
To display more expense entries on a page, use the    Entry Size buttons:  to enlarge and reduce 
respectively the size allotted for an entry.
To Zoom in on notes for any entry, click on the entry and then on the  button at the bottom of the 
window (to change zoom window size, drag the border up or down).    To scan successive entries, click on
scroll bar arrows (or use arrow keys).    To edit text, click in the text window and make changes.    



Totaling Time and Expenses
To total time and expenses allocated to any project, select the Total Time & Expenses command from 
the Tools menu.

If you selected one or more entries on screen, Day-Timer Organizer will total time and expenses for those
entries.    Otherwise, it will total all entries, subject to search and date range settings.

¨ Search buttons let you filter by person, project, word, category or entry type.    Any search 

settings in the active view will be automatically retained; to clear search settings, click on .
¨ Dated Between lets you select expenses between a range of dates.    Click on the date buttons 
and select desired dates from the calendar.
¨ Hourly Rate lets you tally labor costs for a project.    If you enter a rate, it will be multiplied by time
spent to determine total labor cost.

Once the search settings are correct, click on OK.    Day-Timer Organizer will present a screen.

To view a breakdown of the totals by expense type, click on the  button.    To view a list of entries for 
any expense type, click on the 

  button for that type. 
Note that the totals generated through this command cannot be printed.



Modifying an Expense Entry
To modify an expense entry, double click on the entry on any view screen.    If you prefer, you can click on 

the entry and then either click on the  icon or drag the entry over the 

 icon.    When the template appears, click on any field you wish to modify and proceed as you would 
when adding an expense (described in Adding an Expense).
To modify multiple entries at the same time, you must select them.    To select a series of entries, press 
the Ctrl key while you click on each entry.    To select a range of entries, click on the first entry, then press 

the Shift key while you click on the last entry.    Once the entries are selected, click on the  button, 
and select the field(s) you wish to change.    Finally, click OK to save the changes.



Deleting an Expense Entry
To permanently delete an expense entry, click on the entry on any view screen.    Once the entry is 

selected, click on the  button (or press the Del key).    Next, click on Yes to confirm that you want to 
permanently delete the entry (for your convenience, there is also a 

 button on the entry itself, accessible whenever you add or modify an expense entry).
To select multiple entries for deletion, press the Ctrl key while you click on each entry (to select a range of
adjacent entries, click on the first entry, then press the Shift key while you click on the last entry).



Viewing Timelines
To display Timeline view, click on the  button on the View button bar or choose the View...Timeline 
command.    This view presents an unbroken list of all date-related activities in chronological order.    The 
entries displayed in the timeline include:

· schedule

· tasks

· phone calls

· expenses

· addresses (with follow-ups)

· notes (with follow-ups)

· messages

Related Topics:
Moving Through the Timeline
Controlling Timeline Entry Size



Moving Through the Timeline
To move through your Timeline list, use the scroll bar.    If you click on the scroll bar's thumb and hold 
down the mouse button while you drag the thumb up or down, a speedbox will show the date 
corresponding to the current thumb position.    This makes it easy to move quickly yet precisely though 
time.

To move backward or forward by a week, click on the  or 

 button respectively on the Display button bar. To move backward or forward by a month, click on 
the 

 or 

 buttons.    To return to today's date, click on the Today button.
To move through larger time intervals, use the Find Date command on the Search menu and type the 
desired date.    Alternately, you can click on the icon to set the date.



Controlling Timeline Entry Size
To display more entries on a page, use  buttons at the bottom of the window.
To zoom in on text for one entry, click on the entry and then on the  button at the bottom of the scroll 
bar.    To scan successive entries, click on scroll bar arrows (or use Arrow keys).    To edit expanded text, 
click in the text window. 



Global View
The Global view shows all Day-Timer Organizer entries such as schedule, tasks, addresses, notes, 
phone calls, expenses, and messages (multi-user database only) in one place.    The Global view includes
both Dated and Non-Dated items, which makes it well-suited for finding everything which applies to a 
topic.

To select the global view, click on the  button or choose the View...Global command.    The global list
is sorted so that entries added or modified most recently appear at the top.    To move through your list, 
use the scroll bar.    To view entries prior to today, click on the up arrow icon of the scroll bar.

Related Topics:
Controlling Entry Size
Saving View Settings
Controlling the Contents of List Views

Search and Repositioning

Printing



Controlling Entry Size
To display more entries on a page, use  buttons at the bottom of the window (or the keypad Plus 
and Minus keys).
To zoom in on text for one entry, click on the entry and then on the  button at the bottom of the scroll 
bar.    To scan successive entries, click on scroll bar arrows (or use Arrow keys).    To edit expanded text, 
click in the text window.    



Setting User Preferences
Preference options let each user personalize a variety of settings in Day-Timer Organizer.    When you 
select User Preferences from the Setup menu, Day-Timer Organizer will display a dialog box like that 
shown below.    When you select an option in the panel on the left, the panel on the right shows your 
current settings.

Related Topics:
Controlling the Display of the Calendar Week
Controlling the Alarm Settings
Specifying your Standard Business Hours
Setting Miscellaneous Features
Selecting the Screen Font
Customizing the Button Bar
Requesting Notification Messages (multi-user database only)



Controlling the Display of the Calendar Week
This command allows you to specify whether the week is to begin on Sunday (as in the U.S.) or on 
Monday (as is done in Europe).

The month calendars at the left in Daily Planner view, the calendar popup for setting dates, and the 
Monthly Planner view may display either Sunday or Monday as the leftmost day.

The weekly view displays Monday tio Sunday, although the printed report of the Weekly Planner will 
reflect your choice.



Controlling the Alarm Settings
To control pop-up alarm behavior, use the Alarm Settings selection in the Setup...User Preferences 
command.

When an alarm sounds, you may clear it or snooze it.    If you snooze it, it will pop up again after the 
Snooze Interval (which is initially set to 15 minutes, but may be set to any time interval you wish).

If no action is taken on an alarm (perhaps because you are away from your desk), an audio alert will 
automatically repeat at periodic intervals (by default, every 5 minutes).    Even if Day-Timer Organizer is 
running in an off-screen window and you are away from your desk when an alarm sounds, you will hear it 
within 5 minutes of your return.

If the Autosnoozing box is checked, pop up alarms which remain on screen with no action taken will be 
automatically removed from the screen after the snooze interval (and pop up again after another snooze 
interval has passed).    This allows any active program which is interrupted by an alarm to receive 
processing time. 



Specifying your Standard Business Hours
To set your business hours, select User Preferences from the Setup menu, then select Business 
Hours.    Note that business hours cannot begin before 6 a.m. and cannot extend past 10 p.m.

You may control the beginning and end of your work week, as well as the beginning and end of your 
business day.    These settings control both printouts and the Find Time feature in the Team Organizer 
view, which finds the next available time you and others can meet.    The start must be before the end.

Long business hours may cause reports to use more than the normal number of pages (daily and 
weekly).



Setting Miscellaneous Features
The Miscellaneous choice on the Setup...User Preferences dialog controls three settings:

To disable the audio alert when Day-Timer Organizer displays an error message, click on the check box 
to turn Error Bell off.

Day-Timer Organizer automatically identifies potential conflicts whenever a Schedule entry is added or 
changed.    To disable this feature, click on the check box to turn Find Conflicts off.

To reduce screen clutter, Day-Timer Organizer's daily, weekly, and monthly planner views do not show 
your name next to entries assigned to you and no one else.    To display all names on planner views 
(including your own), click on the box beside Display Own Name so that a check mark appears.



Selecting the Screen Font
To choose screen fonts, select User Preferences from the Setup menu, then choose the Screen Fonts 
option.    You may set screen fonts independently for daily and weekly planners, monthly planner, all other 
views, and the text editor.    To do so, click on the appropriate button. 

Select the font, style, and point size you want.    If the font you select results in clipped characters or 
strange screen behavior, it is inappropriate for your hardware configuration and you should choose a 
different screen font. Note that not all on-screen attributes can be changed with this option.

This command affects only the screen display.    To change reports, use the options on the Printing 
Options dialog box.



Customizing the Button Bar
Although the default button bar settings meet the needs of most users, users with specialized needs may 
substitute or add buttons if they wish.    Depending on your screen size, you may want to add or remove 
some of the buttons.    On a higher resolution screen, you may have room for additional buttons whereas 
on lower resolution screens, you may want to remove the buttons that you use less frequently.    To 
customize your button bar, select User Preferences from the Setup menu, then select Button Bar.

Buttons that are highlighted will appear on the button bar.    To omit a lighted button from the button bar, 
click on it.    To include an unlighted button on the button bar, click on it.



Requesting Notification Messages (multi-user database only) 
By default, Day-Timer Organizer for Workgroups automatically sends a notification message whenever 
you assign a schedule or task entry to another network user.    Users who routinely delegate large 
numbers of tasks may find automatic notification an unnecessary burden upon the assignees.    To turn off
automatic notification for either task or schedule entries, select User Preferences from the Setup menu, 
then select Messages.

You can choose to have automatic notification when schedule entries or to do entries (tasks) are assigned



Controlling Startup Behavior
When you start Day-Timer Organizer, you will usually see the standard startup screen from which you can
select a view.

If you have a favorite view or set of views, you may want to save a different startup configuration.    To do 
so, open all the views you want to display at startup, and configure everything exactly the way you want it,
including:

¨ Size and position of the Day-Timer Organizer window.

¨ Size and position of each view you want open.

¨ Search settings (optional) to save for each view you have open.

Next, select Startup Screen from the Setup menu, and select "Save Current Views".    To save search 
settings in all open views, click on the "Include Search When Saving" checkbox.    To save views (and 
optionally, search settings) each time you exit, select "Save Views at Exit".    

If you have previously saved settings and you wish to use the default startup screen, select "Use Startup
Screen".



Telephone Settings
To set local area code, communications port, modem settings, or frequently used dial codes, select 
Telephone from the Setup menu.

Related Topics:
Local Area Code
Modem Settings (including TAPI and TSAPI)
Dial Codes
Direct Phone Interface (DDE)
Call Status



Local Area Code
Day-Timer Organizer's dialer will automatically place a "1" in front of all area codes except your local area
code.    If you reset this area code when you travel to another city, Day-Timer Organizer will automatically 
adjust local and long distance dialing correctly.    To reset your local area code, select Telephone from the
Setup menu, then select Local Area Code.    Type the correct area code in the provided window.

To distinguish local numbers from long distance numbers inside your local area code, place a "1" in front 
of the long distance numbers.    By default, Day-Timer Organizer will omit your local area code when 
dialing long distance within your area code.    To include your local area code in long distance calls, click 
on the Include When Dialing option.



Modem Settings (Including TAPI and TSAPI)
To verify that Day-Timer Organizer has the correct settings for your modem, select Telephone from the 
Setup menu and click on Modem Settings.    Make sure Com Port and Type of Phone settings are 
correct.

When using a modem with Day-Timer Organizer, some of the factors to consider are:

¨ Your modem must be Hayes or 100% compatible.

¨ Most PCs have 2 serial ports, labeled Com1 and Com2.    Unless you have a PS/2 style mouse, 
your mouse will normally be connected to Com1.    External modems will normally be connected 
to Com2.

¨ Internal modems have jumpers on the modem board (see your modem manual) which are 
normally set to Com4 or Com2.    If you are using an internal modem and have a computer with 
two serial ports, set your internal modem to Com4 to avoid conflicts with your 2nd serial port (if 
your internal modem must be set to Com2, disable the 2nd port via your computer's Setup utility).

¨ Com3 shares a hardware interrupt with Com1, and Com4 shares an interrupt with Com2.    For 
this reason, you should not use Com1 and Com3 (or Com2 and Com4) concurrently.

¨  If you have a multi-line phone system, make sure a dial tone is available at your modem.

Setting the Com Port
If you are using a modem, you can simply select the appropriate port (Com1 through Com4) are required. 
If you are using a TAPI or TSAPI phone system with Day-Timer Organizer, you must select that from the 
Com Port pull-down.

Using DDE
Direct Phone Interface (DDE)

Using TAPI

For Windows 3.1 / Windows NT:    If you have not already done so, you need to obtain the TAPI Add-on 
package from Microsoft.    Once you have installed this add-on package and have correctly setup your 
modem under Control Panel then you need to select Use TAPI in the Com Port pull-down.

Windows 95:    Use the Control Panel to install your telephone/modem under Windows 95.    Once this is 
complete, then    to select Use TAPI in the Com Port pull-down.

Using TSAPI

If you have not already done so, you need to obtain the TSAPI Add-on package from Novell.    Once you 
have installed this add-on package and have correctly setup your equipment under the Control Panel, 
then you need to select Use TSAPI in the Com Port pull-down.    You will then be required to select a 
NetWare TElephony Services server and to provide the login ID and password.    In addition, you must 
specify a controlled "device" (in this case, your desktop telephone extension number).    This information 
will be retained by Day-Timer Organizer for future use.      You can change your TSAPI settings later from 
the phone dialer dialog.

Related Topics:
Changing TAPI/TSAPI Settings



Setting the TSAPI Device



Dial Codes
Dial codes let you handle special dialing situations (e.g. "9" for an outside line).    To set a dial code, select
Telephone from the Setup menu, then select Dial Codes.    In addition to the code itself, you may type a 
description by which it will be referenced.    To include a dial code for all your calls, click on Use As 
Default.

To insert a telephone number into a dial code, place a caret (^) where the number will be positioned.    To 
insert a pause, use one or more commas.    To wait for a dial tone, use a W.    For a complete list of 
modem control characters, see your modem's instruction manual.



Direct Phone Interface (DDE)
Day-Timer Organizer also provides a software interface to phone systems which provide windows based 
dialing software.    This support is currently limited to Inter-Tel Axxess™ telephone systems equipped with 
Axxessory Connect™ Windows software, but future versions of Day-Timer Organizer will support 
additional systems.

Day-Timer Organizer's direct phone interface provides windows based access to all your system's 
capabilities, plus the ability to dial from within Day-Timer Organizer.

In dialing areas which support Caller ID, the direct phone interface lets Day-Timer Organizer 
automatically find the address book entry corresponding to an incoming call's phone number.    This lets 
you know who's calling before deciding whether to take a call, and gives you information about the caller 
before you pick up the phone.

For assistance with your Inter-Tel Axxess telephone system, contact Inter-Tel.

To take advantage of Day-Timer Organizer's direct phone interface capabilities, select Telephone from 
the Setup menu, then select DDE Dialing. Under the Voice Mail option, type the voice mail facility's 
extension on your system (which is not the same as your personal voice mail extension).

Related Topics:
Modem Settings (including TAPI and TSAPI)



Call Status
When you are logging phone calls, the Status field is a pull-down which allows you to set the call's status. 

The labels that are displayed in the pull-down can be customized with the Call Status option of the 
Setup...Telephone command.    This option is available only in single user databases, or when logged in 
as the Supervisor in a multi-user database.



Customizing Expense Types
Day-Timer Organizer ships with a list of expense types that will be sufficient for most users.    If you have 
specialized needs, you may substitute your own expense types for the ones we provide.    To do so, select
Expense Types from the Setup menu.    For instructions, see Tracking Expenses.    Only the supervisor 
can change the standard expense types in a multi-user database.



Creating Custom Fields
Custom fields are a flexible way for you to choose what data to associate with entries in your schedule, 
address book, to do list, expense report, phone log and notes.    

For example, you might want to track the following information for contacts:

· the date and event where you met them (e.g. a tradeshow, etc.)

· their birthday or spouse's birthday

· what industry they are in

· which products and services they are interested in

· the size of their company (e.g. number of employees, annual sales range, etc.)

You can also use custom fields to help you target your mailings.    For example, if you tracked company 
size, you might want to send a direct mail piece but only to contacts who work for companies with less 
than 50 employees.    You could then request a search by the custom field containing the number of 
employees and print mailing labels only for those contacts.

As another example, after a trade show, you might enter new contacts in your address book and you 
might want to note the type of computer system they use (e.g. Macintosh or Windows), product line 
interests, etc.

To define your own custom fields, choose the Setup...Custom Fields command.    Click on the tab that 
corresponds to the type of entry¾schedule, address book, etc.

Then simply type in the name of the new custom field.    

When you now add an address entry, clicking on the Custom Fields tab will show your field definitions.

Only the supervisor can change the names of custom fields in a multi-user database.



Setting and Displaying Holidays
Holidays display on your planning view, just like on a paper calendar.    For example, on the Daily, Weekly 
and Monthly Planner views,    the holiday name will be displayed beside the day indicator in the top left 
corner.

Day-Timer Organizer is preset with holidays from a number of countries.    By default, only holidays from 
your own country (as set in your computer's operating system environment) will be displayed on the daily, 
weekly, and monthly planner views.

Holidays are also used by the Find Time feature of the group scheduler (when you try to schedule a 
meeting, it will not search holidays for available time).    If you are using this feature, it is important to 
maintain an up-to-date holiday schedule.

Note that you should not use holidays to track birthdays or anniversaries because holidays are 
shared by all users (multi-user databases only) and are not exported and imported when you 
transfer data between systems.

Related Topics:
Setting Personal Holidays
Displaying Holidays for Other Countries
Defining New Countries and Holidays



Setting Personal Holidays
You can define new holidays if your company observes additional regional holiday or vacation days, or to 
account for personal days off (e.g. an anniversary or birthday).    For example, if a major holiday falls on a 
Tuesday or Thursday, many companies also give the corresponding Monday or Friday as a holiday to 
give staff a 4-day weekend.    You can record these holidays in Day-Timer Organizer so that no schedule 
entries are accidentally set for that day.

To define a new holiday, choose the Setup...Holidays command and you will see a dialog box with a list 
of countries whose holiday schedules are programmed into Day-Timer Organizer.    To set a special 
holiday, first be sure that your country is selected.    Click on the Holidays button to display the holidays 
for your country.    Then click on the Add button to create a new holiday.

Enter the name of the holiday and click on Is a vacation day if the company is closed for that day.

Click on the name(s) of the country or countries for which this is a holiday.

Finally, click on New in the Occurs on panel to specify the date of the holiday.

Enter the date for the holiday and click on OK to continue.    You can click on the Add Another button to 
add additional holidays.

When you click on OK, the defined holiday(s) will be added.

Note that you should maintain a list of the special holidays that you create.    Holidays are maintained as 
part of the database structure and holidays are not exported and imported.    In addition, if your database 
is damaged and you have to rebuild it, holidays may not be recovered.



Displaying Holidays for Other Countries
In addition to displaying the holidays for your own country, you may do business in other countries and 
want to be advised of their holidays.    For example, if you have relatives or business associates in 
Canada, you may wish to have Canadian holidays displayed.    If you help staff plan business trips to the 
U.K., you may need to know about British holidays.

To display another set of holidays in addition to or in place of the current set, choose Holidays from the 
Setup menu.    Any country shown with an asterisk (*) will have its holidays displayed on your planner 
views.    

To select a country's holidays for display, click on that country on the Countries list, then click on the 
Modify button, and then click on the "Show Country's Holidays" checkbox.    When you click on OK to 
close the dialog box, the holidays for the selected country will be displayed on your planner views.

To turn off any country's holiday display, click on that country, then click on the Modify button, then click 
to turn off the "Show Country's Holidays" checkbox.    When you click on OK to close the dialog box, 
the holidays for the selected country will be removed from your planner views.



Defining New Countries and Holidays
If your country is not displayed on the Countries list, you may add it by simply clicking on the add button 
and filling out its name.

To add, modify, or delete holidays, click on the Holidays button to view the holiday list.    Then click on the
Add, Modify, or Delete button as required (before modifying or deleting, click on the desired holiday to 
select it).

When adding a holiday, type its name (e.g. Independence Day), designate whether it is a vacation day, 
click on the country to which it applies, and then click on the New button for each occurrence you wish to 
add (this lets you accommodate government holidays that fall on weekends some years).    Click on the 
OK button when finished.



Database Security Setup
When you select Database from the Setup menu, you can

Set Password(s) on your Database
Set New Entry Default Rights (Viewing Rights on Entries)
Set the Quarterly Start Date

The expanded database setup options for Day-Timer Organizer for Workgroups are only available to the 
Supervisor or Database Manager.    For a discussion of database management options which pertain to 
Network installations, consult your Day-Timer Organizer Workgroup Guide.



Setting Passwords on your Database
Passwords prevent unauthorized access to sensitive information.    If you set a password, you will be 
prompted for it whenever you start Day-Timer Organizer.    There are two types of password on your 
database:
Password Type Function
user password (multi-user database 
only)

Prevents other users from 
logging in to the database with 
your user name and viewing your
private data.

database password Protects the entire database 
from access by an unauthorized 
user.    For multi-user 
databases, only the supervisor
or database manager can set 
the database password.

Related Topics:
Setting Your User Password (multi-user database only)
Setting a Database Password



Setting Your User Password (multi-user databases only)
To set your user password, select the User Security option from the Setup...Database dialog box.

¨ To set a password for the first time, click in the New field and type up to 8 characters.    Next, click
on the Verify field and type the new password.    Write down your password and keep it in a safe 
place.

¨ To change an existing password, click on the Old field and type your old password.    Then type 
your new password into the New field and again in the Verify field, as described above.



Setting a Database Password
To set a password on the entire database, select the Database Security option from the 
Setup...Database dialog box.    If your current database is a multi-user database, only the Supervisor or 
the database manager is allowed to set the database password.

¨ To set a password for the first time, click in the New field and type up to 8 characters.    Next, click
on the Verify field and type the new password.    Write down your password and keep it in a safe 
place.

¨ To change an existing password, click on the Old field and type your old password.    Then type 
your new password into the New field and again in the Verify field, as described in Setting Your 
User Password.



Setting Viewing Rights for New Entries
By default, all entries are Private - i.e. only the person who created a task may view, modify or delete it.    
You may choose to allow all entries to be viewed by everyone by clicking instead on the Viewable by 
everyone button.    You may also wish to allow all users to modify other users' entries by clicking on the 
Modifiable by everyone button.    Note that this setting would allow users to change or delete each 
others' entries.



Setting the Quarterly Start Date
By default, Day-Timer Organizer works from a calendar year.    This means that when you schedule 
recurring events to occur quarterly, Day-Timer Organizer assumes that the first quarter begins on January
1, the second quarter begins on April 1, etc.

You can change the quarter start date by choosing the Quarter Start option of the Setup...Database 
command.

To change the first day of the first quarter, simply choose an alternate month and/or day.



Coordinating Users on a Standalone System
You can coordinate the activities of several people using a single-user copy of Day-Timer Organizer.    
Simply define the people to be coordinated using the Setup...Assignees/Users command.    (Assigning 
tasks and events to other users is discussed in detail in Assigning Entries to Others.)    



Group Scheduling
For advanced group scheduling, select the  view (the TeamOrganizer view) from the button bar.    
This view shows a graphic display of an entire week's schedule for any individuals you select, allowing 
you to schedule a meeting by clicking and dragging on the display.
Use the buttons on the Display button bar to move by week or month.    The scroll bars at the bottom 
allow you to display other users or other days within the current week.
From this view, you can also manage your Email, including searching for specific messages, and adjusting the 
message display and print the message list.
From this view, you can also search for specific entries, adjust the display and print the schedule.

Related Topics:
Choosing Attendees
Finding Available Times
Removing Individuals Who Can't Attend

Viewing Timeline Entries
Individual Timelines
Group Timelines

Click and Drag Scheduling

Coordinating Users from a Standalone System



Choosing Attendees
To select individuals, groups, or resources to view or schedule, click on the Attendees button.    When 
you click on the name of each person you want to select, a check mark will appear beside their name.

Click on OK to accept your choices.

Related Topics:
 Assigning Entries to Others



Finding Available Times
To let Day-Timer Organizer find the next available time for all selected individuals, click on the Find Time 
button.    Type the required Duration (or select it from the pull down list).    Click on Find Next to find the 
first time.    Once Day-Timer Organizer finds a time, click on the Add button, or the Find Next button to 
find the next available time .    To include weekends in your search, click on Include Weekends.

Related Topics:
Choosing Attendees



Group Timelines
The right half of the window shows a block of time for the group of all selected individuals, making it easy 
to find times when everyone (or almost everyone) can attend.    To view more days, click on the horizontal 

scroll bar or the  button (the 

 button restores the pane to its original size).    To adjust the time of day, use the vertical scroll bar.

¨ Thick lines indicate that most selected names are busy.

¨ Thin lines indicate that most selected names are available.

¨ White space indicates that all selected names are available.



Individual Timelines
The left half of the window shows timelines for each individual you have selected for that particular 
calendar date (with any overlapping activities showing in red).    If there are names which do not fit in the 

left pane, use the horizontal scroll bar or click on the  button (the 

 button restores the pane to its original size).    To adjust time of day, use the vertical scroll bar.



Removing Individuals Who Can't Attend
To remove an individual who is unable to attend, click on the name of that individual on the left pane.    To 
re-select an individual, click on that name.    A check mark beside a name indicates that the name is 
currently selected.



Viewing Timeline Entries
If you click on a black area in the timeline, Day-Timer Organizer will show entries for that portion of the 
timeline.    To modify one of these entries, double click on it.    To reschedule with the mouse, click on the 
desired entry and hold down the mouse button while you drag it to a new begin time (network users must 
have view and modify rights to change an entry).

To see a list of the entries at a particular time, position your cursor over the entry so that the cursor 
changes to a magnifying glass.    Then click.



Click and Drag Scheduling
To schedule an activity for the entire group (except names removed by clicking on the name button), 
position the mouse cursor over an open timeline area in the right pane, and hold down the mouse button 
while you drag the cursor from begin time to end time.

To schedule an activity for one individual, position the mouse cursor over an open area in the left pane, 
and hold down the mouse button while you drag the cursor from begin time to end time.

Day-Timer Organizer will create a new entry, filling in Date, Begin Time, End Time, and Assign To fields 
automatically.    All you have to do is click on the Notes field, type a description, and click on OK to save 
the entry.



Administering a Workgroup 

Installing a New Workstation

Setting the Supervisor Password

Appointing a Database Manager

Setting a Database Password

Specifying Shared Network Settings

Accessing a Multi-User Database from a Single Copy of Day-Timer Organizer

Moving from a Single User to a Workgroup Environment

Transferring Data from a Single User to a Multi-User Database



Sharing Entries With Others
When working in a multi-user database, users can share entries selectively, facilitating group scheduling, 
task assignment, internal mail, and general information sharing.

The right to view an entry is controlled by how you have set viewing rights in your database.    In addition, 
when you assign a task to another user with the Assign To feature, that user automatically receives the 
right to view and modify (but not delete) the task.    The standard setting is that, viewing and modify rights 
for any new entry are set to private, which means that only the person who created it can view or modify 
it.    If you assign an entry to one or more other users (using the entry's Assign To field), each assignee 
will automatically receive rights to view and modify the entry (you may alter these rights if desired).

Assigning an entry to someone else allows them to see the entry without having to set Assignee Search,
which is ideal for Schedule and Task entries.    With other types of entries, recipients may not want their 
screens cluttered with information shared by other users.

To share an entry with someone else without forcing them to view it all the time, give them viewing rights 
without assigning the entry to them.    They may then view these entries whenever they want by clicking 
on the Assignee Search button and selecting the person who created the entries they wish to see.

When creating an entry, you can control who can view or modify an entry by clicking on the Viewing 
Rights button.    You may set viewing and modify rights independently, and you can also control whether 
users you granted Modify rights can delete the entry.

Viewing or modify rights may be set to Private, Shared, or Everyone.    If you choose Shared, you may 
select individuals or groups with whom it will be shared.

To allow all users with Modify rights to also Delete the entry, click on the "Modifiers allowed to delete 
entry" check box.

For more information on working with entries created by others, see Proxying for Other Network Users as 
well as Setting New Entry Default Rights (Viewing Rights on Entries).



Sending Internal Messages
If you have Day-Timer Organizer for Workgroups, you can exchange messages with other Day-Timer 
Organizer users.    If your office has an e-mail product which supports VIM (such as cc:Mail™) or MAPI 
(such as Microsoft Mail™), you may also send messages to other Day-Timer Organizer users via those 
mail packages.

In addition to every-day user-to-user messages, Day-Timer Organizer can generate Automatic 
Notification messages when you schedule a meeting or assign a task to another user.    Notification 
messages can be discarded after viewing without affecting the underlying schedule or task entry.

Sending and Receiving Messages

Sending a Standard Message
Sending a Reply
Meeting and Task Notification Messages

Reading a Message
Saving a Message

Viewing Messages

The Message list view displays messages.    From this view, you can also manage your Email, including 
searching for specific messages, and adjusting the message display and print the message list.

Incoming
Outgoing
Saved

Email Management

Creating a To Do Item from a Message
Seeing Who Has Read Your Messages
Seeing Who Can Attend a Meeting



Sending a Message

To send a message, begin by clicking on the  button.    From the pull-down menu, click on Message.
Day-Timer Organizer will present a template.    Alternately, you can double click on a blank entry on the 
message list view.    The Edit...New Entry...Message command also creates a message
You can fill in the template as you wish.    Typically you would

· enter a brief subject in the Subject field (this will appear in the message list view), 

· enter the message itself into the Notes field 

· select the recipient(s) by clicking on the Send To button 

·  click on OK to send the message.

In addition, the Category button allows you to assign a category to the message.    If you wish the 
message to be automatically deleted after 60 days, you can click on the Purge after 60 days option.    
The Urgent option indicates to the recipient that the message is particularly important.

The other three option tabs allow you to enter

Custom Fields

Linked Entries
Attachments



Selecting Recipients
Click on the Send To button, and select the desired recipients from the list of network users.    To select 
(or deselect) a recipient, click on the name.    When your selection is complete, click on OK.

To send a message to a group or any of its members, click on the group.    Next, either click on the All 
button to select all members, or select individual members from the list.    When finished, click on OK.

To send the message, click on the OK button.



Urgent Messages
Clicking on the Urgent check box when creating a message designates a message as urgent.    In this 
case, each recipient running Day-Timer Organizer (even in a minimized or inactive window) will receive a 
popup message notification with an audio alert.



Purge After 60 Days
By default, any new message will be discarded from your Out Box sixty days after it is sent.    To keep it 
indefinitely, click on the Purge after 60 days check box to remove the check mark.

Note: The purge setting does not affect the ability of recipients to save any message to their personal 
message history.



Viewing Incoming Messages
When another user sends you a message, Day-Timer Organizer displays a message icon on the status 

bar at the bottom of the Day-Timer Organizer window.    To view incoming messages, click on the  
button in the View button bar at the top of the window or select Messages from the View menu.
Click on the In button on the Display button bar to display incoming messages.    To view the complete 
text of a message, double click on an entry and then click on the Notes tab.
Your most recent messages appear at the top of your list.    If there are any schedule or task notification 
messages, you will see them as Schedule or Task entries rather than Messages under the Type column.
To move through your message list, use the scroll bar (or PgUp, PgDn, and Arrow keys).    You may also 
search through your messages by assignee, category, priority (tasks only), entry type, or words they 
contain.

Custom Fields

Linked EntriesLinkingEntries.131
Attachments

Related Topics:
Sending Internal Messages

Adjusting the message display

Printing the message list.



Reading a Message
To view the complete contents of a message, double click on that message.    If the message is long, you 
may expand the text field by clicking on the  icon at the bottom of the scroll bar.
The message template typically contains

· a brief subject in the Subject field (this will appear in the message list view), 

· the message itself into the Notes field 

In addition, the Category button lists the message category.    The Urgent option indicates that the 
message is particularly important.

The other three option tabs allow you to display

Custom Fields

Linked Entries
Attachments



Saving a Message
By default, Day-Timer Organizer discards messages after you read them.    To save a message, click on 
the Save to History check box.    Where a message is sent to multiple users, each user's decision to 
save or discard is personal in scope, and does not affect other users.

Note that by default, the Remove from In-Basket option is checked.    If you click on this box to turn this 
option off, the message will remain in the incoming messages list.



Viewing Saved Messages

To view incoming messages you saved after reading, click on the  button at the bottom of the View 
window or select Incoming History from the View menu.



Creating a Task from a Message
When a message requires action on your part (such as a phone message you want to return), you can 
add it to your current task list by clicking on the Add Task button at the bottom of the message window.



Sending a Reply
To send a reply after you have read an incoming message, click on the Reply button at the bottom of the 
message window.    Day-Timer Organizer will generate a pre-addressed reply template.    Type in your 
reply, and then click on OK.



Meeting and Task Notification Messages
After inspecting a message which notifies you of a schedule or task assigned to you, click on OK to 
discard it from your In Box (the schedule or task entry itself may be viewed elsewhere).    If the message 
is a meeting notification, you will be asked whether or not you can attend.



Viewing Outgoing Messages
By default, Day-Timer Organizer displays incoming messages.    To view outgoing messages, click on the

    button at the bottom of the View window.
To view the complete text of a message, double click on an entry and then click on the Notes tab.
Your most recent messages appear at the top of your list.    If there are any schedule or task notification 
messages, you will see them as Schedule or Task entries rather than Messages under the Type column.
To move through your message list, use the scroll bar (or PgUp, PgDn, and Arrow keys).    You may also 
search through your messages by assignee, category, priority (tasks only), entry type, or words they 
contain.

Custom Fields

Linked Entries
Attachments

Related Topics:
Sending Internal Messages

Seeing Who Has Read Your Messages

Seeing Who Can Attend a Meeting

Adjusting the message display

Printing the message list.



Seeing Who Has Read Your Messages
To determine who has read a message you sent, select the outgoing message list (see above), and 
double click on the desired message.    When you click on the Send To button, all addressees who have 
read the message will show an R next to their selection check mark.



Seeing Who Can Attend a Meeting
For notification messages, proceed as above, but click on the Notify button.    Any addressee who has 
read a schedule notification message and can attend will show a happy face.    Any addressee who has 
read and cannot attend will show a sad face.



Coordinating Tasks with Notification Messages 
When you assign a task to someone else, each assignee may automatically receive a notification 
message, if they have requested notifications.    

To disable notification messages, or to select additional recipients, click on the Notify button.

Selecting message recipients is similar to selecting assignees with the Assign To feature, discussed in 
Assigning Entries to Others.



Proxying for Other Network Users 
The proxy option lets you quickly switch to another network user's data (if they have granted you proxy 
rights) as if you had logged on under their name.    This feature lets people who work together closely 
substitute for one another (e.g. to allow an administrative assistant to manage schedule when co-workers 
are on a trip).

To switch to another user who has granted you proxy rights, select the Proxy option from the Tools 
menu, click on the desired user name, then click on OK.

You may also selectively grant other network users proxy rights to view and modify your data.    To grant 
or revoke proxy rights to others, select the Proxy command from the Tools menu, click on Grant Proxy 
Rights, then click on each user you wish to grant proxy rights.    When you grant rights to a user, a check 
mark will appear beside the user's name to confirm that they have been selected.    When you wish to 
revoke rights, simply click on the user name and the check mark will disappear.

Finally, click on OK to save your changes.



Assigning Rights to the Database
Before a user can access the shared, multi-user database for Day-Timer Organizer, they must first have 
the right to access the network drive where the database is located.    A description of how the Novell 
NetWare supervisor assigns these rights is provided below for your convenience.    For other types of 
networks, consult your system documentation or consult your system administrator for more information.

1. Log in as the Novell Supervisor.

2. Map your active directory to the PUBLIC directory - usually on drive F:.

3. Type Syscon and press the Enter key.

4. Select User Information from the menu.

5. Select the user name that you are assigning rights to (the new user to be enabled).

6. In the User Information windows, select Trustee Directory Assignments.

7. Press the Insert key and then enter the full volume and path of where Day-Timer Organizer is 
installed.    For example,    

SYS:DTO21

For correct syntax, ask your system administrator or consult your system documentation.    Once 
you have entered this information, press the Enter key.

8. In the Rights Granted window, press the Insert key to bring up the Trustee Rights Not Granted 
Window.

9. Now highlight each right you want to give to this user and hit the F5 key for each one.

You need to give Read rights on \DTO21 and Read, Write, and Modify rights on \DTO21\FILES 
and \DTO21\USER.

10. When complete, press the Enter key to exit.    This will take you to the Trustree Rights Granted 
Window and all of the rights that you have selected will be listed here.

11. Press the Escape key. This will bring you back to Trustee Directory Assignments.      Once 
again, all of the rights you selected will be noted in the brackets to right of the directory 
assignment.

12. Press the Escape key 4 times.    Respond YES to exit Syscon.



Installing New Users
To set up new users, from the user workstation, run the workstation setup program (WSSETUP.EXE) from
the shared network drive where it is located.    Note that you must have enough licenses for the new user 
to access the multi-user database.    

If you can't run the workstation setup program:

1. Check to make sure you have the proper rights to the DTO21 directory.      Consult your system 
administrator for additional help.

2. If you cannot locate WSSETUP.EXE, Make sure you have the proper rights to this directory and 
that you are looking in the correct location of where Day-Timer Organizer is installed.

Related Topics:
Granting User Rights on Novell Networks

Connecting to a Network Drive on Novell Networks

Setting up a Windows Workstation

Setting up a Macintosh Workstation

Deleting a User



Connecting to a Network Drive 
Before you can access the multi-user database or central program files for Day-Timer Organizer, you 
must connect to the network drive where these files are located.    A description of how to do this on a 
Novell network is provided below for your convenience.    For other types of networks, consult your system
documentation or consult your system administrator for more information.

Windows 95:
1. On the Desktop, click the right mouse button on the Network Neighborhood icon.

2. Click on Map Network Drive.    On the Map Network Drive dialog box, select a drive letter that 
does not currently have anything mapped to it. (This will be the letter assigned to the drive at your
workstation.)

3. Type in the complete volume and path including the network server of where Day-Timer 
Organizer  is installed. For the correct syntax of this, consult your system administrator.

4. Click on Reconnect at Logon if you want this to be a permanent connection.

5. CLick on OK.

Note:    For specific rights to the directory you have set up, the system administrator will have to grant 
these.    You can only map to a network drive, after the system administrator grants you the rights to the 
DTO21 directory on fhe file server.

Windows 3.11:
1. Open the File Manager by double clicking on it.

2. From the Disk menu, select Network Connection.

3. From the Netware Drive Connections dialog box, select a drive letter that does not currently 
have anything mapped to it.

4. Type in the complete volume and path including the network server of where Day-Timer 
Organizer  is installed. For the correct syntax of this, consult with your system administrator.

5. Click on Permanent if you want this to be a permanent connection.

6. Click on Map.    You will be prompted: "Remap network device?",    and you should click on OK.

7. Hold down the Alt key and press X to exit.

Note:    For specific rights to the directory you have set up, the system administrator will have to grant 
these.    You can only map to a network drive, after the system administrator grants you the rights to the 
DTO21 directory on fhe file server.



Installing a Windows Workstation 
Installing Day-Timer Organizer for Workgroups requires several steps for Windows systems:

1. Install program files:    copy programs to a central location and create the multi-user database

2. Login for the first time:    set up the workstation and login as the Supervisor user

3. Define users

4. Set up workstations to access the central database

Step 1:    Installing Files
Starting the Installation Program

Windows 3.x:    Choose the File...Run command from the Program Manager.    Click in the Command 
Line box and type a:setup, then click on the OK button (if installing from Drive B, type b:setup).

Windows 95:    Choose the Run command from the Start menu.    Click in the typing box and type 
a:setup, then click on the OK button (if installing from Drive B, type b:setup).

Choosing the Type of Installation

The screen will display the Day-Timer Organizer window and the Installation Setup dialog box will appear. 
Select one of the following options and click on OK to proceed.

Option Meaning

Full Installation Install all program files and create a new set of 
data files.

Upgrade from Day-Timer Organizer 1.0 For use only by users who have a copy of Day-
Timer Organizer, version 1 installed; this option 
will upgrade the old program files and prompt you
to convert the old data files for use with Day-
Timer Organizer 2.

Upgrade from Day-Timer Organizer 2.0 For use only by users who have a copy of Day-
Timer Organizer, version 2 installed; this option 
will upgrade the old program files and prompt you
to convert the old data files for use with Day-
Timer Organizer 2.1.

Copy program files This reverses an Uninstall; no new data files will 
be created; this option can also be used if your 
program files have been damaged and need to 
be replaced.

Increase licensed user count When installing additional user licenses; this 
selection increases the internal license count to 



allow additional users to access the central 
database.    For information about purchasing 
additional licenses, contact Day-Timer 
Technologies, Inc.

Selecting the Location for the Program Files

The next screen allows you to specify the network drive and directory where Day-Timer Organizer will 
store its files.    To accept the recommended program and data directory paths, click on OK.    

To choose another directory, select a new drive or type a different directory name and then click on OK.

Setting the Network Type

Select your network type from the list.    If your network is not on the list, select NetBIOS if it is peer-to-
peer or NetBIOS-compatible; if not, select Other (if you select Other, your system will not have urgent e-
Mail alerts or message notification on the status bar).

Setting Registration Information

Finally, from the next screen, type your name, press Tab, and enter your company name.

Finishing the Installation

When you have filled in all the information, click on OK.      

At this point, Day-Timer Organizer will be copied to your network drive and a central multi-user database 
called Office will be created in the DTO21\files directory.      You will be prompted to insert additional 
disk(s) as required. 

Installing More than One Set of Licenses

If you have more than one set of licenses (e.g. if you purchased a 5-user license package and a 2-user 
license), you will need to install the additional licenses.    

Step 2:    Logging In For the First Time
When Day-Timer Organizer for Workgroups is first installed, there are two system users:

· Supervisor, whose special privileges include adding and deleting users or database members.    
This name should be reserved for system maintenance purposes.    If the system administrator 
uses Day-Timer Organizer for Workgroups for other purposes, it should not be as Supervisor, but 
rather under a separate user name.

· Guest, which is the name given to anyone who logs in without a user name.    Users who log in as
Guest will be restricted to databases where access by non-members has been enabled (for more 
information, see Database Access by Non-Members on page42).

Setting Up the Workstations

Before you can log in to the central multi-user database, you must set up the workstation by running the 
Workstation Setup program, which will set up a Day-Timer Organizer for Workgroups icon (and, if desired,
copy executable files to the workstation).    Once this is done, you can log in to Day-Timer Organizer for 
Workgroups by double clicking on the new icon.    Run the workstation setup program as follows:



Starting the Workstation Setup Program 

Windows 3.x:    Choose the File...Run command from the Program Manager.    Click in the Command 
Line box and type a:wssetup, then click on the OK button (if installing from Drive B, type b:wssetup).

Windows 95:    Choose the Run command from the Start menu.    Click in the typing box and type 
a:wssetup, then click on the OK button (if installing from Drive B, type b:wssetup).

Completing the Workstation Setup 

Once the workstation setup program has started, select the drive and path where program files should be 
placed.      When finished, click on OK.

Logging in as the Day-Timer Organizer Supervisor

To start Day-Timer Organizer and log in as Supervisor, double click on the Day-Timer Organizer icon, and
specify the user name as Supervisor.

Step 3:    Defining Users
Individuals may use more than one login name.    For example, a clerical assistant may log in under the 
department head's name.    Or the system administrator may log in as the Day-Timer Organizer 
Supervisor user or under their own name.

Defining New Users

To set up new Day-Timer Organizer user names, proceed as follows:

1. Log in as the Day-Timer Organizer Supervisor.

2. Select Assignees/User Names from the Setup menu.

3. If you have Novell NetWare, click on the Use Bindery option under the Add button, which lets you 
add users from your network directory services.

4. If you do not have Novell NetWare, click on the    button and choose User from the pull-down 
menu.    

5. Enter a unique user name (users will use this name when they log in to Day-Timer Organizer), up 
to 20 letters or numbers with no spaces.    In addition, you can specify a description and password
as described below.

The optional Description field allows you to provide a full name to describe the user (up to 20 characters). 
For example, the Name field might be 

          RJONES or ROBERT

and the Description might be

          Robert Jones (Marketing).

If desired, click on the Set Password button to enter a password for the new user.    Passwords protect the



privacy of both personal and shared information, and are recommended.    Each user may reset or clear 
this password at any time by selecting Database on the Setup menu and clicking on the User Security 
icon.    If necessary, the Supervisor can reset or clear (but not view) a user password.

On Windows systems, Day-Timer Organizer for Workgroups allows users to send each other messages, 
including automatic meeting and task notification messages.    If you have an e-Mail package which 
supports VIM (vendor independent messaging) or MAPI (message application protocol interface) 
message exchange, and want this user's Day-Timer Organizer messages routed through third party e-
Mail instead of Day-Timer Organizer's, enter the user's e-Mail address.

Reading Novell Bindery 

If you have Novell NetWare (not NetWare Lite), Day-Timer Organizer for Workgroups can build a user list 
directly from your network's directory services.    To select this option, click on the Use Bindery option 
under the Add button.    Day-Timer Organizer for Workgroups will present a list of network users and 
groups.

Click on the individuals or groups you want to include.    A check mark will appear next to each selected 
item.    When you select a group, Day-Timer Organizer will turn on checkmarks for all group members.    
When finished, click on OK.

You will be given the opportunity to adjust settings for each new user.

Step 4:    Setting Up Workstations
Each copy of Day-Timer Organizer (or each license for Day-Timer Organizer for Workgroups) is to be 
used by a single person.    When additional people need to use Day-Timer Organizer, you should 
purchase additional copies or licenses. 

Note that the only difference between single copies and licenses is that licenses are sold in quantity and 
are therefore less expensive.

If you purchased a single package (e.g. for 20 licenses), you can skip the next step since the license 
information was installed when the program was installed in Step 1.

Adding User Licenses

 In order for both Macintosh and Windows systems to access the same data files, both must use at least 
version 2.1 of Day-Timer Organizer.

To begin installing additional user licenses (after first having installed Day-Timer Organizer for 
Workgroups), first insert disk 1 into the disk drive.

Windows 3.x:    Choose the File...Run command from the Program Manager.    Click in the Command 
Line box and type a:setup, then click on the OK button (if installing from Drive B, type b:setup).

Windows 95:    Choose the Run command from the Start menu.    Click in the typing box and type 
a:setup, then click on the OK button (if installing from Drive B, type b:setup).

Increasing the License Count

You will be prompted for the location of your current Day-Timer Organizer for Workgroups files.    The 
licensing information in those files will then be updated to allow the additional users.

Running the Workstation Setup Program

Note that this step is not required for systems with single user versions.    Before you can log in to the 



central multi-user database, you must set up the workstation by running the Workstation Setup program, 
which will set up a Day-Timer Organizer for Workgroups icon (and, if desired, copy executable files to the 
workstation).    Once this is done, you can log in to Day-Timer Organizer by double clicking on the new 
icon.    Run the workstation setup program as follows:

Starting the Workstation Setup Program 

Windows 3.x:    Choose the File...Run command from the Program Manager.    Click in the Command 
Line box and type a:wssetup, then click on the OK button (if installing from Drive B, type b:wssetup).

Windows 95:    Choose the Run command from the Start menu.    Click in the typing box and type 
a:wssetup, then click on the OK button (if installing from Drive B, type b:wssetup).

Completing the Workstation Setup 

Once the workstation setup program has started, select the drive and path where program files should be 
placed.      When finished, click on OK.

Adding Single Users

To add a single user, you can purchase a single-user copy of Day-Timer Organizer and install it on the 
workstation.    

Running Day-Timer Organizer from Workstations

Once you have installed a single copy of Day-Timer Organizer or run the workstation setup program, you 
can run Day-Timer Organizer from a workstation by double clicking on the Day-Timer Organizer icon.

When you run the program from a workstation, it runs local program files (that were created during 
installation) and accesses the database files, using the user name that was specified during workstation 
setup.



Installing a Macintosh Workstation 
If you are using both Windows and Macintosh workstations to access a central multi-user 
database, we recommend that you install the Windows software first.

Installing Day-Timer Organizer for Workgroups requires several steps for Macintosh systems:

1. Install program files

2. Login for the first time:    create the multi-user database and login as the Supervisor user

3. Define users

4. Set up workstations to access the central database

Step 1:    Installing Files
Starting the Installation Program

Double click on the Day-Timer Installer icon.

From the opening screen, click on Continue to begin the installation.

Specifying the Locations of Files

The next screen allows you to select the location of the Day-Timer Organizer program files.    By default, 
they will be copied to a folder called Day-Timer Organizer 2.1 on your main hard disk.    You can accept 
the default value or select an alternate location from the next screen.

You can select a different location by clicking on the pull-down in the Install Location box.    The Switch 
Disk button allows you to change to a different disk or to a different folder on the currently selected disk.    
Click on the Install button to proceed.

In order to install Day-Timer Organizer, all open applications must be closed.    You will be prompted to 
confirm that the installation utility can close all applications that are currently in use.    Once that is 
complete, the Day-Timer Organizer program files will be copied to the destination of your choice and your 
computer will be restarted.

Installing More than One Set of Licenses

If you have more than one set of licenses (e.g. if you purchased a 5-user license package and a 2-user 
license), you will need to install the additional licenses. 

Step 2:    Logging In For the First Time
Creating the Central Database

To begin, start Day-Timer Organizer by double clicking on the program icon.

If you are using both Windows and Macintosh workstations to access a central multi-user database AND 
you have already installed the Windows software, click on the Open button and choose the Office 
database stored under the Windows \DTO21\Files subdirectory.

If you are not using Windows and this is the first time that you have installed the Macintosh software for 



Day-Timer Organizer, you must create the central multi-user database.    To do that, simply click on the 
New button from the opening dialog box.    From the next dialog box, specify the database location to be a
shared location on the network.    We recommend that you name the database Office.    Be sure that the 
Multi-User Database button is selected before clicking on OK to proceed.

When the multi-user database for Day-Timer Organizer for Workgroups has been opened or created, 
there are two system users:

· Supervisor, whose special privileges include adding and deleting users or database members.    
This name should be reserved for system maintenance purposes.    If the system administrator 
uses Day-Timer Organizer for Workgroups for other purposes, it should not be as Supervisor, but 
rather under a separate user name.

· Guest, which is the name given to anyone who logs in without a user name.    Users who log in as
Guest will be restricted to databases where access by non-members has been enabled (for more 
information, see Database Access by Non-Members on page42).

Logging in as the Day-Timer Organizer Supervisor

If you have just    created the database, you will automatically be logged in as the Supervisor user.    

If you have just opened the database with the File...Open command, you will be prompted for a user 
name and password.    At that point, you can specify the Supervisor user.    After installation, the password 
for the Supervisor user is blank. 

Step 3:    Defining Users
Individuals may use more than one login name.    For example, a clerical assistant may log in under the 
department head's name.    Or the system administrator may log in as the Day-Timer Organizer 
Supervisor user or under their own name.

Defining New Users

To set up new Day-Timer Organizer user names, proceed as follows:

1. Be sure that you are logged in as the Day-Timer Organizer Supervisor, as described on page30.

2. Select Assignee/User Setup from the Setup menu.

3. If you have Novell NetWare, click on the Use Bindery option under the Add button, which lets 
you add users from your network directory services.

4. Click on the screen box for Users and Resources and then click on the Add button at the bottom
left of the dialog box.

5. Enter a unique user name (users will use this name when they log in to Day-Timer Organizer), up 
to 20 letters or numbers with no spaces.    You may also specify a description or password as 
described below.

The Description field allows you to provide a full name to describe the user (up to 20 characters).    For 
example, the Name field might be 

RJONES or ROBERT

and the Description might be



Robert Jones (Marketing).

If desired, click on the Set Password button to enter a password for the new user.    Passwords protect the
privacy of both personal and shared information, and are recommended.    Each user may reset or clear 
this password at any time by selecting Database on the Setup menu and clicking on the User Security 
icon.    If necessary, the Supervisor can reset or clear (but not view) a user password.

Reading Novell Bindery 

If you have Novell NetWare (not NetWare Lite), Day-Timer Organizer for Workgroups can build a user list 
directly from your network's directory services.    To select this option, click on the Use Bindery option 
under the Add button.    Day-Timer Organizer for Workgroups will present a list of network users and 
groups.

Click on the individuals or groups you want to include.    A check mark will appear next to each selected 
item.    When you select a group, Day-Timer Organizer will turn on checkmarks for all group members.    
When finished, click on OK.

You will be given the opportunity to adjust settings for each new user.

Step 4:    Setting Up Workstations
Each copy of Day-Timer Organizer (or each license for Day-Timer Organizer for Workgroups) is for one 
individual.    When additional people need to use Day-Timer Organizer, you should purchase additional 
copies or licenses. 

Note that the only difference between single copies and licenses is that licenses are sold in quantity and 
are therefore less expensive.

If you purchased a single package (e.g. for 20 licenses), you can skip the next step since the license 
information was installed when the program was installed in Step 1.

Adding User Licenses

 In order for both Macintosh and Windows systems to access the same data files, both must use at least 
version 2.1 of Day-Timer Organizer.

To install additional user licenses (after first having installed Day-Timer Organizer for Workgroups), insert 
the license disk into the disk drive and double click on the Day-Timer Installer icon.

Select the Day-Timer Organizer 2.1 folder and the licensing information in that folder will be updated.    
Once you have updated the license information, run the workstation setup program for each workstation 
as described below.

Running the Workstation Setup Program

Double click on the DTO 2.1 Workstation Install icon on the network drive.

Once the workstation setup program has started, select the drive and path where program files should be 
placed.      When finished, click on OK.

Adding Single Users

To add a single user, you can purchase a single-user copy of Day-Timer Organizer and install it on the 
workstation.    

Running Day-Timer Organizer from Workstations



Once you have installed a single copy of Day-Timer Organizer or run the workstation setup program, you 
can run Day-Timer Organizer from a workstation by double clicking on its icon.

When you run the program from a workstation, it runs local program files (copied during installation) and 
accesses the database    using the user name that was specified during setup.



Setting Shared Network Settings
Associated with the centralized database are a variety of settings which can be set by the system 
administrator.    Once set, these affect all users who access the shared central database.

Expense Types

Holidays

Shared Dial Codes

Call Status Labels

New Entry Default Rights

Database Access by Non-Members

Custom Database Fields

Shared Assignees and Categories



Expense Types
Day-Timer Organizer ships with a list of expense types that will be sufficient for most users.    If your 
company has specialized needs, you may substitute your own expense types for the ones we provide.    
To do so, select Expense Types from the Setup menu.    Click on any type you wish to change, and type 
your own text.    Because of the special features associated with Entertainment and Mileage types, these 
types cannot be customized.



Holidays
Day-Timer Organizer lets you select one or more countries whose holidays you wish to display.    You can 
customize the holiday list for any country.    To do so, select Holidays from the Setup menu.    

From the resulting dialog box, you can first add any country for which you wish to define the holidays.    To
do that, click on the Country button and use the Add button to define an additional country.

To define a holiday, click on the Holiday button and then use the Add button to define a new holiday.



Shared Dial Codes
Shared dial codes let the Supervisor establish system-wide dial codes to handle special dialing situations 
(e.g. 9 for an outside line), eliminating the need for users to set these up individually.

To set shared dial codes, select Telephone from the Setup menu, then select Dial Codes.    The first four 
dial codes on the list are reserved for network-wide shared codes (which only the Supervisor can set or 
modify).    In addition to the code itself, you may type a description by which it will be referenced (for more 
information, see Dial Codes in the Day-Timer Organizer on-line help.



Call Status Labels
Day-Timer Organizer ships with a call status list that will be sufficient for most users.    If your company 
has specialized needs, you may substitute your own for the ones we provide.    To do so, select Telephone
from the Setup menu, then select Call Status.    Click on any status you wish to change, and type your 
own text.



New Entry Default Rights
By default, new entries are marked as private, which means that only the creator of an entry can view or 
modify it.    Where there is no need for private entries, select Database from the Setup menu and click on 
the User Security icon.

If you click on Modifiable By Everyone, all users will be able to view and modify new entries (users may 
view entries not directly assigned to them by setting Assignee Search).

If you click on Viewable By Everyone, all users will receive viewing rights to new entries (users may view 
entries not directly assigned to them by setting Assignee Search).

Default settings may be easily overridden on an entry by entry basis when privacy is required for sensitive
information.



Database Access By Non-Members
Normally, users who are not members of a database cannot access it.    To grant limited access by non-
members, select Database from the Setup menu and click on the Database Security icon.

If you click on View Public Entries, non-members may view (but not modify) all entries with viewing rights 
set to Everyone (see the Day-Timer Organizer on-line help).

If you click on Add/Modify/View Public Entries, non-members may add, view, or modify entries with 
viewing rights set to Everyone.

Even if access by non-members is permitted, non-members will have no user identity (they will be treated 
as user Guest, which is the name given to anyone who logs in without a User Login Name).



Custom Database Fields
Day-Timer Organizer allows each database to have up to 12 custom data fields for each entry type 
(schedule, task, address, etc.).    Each custom field can store up to 40 characters of text or numbers, 
giving users with specialized needs the flexibility to store data specific to their profession.    Stockbrokers, 
for example, might want to store data such as net worth, annual income, and risk sensitivity for each of 
their clients.

To set up custom field labels for the current database, log in as either the Supervisor or Database 
Manager, then select Custom Fields from the Setup menu.    Click on the Entry Type tab you want.    Day-
Timer Organizer will display custom field labels for that type.    Next, click on the field you wish to label, 
and type the label text.



Shared Assignee and Category Control
Shared names and categories are viewable by all users of a shared database.    Each Day-Timer 
Organizer for Workgroups database can have its own names and categories, independent from those in 
other databases.    Day-Timer Organizer for Workgroups allows up to 720 shared names and 700 shared 
categories (plus 48 shared name groups and 48 shared category groups) per database.    In addition, 
each user may have up to 64 personal names (e.g. family members) and 240 personal categories, which 
will not be viewable by any other user.

Limiting who can add or modify shared assignees and categories helps reduce clutter and assure 
consistency (creating groups of names and categories also reduces clutter).

To designate who can add or modify shared assignees and categories, select Database from the Setup 
menu and click on the Rights/Access icon.    Click on the Select button, and then click to select or deselect
users (all users are initially selected).    To prevent users from being able to view others' data by adding 
themselves to a group, only the Database Manager or Supervisor can specify shared group membership.



Accessing a Multi-User Database from a Single Copy 
of Day-Timer Organizer
If some of your users have existing copies of Day-Timer Organizer that were purchased for stand-alone 
systems, they can still use the centralized database of the networked system.

To do this, simply log onto the network from the machine with the stand-alone copy of Day-Timer 
Organizer.    Then choose the Open command from the File menu and choose the name and location of 
the centralized database.    You will be prompted for the user password if one has been set.

In a similar way, other users on the network may optionally access the data that is stored in a stand-alone
system by opening the databases on that machine.    Generally, when individuals create databases (at 
installation) on their stand-alone systems, they create them with the Single-user database option.    This 
means that only one person at a time can access them.    If data on a stand-alone computer is to be used 
on a network at a later time, it should be created with the Multi-user database option set.



Moving from a Single User to a Workgroup 
Environment
Single User vs. Multi-User Databases

Day-Timer Organizer can be used stand-alone (single-user database) or as a workgroup solution (multi-
user database).    As long as the Day-Timer Organizer database was created with the multi-user option, it 
can be accessed by two or more users and take advantage of the workgroup features.    Note that a multi-
user database can be accessed by either Windows or Macintosh users, with stand-alone copies of Day-
Timer Organizer or with a Day-Timer Organizer for Workgroups license.

Adding User Licenses to your Single User Version

If you have an existing stand-alone version of Day-Timer Organizer with a single-user database you can 
access workgroup features by installing additional software on another computer:

· installing an additional stand-alone copy of Day-Timer Organizer on another computer, as 
described in the Getting Started Guide; during installation, select the Full Installation option, be 
sure to set your network type correctly, and choose the Multi-User Database button when 
creating the database

OR

· installing a multi-user license for Day-Timer Organizer for Workgroups    in a central shared 
location on the network and following the installation instructions for Windows or Macintosh as 
appropriate.



Transferring Data from a Single-User Database to a 
Multi-User Database
After you have installed the additional users and created a multi-user database, you can transfer the data 
from your current single-user database to the multi-user database that was created during installation of 
the new user software.    To do this,

Open the single user version of Day-Timer Organizer.

Export all of the entries in the database and include all assignees and categories.    To do this, any view 
can be displayed on the screen.    Choose the File...Export Entries command from the menu.

By default, the Windows version of Day-Timer Organizer will create an export file that ends in .exp and we
recommend that Macintosh users also add .exp to the end of the exported file that will be created.

Use the File...Open command to open the new, multi-user database.    Log in as the Supervisor user.

By default, the new entries that you are about to import will be set to be private to you.    To change this, 
from any view choose the Setup...Database command and set the New Entry Default Rights before 
importing the single user data.    This will specify how the imported entries are treated, either as private to 
the current user or as viewable or modifiable by other users.

By default, only the Supervisor user can add or change shared categories.    You can select additional 
users for this privilege by choosing the Setup...Database command and then clicking on the Database 
Security icon.

Add any new shared categories, assignees and users to match the names used in the single-user 
version.    The assignees and categories will be imported as personal unless you specifically add them as 
shared entries, prior to the import.

Use the File...Import command to import the .exp file created above.

Once the data has been imported, you may prefer to use the Setup...Database command to reset the 
New entry Default Rights so that users may create private entries.



Appointing a Database Manager
Day-Timer Organizer for Workgroups allows you to create as many shared databases as you wish.    You 
may also establish a database manager for any database.    Database setup options (which define 
database security, user security, viewing defaults, user access, user privileges, and custom field labels) 
are available only to the Supervisor or the database manager.

To access database setup options, log in as either the Supervisor or Database Manager, then select the 
Database option on the Setup menu.    Database setup options affect the currently selected database only
(see the Day-Timer Organizer on-line help for a discussion of working with multiple databases).

By default, the user who creates a network database becomes the database manager and has control 
over who may access the database and how it will be used. 

Designating the Database Manager
To appoint a new database manager, select Database from the Setup menu, and then click on the 
Database Security icon.    Click on the Manager button, then click on the new database manager's 
name.    When finished, click on OK.



Setting the Supervisor Password
To prevent unauthorized tampering with user, database, and system settings, a Supervisor password is 
highly recommended.    You will be prompted for this password whenever you log in to Day-Timer 
Organizer as the Supervisor.    To set or change the Supervisor password, log in as the Supervisor, select 
Database from the Setup menu, and click on the User Security option.

To set a password for the first time, click in the New Password field and type up to 8 characters.    Next, 
click on the Verify field and type the new password.    Write down your password and keep it in a safe 
place.

To change an existing password, click on the Old Password field and type your old password.    Then 
type and verify your new password as described above.

To clear your password, click on the Old Password field and type your old password.    Next, click on the 
Clear Password check box, then click on OK.



Deleting a User
To delete a user, select Assignees/Users from the Setup menu, click on the user you wish to delete, then 
click on the Delete button.    



Setting a Database Password
To set, change, or clear a database password, log in as either the Supervisor or Database Manager and 
select Database from the Setup menu.    Click on the Database Security icon.

To set a password for the first time, click in the New Password field and type up to 8 characters.    Next, 
click on the Verify field and type the new password.    Write down your password and keep it in a safe 
place.

To change an existing password, click on the Old Password field and type your old password.    Then 
type and verify your new password as described above.

To clear your password, click on the Old Password field and type your old password.    Next, click on the 
Clear Password check box, and then on OK.



Choosing Paper
The printouts are intended for use in loose-leaf binder systems or as stapled booklets.    Note that 
printouts cannot be used with wire bound formats.

You can print from Day-Timer Organizer either on 

· plain paper

or on 

· special forms available from Day-Timers, that are perforated and punched to allow them to be 
quickly inserted into your paper organizer system

Note that you cannot print on the dated planner pages from your paper Day-Timer Organizer, but rather 
the blank paper with shaded areas, intended specifically for Day-Timer Organizer.    Once printed, the 
pages can be inserted into your regular organizer binder.

Related Topics:
Ordering Day-Timer Preprinted Forms
Purchasing Other Special Forms
Using Day-Timer Organizer Printouts with Other Paper Planner Systems



Ordering Day-Timer Preprinted Forms
To order Day-Timer preprinted forms, contact your local computer retailer or Day-Timers, Inc.
If you are located in... Sales Phone Number
United States (800) 225-5005
Canada (800) 465-5501
UK 0800 716134
Australia 1800 251 861
New Zealand 0800 808 383

Please specify product number when ordering.    All paper sizes may not be available in all countries.    
Day-Timer Organizer does not support continuous feed paper.

Loose Leaf Style ¾ Sheet Feed and Laser Printers 
¨ Folio (M - Senior Desk) - Product # 20250    8-1/2" x 11"

¨ Desk (L - Junior Desk) - Product # 20251    5-1/2" x 8-1/2"

¨ Portable (K - Senior Pocket) - Product # 20254    3-3/4" x 6-3/4"

¨ Jotter (J - Junior Pocket) - Product # 20255    2-3/4" x 5"

On some Canon printers, the 'paper out' sensor is lined up with the pre-punched holes in the Desk paper. 
As a result, the paper may not work well with these printers.

For Desk printouts, you can also use plain paper, cut it in half, and punch it with the special punch sold by
Day-Timers, Inc.

Booklet Style ¾ Sheet Feed and Laser Printers 
¨ Pocket Booklet (C) - Product # 20252    3-1/2" x 6-1/2"

¨ Compact Booklet (B) - Product # 20253    3" x 5"

For Folio (8.5" x 11") binders, plain paper pages can be punched and inserted into your binder.    However,
for the smaller sizes , the Day-Timer preprinted forms are strongly recommended because they can be 
torn apart on the perforations and inserted directly into your binder.    If the forms are printed on plain 
paper, they must be cut apart manually for insertion.



Purchasing Other Special Forms
For other forms such as mailing labels, rotary cards and envelopes, suppliers such as Avery provide a 
variety of types and styles for your laser printer.    Day-Timer Organizer can print on a standard form, or 
you can customize the settings for any form you choose.

Note that the selected size of envelope must also be supported by your printer.    Day-Timer Organizer 
does not support continuous feed paper or sheet forms (non-label) from Avery.



Using Day-Timer Organizer Printouts with Other Paper Planner Systems
The printouts from Day-Timer Organizer can be used in the binder from your existing paper-based 
planner system.    The page equivalents are shown below.
Day-Timer Page Size Dimensions Day-Runner 

Equivalent
Franklin Quest 
Equivalent

Folio                  (Sr. Desk) 8 1/2 x 11 Entrepreneur Monarch
Desk                  (Jr. Desk    ) 5 1/2 x 8 1/2 Classic Classic
Portable      (Sr. Pocket ) 3 3/4 x 6 3/4 Running Mate Compact



Printer Setup
Before you can print, you must have installed your printer and its driver.    If you have not done this yet, 
refer to the manuals for your computer and printer for instructions.    We recommend that you have at 
least 1 megabyte of printer memory installed in order to have best performance.

Also, make sure your printer is turned on and properly connected to your computer and set to On Line 
before attempting to print.

If you encounter problems when printing, make sure the latest version of the correct printer driver is 
installed.    You can contact the printer manufacturer to see whether an updated printer driver is available.  
Manufacturers often resolve problems by issuing new printer drivers.

For best results, we recommend printing from Day-Timer Organizer to a laser or inkjet printer.    These 
printers have more flexibility in printing options and allow you to print a full range of reports and forms.

When using printers with limited feature sets (plotters, daisy wheel printers, and some dot matrix printers),
you may be able to print only list style reports, which are much simpler than other report styles.    For best 
results, select a font directly supported by your printer.

On some Canon printers, the 'paper out' sensor is lined up with the pre-punched holes in the Desk paper. 
As a result, the paper may not work well with these printers.

If you wish to print envelopes, you must verify that your envelopes are supported by using the Windows 
Control Panel to make sure that your envelope size is listed in the standard forms.



Handling Paper for Double Sided Printing
Day-Timer Organizer allows you to print on both sides of the page when using a laser or inkjet printer.    
After printing one side of the paper, you must reinsert the sheets to print on the other side.    Since the 
procedures for printing double sided paper differ between printers, you must determine how to reinsert the
paper and whether it needs to be flipped over or reversed.    To assist in this process, Day-Timer 
Organizer provides a special Paper Handling command on the File menu that helps you determine the 
correct method for double sided printing on your printer.

You must work through the Paper Handling command if you wish to print double-sided pages, in order to 
teach Day-Timer Organizer how to print double sided forms on your printer.

Note:    Some printer manuals state that double sided printing is not recommended.    We recommend that
you follow the manufacturer's instructions.



Choosing the Print Style
By default, when you open the printing dialog, it will assume that you wish to print a report of the currently 
displayed view.    You can select any type of report that you wish by clicking on the appropriate icon in the 
selection bar at the left of the printing dialog box.
Icon Prints
Daily
Weekly
Monthly

Planner pages

Address Book
Phone Book

Address and phone book pages

Labels
Envelopes
Rotary Cards

Names and addresses in a variety of layouts for 
mailing or for a rotary card file.

Schedule List
Task List
Notes List
Address List
Messages List
Timeline
Phone Log
Expenses List
Global List

Reports in list (simple table) format

This format is most useful for printers that do not 
support extensive page layout (typically NON-laser 
printers) or for users who want more control over 
which information is printed.

Choosing the Data to Print
When you begin printing, Day-Timer Organizer will assume that you wish to print the data that was 
selected on the current view screen.    You may select a different range of data, or all data.

Before issuing the printing command, you may wish to select the specific data to print.    To select a range 
of data, click on the first entry to be printed.    Then use the Scroll bars to display the final entry on the 
screen.    Then hold down the Shift key while you click on the last entry to be printed.    All of the entries 
that are selected will be highlighted and you can use the scroll bars to verify that the correct range has 
been selected.

Related Topics:
Printing Selected Entries or All Entries
Filtering the Entries to Print
Setting the Range of Dates

Searching and Repositioning



Printing Selected Entries or All Entries
You can select Which Entries are to be printed by clicking on

Selected - prints the entries that were highlighted on the view

All applicable - prints all data applicable

For example, if you are printing your address book and you have highlighted only some of the entries, by 
default only the selected entries will print.    If you click on All applicable, the entire address book will 
print.



Filtering the Entries to Print
The Search By:  button bar allows you to filter the data that will be printed.    Depending on the printout 
that has been selected, not all of the buttons will be displayed on the button bar.

Button Search Type Effect
By Assignee includes only entries assigned to selected individuals, 

groups, or resources
By Category includes only entries filed under selected categories

By Word includes only entries containing selected words (or word 
beginnings) in the note, address, or custom fields

By Priority includes only tasks within selected range of priorities

By Entry Type includes only entries of the selected type or any 
combination of types (schedule, task, address, note, 
expense, phone call, or message)

By Call Status includes only phone log entries by status (such as all calls 
you did not complete)

By Expense Type includes only expenses of any selected type

By Other Values includes entries that match selected criteria

Clear Search clears all filter settings

Note:    The filter settings are cumulative.    For example, if you
were printing an address book and you set the Category to 
Personal and then set the Keyword search to Tennis, you 
would see personal contacts with the keyword Tennis 
somewhere in that entry.    The more search commands you 
issue, the more filters are placed on your data.

To clear all filters, click on the  button.



Setting the Range of Dates

To set the start and end dates, click on the     icon next to the date field, then click on the desired 
calendar date from the resulting window.

Alternately, you can simply type a new value into the fields for the starting and ending date.    Day-Timer 
Organizer's smart date recognition accepts most typed formats, such as "tu" for Tuesday or "2w" for 2 
weeks from today.



Setting Paper Options
If you are integrating Day-Timer Organizer with a paper-based organizer system, you may choose to print
on a paper format that can be inserted into your current binder.    Day-Timers offers pre-punched, 
perforated sheets to make this process as easy as possible

To select the paper size, click on the Page Sizes pull-down menu and select from the list of paper sizes.

Note:    If you are using the preprinted, specially perforated forms from Day-Timers, the page size 
chosen should match your forms.

Note also that you cannot print onto the pre-printed, dated pages from a paper-based organizer system.

Related Topics:
Ordering Day-Timer Preprinted Forms
Purchasing Other Special Forms



Printing Double Sided Forms
To save paper in your binder, you may wish to print your output on both sides of the page.    To request 
this, click on the Double Sided Printing option just below Page Sizes on the printing dialog box.

In order to print on both sides of the paper, you must first use the Paper Handling command from the 
File menu to learn how to orient the paper and to teach Day-Timer Organizer how double sided forms on 
print to your printer.    This command prompts you to feed forms through the printer to determine exactly 
how to feed paper through your printer in order to print correctly on both sides.

Depending on your printer, you may need to turn the paper over or flip it side to side so that both sides to 
be correctly oriented in relation to each other.

Note:    For some printers, the manufacturer does not recommend double-sided printing.    Consult 
your printer manual for more information.

Related Topics:
Ordering Day-Timer Preprinted Forms
Purchasing Other Special Forms



Choosing an Alternate Font
Day-Timer Organizer printouts default to Times Roman font in order to fit all information on the page with 
the most attractive appearance.    If you prefer a different font, click on the Font button to select one.

Then select the desired font type from the resulting dialog box.    Note that not all fonts may be fully 
supported by your printer.    Specifically, to print TrueType fonts, you must use the Print...Print 
Setup...More Setup command to either print TrueType fonts as graphics or to substitute PostScript fonts 
as appropriate.



Making It Print:    Using the Button Controls
The buttons at the bottom of the printing screen allow you to control how printing is actually done.

Printer Setup
This command allows you to set printer options.    The options available depend on your printer itself.    For
more information, consult your system and printer documentation.    Note that the paper size selected 
must be set with Day-Timer Organizer, and also within the printer's setup as well.

Saving Your Printing Settings
If you have made a set of choices that you will be using frequently, you can click on the Save Settings 
button to store the current settings so that they can be used each time you print the same type of page 
from Day-Timer Organizer.

Previewing Before Printing
You may wish to review your printouts on the screen before printing them.    To do that, click on the 
Preview button.    A new window will appear that shows the first page to be printed, along with control 
buttons for viewing and printing.

Related Topics:
Printing Directly from Preview Mode
Cancelling the Printout
Returning to the Printing Options Dialog Box
Changing the View
Viewing Other Pages
Checking Page Sides for Double Sided Printing
Printing Only Some Pages



Printing Directly from Preview Mode
If the displayed images are satisfactory, you can click on the Print button to print the output directly.



Canceling the Printout
To cancel the print operation entirely, click on the Cancel button.    You will return to the current view of 
Day-Timer Organizer.



Returning to the Printing Options Dialog Box
If you wish to choose different print options, click on the Change Settings button to return to the Printing
Options dialog box.



Changing the View
The Zoom slider allows you to view the printed page larger.    Simply move the slider to a new position to 
change the page size.

Once the page is zoomed, you can use the scroll bars at the right and bottom to move around and view 
other parts of the page.



Viewing Other Pages
To view a different page, use the page positioning buttons:
Button Action
First Page displays the first page
Previous Page displays the previous page (if applicable)
Next Page displays the next page (if applicable)
Last Page displays the last page of the printout (if 

applicable)

You can move through all of the pages of the printout and view pages as many times as you wish before 
printing.



Checking Page Sides for Double Sided Printing
If you have requested double sided printing, you can click on the Back radio button to see what will 
appear on the flip side of the currently displayed page.    From the back view, clicking on Front displays 
the front side of the currently displayed page.



Printing Only Some Pages
The Sheet will be printed check box allows you to choose whether specific pages are printed or not.    If 
you do not wish to print a specific page, click on this box and de-select it.



Setting Planner Page Options
The daily, weekly and monthly planner pages can be printed in a variety of formats.    In addition to the 
standard print settings, a variety of settings can be specified for planner pages.

Related Topics:
Setting the Amount of Text to Print
Specifying the Number of Pages per Day
Setting the Panes to appear on the Printout
Setting Other Printing Options



Setting the Amount of Text to Print
Day-Timer Organizer allows you to specify how much text is to be printed, to ensure that as many events 
as possible are displayed.    The standard setting is Critical, which prints the first line (up to the first time 
the Enter key was pressed) of the description of the event.    This is typically more of an issue on weekly 
and monthly planner printing, where fewer events can be displayed.    You can use the pull-down to set 
the maximum number of lines that will be printed.

Note that if you specify that up to, for example, five lines can be printed, events with shorter descriptions 
will not use up a full five lines.    If a description is longer than five lines, the sixth and additional lines will 
simply be omitted.



Specifying the Number of Pages per Day
Day-Timer Organizer can print in one page per day or two pages per day format.    However if you are 
printing pages to insert in your paper planner to carry to off-site meetings or on trips, you may wish to use 
the two page per day format.



Setting the Panes to appear on the Printout
By default, the daily planner window displays with five panes:    scheduled events, to be done list, diary 
and work record, upcoming events and expense record.    You can choose which panes you wish to print 
by clicking on the Sections button and choosing which panes should be included or excluded.    When 
you enable the 

Use Custom Sections

check box, you can then click on the Sections button.    From the dialog box, you can move columns from

the Omit box to the Include box by clicking on the column name and clicking on the  button.    The

 button moves selected items from the Include box to the Omit box.
To change the order in which columns are displayed, drag them to the correct position in the list.
The sections will be displayed in the order that you select, starting from the top left of the page.



Setting Other Planner Printing Options
Depending on the planner view that you are printing, you will be able to set the following options:

Print Overdue Tasks - print overdue tasks as well as current ones

Exclude Assignee Names - do not print assignee names with tasks

Printed Time Increments - (daily planner only) - specify the time increments to be printed (e.g. 15 
minutes, half hours, etc.)

Banner Multi-Day Events - (monthly planner only) - multi-day events will be printed as banners across 
all of the affected days.



Setting Address and Phone Book Options
The address and phone book pages can be printed in a variety of formats, in addition to the standard print
settings.

You can use the standard search buttons to select your data before printing.    Alternately, if you click on 
All Applicable, you can specify an alphabetical range that will be used solely for this printout.    For 
example, you can select from E to J by selecting the Alphabetical check box and filling in the From and 
To boxes with E and J respectively.

Related Topics:
Defining Headers and Footers
Setting the Amount of Text to Print
Sorting the Names
Controlling Other Page Options



Setting Headers and Footers
From the print dialog box, you can customize the headers and footers that are to appear on each page of 
your address list printout.

Title - appears on the first page only

Header - appears across the top of all pages

Footer - appears across the bottom of all pages

The text that is specified with be aligned to the left, center or right, depending on the radio button that you 
select to the right of the text.    The text can include the following special codes to insert varying 
information:

# - insert the page number

[Date] - insert today's date

[Time] - insert the current time

Your header and footer settings will be saved if you use the Save Settings command and your headers 
and footers will be inserted automatically whenever you print an address list.



Setting the Amount of Text to Print
Day-Timer Organizer allows you to specify how much text is to be printed, to ensure that as much 
information as possible is displayed.    The standard setting is Critical, which prints the first line (up to the 
first time the Enter key was pressed) of the Notes/text field.    You can use the pull-down to set the 
maximum number of lines that will be printed.

Note that if you specify that up to, for example, five lines can be printed, address items with shorter 
descriptions will not use up a full five lines.    If an entry is longer than five lines, the sixth and additional 
lines will simply be omitted.



Sorting the Names
The names and addresses printed in the address and phone books can be sorted in several ways:
Order Names Sorted By
Name by last name of the contact
Organization by the company name
Zip Code by the zip code
Date Due by the follow up date that was specified

Note that you can print the address and phone book in different orders at different times.    The data is not 
changed by printing it in a different order.



Controlling Other Page Options
By default the address and phone books print as many names per page as possible.    So, for example, if 
you only have a few contacts whose last names begin with A, the names beginning with B will be 
displayed on the bottom half of the page of names beginning with A.    If you want to start a new page 
each time a new letter of the alphabet is reached, click on the Page break by letter option.    Note that 
this will not print blank pages for letters for which you have no contacts (e.g. Q, Z or X).

The Letter Headings option allows you to request that a letter be printed out for the start of the section 
for a given letter.    For example, if you select this option, a heading "H" would appear before the names 
with last name beginning with H.

By default, contacts are displayed in a normal order.    For example

John Q. Smith

If you would prefer them to be displayed with their last names first with for example,

Smith, John Q.

you can click on the

Last name first

option.

When you enable the Box option, the printout will have a box drawn around the page.    This is most 
useful when printing on plain paper, although you may prefer it on preprinted forms as well.

The Print Both Addresses option allows you to request that both work and home addresses be printed.   
If you select this option, you can then click on Work Address First or Home Address First to control 
which address appears first on the printout.    If you disable the Print Both Addresses option, then you 
must select whether you wish to print Work Address Only or Home Address Only.



Printing Mailing Labels
You can print mailing labels directly from Day-Timer Organizer using a variety of label forms from 
suppliers such as Avery.

You can set the following label parameters.

1. Label Size.    Select from the list of standard label sizes.    If your label size is not on the list, 
select Custom, then click on the Custom Label Size button and specify:

¨ Size of label (height and width, in inches)

¨ Page margins (at top and left side of sheet, in inches)

¨ Number of labels per sheet (across and down)

¨ Distance between labels (in inches)

¨ Whether the labels are For use on a Laser Printer or not

2. Label Margins.    (top, bottom, left, and right side, in inches)

3. Copies of each label. Number of duplicates of each label to print

4. First Label you want printed (position across and down on sheet); this allows you to use up old 
label sheets that have some of the labels used.

5. Sort By.    You may sort by last name, organization, zip code, or follow-up date.

6. Which Address.    Choose work or home address.

7. Print Barcodes.    Prints POSTNET barcodes for U.S. domestic mail.    This code is derived from 
the zip code in the address (either 5 or 9 digits). 

Related Topics:
Using the Quick Print Option



Using the Quick Print Option
Day-Timer Organizer includes a quick print option for printing labels.    To use the quick printing feature, 
you must save your label settings and customize the button bar to include the Quick Print button for 
Labels, as described below.

Related Topics:
Saving the Label Settings
Including the Quick Print Button on the Button Bar
Selecting the Name(s) to Print
Printing Labels



Saving the Label Settings
Once you have specified exactly how labels are to be printed, you can save the label settings by clicking 
on the Save Settings button.



Including the Quick Print Button on the Button Bar

Once you have saved your label printing preferences, you may want to include the     button on the 
button bar.    To do that, choose the Setup...User Preferences command and select the Button Bar 
option.    Click on the 

 button to highlight it so that it will be included on the standard button bar.    When you click on OK, 
the button bar will be updated.    Note that if your screen is too small or you already have too many 
buttons displayed, you may not be able to include an additional button.



Selecting the Name(s) to Print
Once you have saved your label settings and customized the button bar, you can select the name(s) to be
printed.

1. Select a single name by clicking on it.

2. Select a group of names by first clicking on the first name in the group; then hold down the Shift 
key and click on the last name in the group.

3. Select several specific names by first clicking on the first name; then hold down the Ctrl key and 
click on the second name; hold down the Ctrl key while you click on all of the other required 
names.



Printing Labels

Once the  button is displayed on the button bar and the label settings have been saved, and the 
names selected, you can print labels by simply clicking on the 

 button.



Printing Envelopes
You can print envelopes directly from Day-Timer Organizer using a variety of envelope sizes.

You can set the following envelope parameters.

1. Envelope Size.    To select envelope size, click on the down arrow next to the size field.    
Normally you will want a standard #10 (4-1/8" x 9-1/2") envelope.    These sizes are determined 
by your printer and what sizes it supports.

2. Return Address.    If you type a return address, it will be printed on your envelope and stored for 
future reference.    To omit the contents of the return address field from envelopes you are 
currently printing, click on Omit Return Address.

3. Use Envelope Feeder.    If your printer has an envelope feeder, you may select it by clicking on 
this check box.

4. Sort By.    You may sort by last name, organization, zip code, or follow-up date.

5. Which Address.    Choose work or home address.

6. Print Barcodes.    Prints POSTNET barcodes for U.S. domestic mail.    This code is derived from 
the zip code in the address (either 5 or 9 digits). 

7. Return Address.    Prints the specified return address in the top left corner of the envelope.

8. Address Position.    Allows you to specify the exact positioning (in inches) of the return address 
and the TO:    address.

Note that the envelope size may also need to be set at the print driver (printer setup) level as well.    In 
addition, since envelopes are seldom 8.5" x 11", they must often be fed through a special tray or slot in 
the printer and the Paper Source setting adjusted accordingly.

Related Topics:
Using the Quick Print Option



Using the Quick Print Option for Envelopes
Day-Timer Organizer includes a quick print option for printing envelopes.    To use the quick printing 
feature, you must save your envelope settings and customize the button bar to include the Quick Print 
button for Envelopes, as described below.

Related Topics:
Saving the Label Settings
Including the Quick Print (Envelopes) Button on the Button Bar
Selecting the Name(s) to Print
Printing Labels



Saving the Label Settings
Once you have specified exactly how envelopes are to be printed, you can save your settings by clicking 
on the Save Settings button.



Including the Quick Print (Envelopes) Button on the Button Bar

Once you have saved your printing preferences, you may want to include the     button on the 
button bar.    To do that, choose the Setup...User Preferences command and select the Button Bar 
option.    Click on the 

 button to highlight it so that it will be included on the standard button bar.    When you click on OK, 
the button bar will be updated.    Note that if your screen is too small or you already have too many 
buttons displayed, you may not be able to include an additional button.



Selecting the Name(s) to Print
Once you have saved your envelope settings and customized the button bar, you can select the name(s) 
to be printed.

1. Select a single name by clicking on it.

2. Select a group of names by first clicking on the first name in the group; then hold down the Shift 
key and click on the last name in the group.

3. Select several specific names by first clicking on the first name; then hold down the Ctrl key and 
click on the second name; hold down the Ctrl key while you click on all of the other required 
names.



Printing Labels

Once the  button is displayed on the button bar and the envelope settings have been saved, and 
the names selected, you can print by simply clicking on the 

 button.



Printing Rotary Cards
You can print rotary cards directly from Day-Timer Organizer using a variety of form sizes from various 
suppliers.

You can set the following parameters.

1. Card Size.    Select from the list of standard rotary card sizes.    If your card size is not on the list, 
select Custom, then click on the Custom Card Size button and specify:

¨ Size of card (height and width, in inches)

¨ Page margins (at top and left side of sheet, in inches)

¨ Number of cards per sheet (across and down)

¨ Distance between cards (rows and columns, in inches)

2. Whether or not cards are For use on a Laser Printer

3. Card Margins (at top, bottom, left, and right side, in inches)

4. First Card position on sheet (across and down)

5. Sort By.    You may sort by last name, organization, zip code, or follow-up date.

6. Which Address.    Choose work or home address or both.



Printing Lists
Lists are especially useful for non-laser printers that have limited page formatting capabilities.    Lists are 
also useful for specialized reports.

The printed list will have a simple columnar layout.

1. Title (optional), which will appear at the top of the first page (to insert date or time, type [Date] or 
[Time]).    The text of the title will be aligned to the left edge of the page, centered, or aligned to 
the right edge of the page, depending on whether you choose the Left, Right or Centered button
on the Title line.

2. Header (optional), which will appear at the top of every page (to insert date, time, or page 
number, type [Date], [Time] or [#]).    You can also click on the Left, Right or Center button to 
specify whether the header text should be aligned to the left or right margin of the page, or 
centered.

3. Footer (optional), which will appear at the bottom of every page (to insert date, time, or page 
number, type [Date], [Time] or [#]).    You can also click on the Left, Right or Center button to 
specify whether the footer text should be aligned to the left or right margin of the page, or 
centered.

4. Amount of Text.    Critical prints up to the first carriage return, Full prints entire text field, Full 
1/Page prints entire text field with each entry on a new page, Text Only prints the entire text field 
and nothing else.

5. Margins (top, bottom, left, and right), in inches.    This setting controls how much white space to 
leave the edges of the paper.

6. Columns let you select fields and their column order.    To move an Omitted field to the Include 
box (or vice versa), click on the field, then click on the direction button.    To change field order, 
click on the desired field and hold down the mouse button while you drag to desired position.

7. Type.    Choose unfinished or finished.    (Task List only).

8. Sort By (Notes List).    Choose position (the default), or due date (which prints only notes with 
follow-up dates). 

9. Sort By (Address List).    You may sort by last name, organization, zip code, or follow-up date.    
(Address List only).

10. Message Type.    Choose incoming, incoming history (saved messages), or outgoing (messages 
you sent)      (Message List only).

11. Call Type.    Choose incoming calls, outgoing calls, or all calls. (Messages List and Phone Log 
only).

12. Expense Type.    Choose unsubmitted, submitted, or both. (Expense List only).



Merging Addresses with Form Letters
You may mail merge Day-Timer Organizer addresses with form letters created in Day-Timer Organizer, or
form letters created in another program (e.g. your word processor).

Related Topics:
Mail Merge to WordPerfect 5.2
Mail Merge to WordPerfect 6
Mail Merge to Word for Windows 6/7
Mail Merge to Ami Pro 3

Mail Merge with a Day-Timer Organizer Note



Mail Merge with a Day-Timer Organizer Note
To create a reusable form letter in Day-Timer Organizer, add a Note entry.    Put a title such as "Form 
letter - overdue receivables" (which will not appear in letters you print) on the top line, followed by the 
body of the letter.

Click wherever name or address fields will be inserted, then click the right mouse button to bring up the 
popup menu.    Select Insert and then Insert Mail Merge Fields from the Edit menu.    Select desired 
fields, then click on OK.    When finished, click on OK to save the letter.

To merge this letter with Day-Timer Organizer addresses, click the letter in the Notes view, and select 
Mail Merge from the Tools menu.

Next, open the Address Book view and click on addresses you want:

¨ To select multiple addresses, press the Ctrl key while you click on each address

¨ To select a range of adjacent addresses, click on the first address, then press the Shift key while 
you click on the last address

¨ To select all addresses conforming to current search filters (e.g. a category), use the Select All 
option on the Edit menu.

Once addresses are selected, choose Mail Merge from the Tools menu.    Click on Day-Timer format.

Select desired font, paper size, and printed page margins.    If desired, you may print a page header and 
footer as well (to insert date, time, or page number, type [Date], [Time] or [#]).

After printing letters, addresses remain selected, allowing you to print envelopes or mailing labels if 
desired.



External Mail Merge: Word Perfect 5.2 & Day-Timer Organizer

The following are the fields that are available to you when you do a mail merge between DTO 2.1 and 
Word Perfect 5.2.

Field Names:

1. MrMrs

2. FirstName

3. Initial

4. LastName

5. Title

6. Company

7. Address1

8. Address2

9. Address3

10.    City 

11.    State

12.    Zip

13.    Country

14.    Email1

15.    Email2

16.    Email3

17.    Email4

18.    Nickname

19.    Phone1

20.    Phone2

21.    Phone3

22.    Phone4

23.    Phone5

24.    Phone6

1.    Using Word Perfect 5.2, create a form letter containing merge field names (listed above). Follow the 
mail merge instructions in your word processor manual. When finished, exit your word processor and 
save the form letter.



Please contact Word Perfect for any technical assistance regarding their word processing package.

Word Perfect 5.2 Mail Merge instructions: 

a.    Place the cursor within the document where you want the field to be inserted.

b.    Tools Menu

c.    Merge

d.    Field

e.    Enter the # corresponding the field you wish to place there. Use the Field Name list from above with 
the 24 fields.

    Example: You want the Company name, use #6.

f.    Be sure to SAVE the document and CLOSE your word processor when you complete the document.

2.    In Day-Timer Organizer, open the Address Book view and click on the addresses you want.

 ** To select multiple addresses, press the Ctrl Key while you click on each address.

 ** To select a range of adjacent addresses, click on the first address, then press the Shift key while you 
click on the last address.

 ** To select all addresses conforming to current search filters, use the Select All command on the Edit 
menu.

 ** To select all addresses filed under a category, use Category Search.

 

 

3.    Once addresses are selected, choose Mail Merge from the Tools menu. Click on Word Processor 
print style, then click on the pull down menu and choose Word Perfect 5.2. Make sure the word processor
directory PATH is correct, but do not change the Options or Macro lines.

 

4.    Day-Timer Organizer will start your word processor. When prompted by Word Perfect 5.2, specify the 
document you created in Step 1. All you have to do is Preview and Print when the macro is complete.



External Mail Merge: MS Word 6.0/7.0 & Day-Timer Organizer

The following are the fields that are available to you when you do a mail merge between DTO 2.1 and MS
Word 6.0/7.0.

Field Names:

MrMrs

FirstName

Initial

LastName

Title

Company

Address1

Address2

Address3

City

State

Zip

Country

Email1

Email2

Email3

Email4

Nickname

Phone1

Phone2

Phone3

Phone4

Phone5

Phone6

1.    Using MS Word 6.0/7.0, create a form letter containing merge field names (listed above). Follow the 
mail merge instructions in your word processor manual. When finished, exit your word processor and 
save the form letter.



Please contact Microsoft for any technical assistance regarding their word processing package.

MS Word 6.0/7.0 Mail Merge instructions: 

a.    Place the cursor within the document where you want the field to be inserted.

b.    Insert Menu

c.    Field

d.    Categories: Mail Merge

e.    Field Names: MergeField 

f.    Field Codes: MergeField FieldName      (Where FieldName corresponds to a name from the list above.)

                  Example:      MergeField    LastName

g.    Click on OK.

h.    Repeat steps a to g for each field you want located within the document.

i.    Be sure to SAVE the document and CLOSE your word processor when you complete the document.

2.    In Day-Timer Organizer, open the Address Book view and click on the addresses you want.

 ** To select multiple addresses, press the Ctrl Key while you click on each address.

 ** To select a range of adjacent addresses, click on the first address, then press the Shift key while you 
click on the last address.

 ** To select all addresses conforming to current search filters, use the Select All command on the Edit 
menu.

 ** To select all address filed under a category, use Category Search.

 

 

3.    Once addresses are selected, choose Mail Merge from the Tools menu. Click on Word Processor 
print style, then click on the pull down menu and choose MS Word 6.0 or 7.0. Make sure the word 
processor directory PATH is correct, but do not change the Options or Macro lines.

 

4.    Day-Timer Organizer will start your word processor. When prompted by MS Word 6.0/7.0, specify the 
document you created in Step 1.

 

5.      All you have to do is Preview and Print when the macro is complete.



External Mail Merge: Word Perfect 6.0/6.0a/6.1 & Day-Timer Organizer 

The following are the fields that are available to you when you do a mail merge between DTO 2.1 and 
Word Perfect 6.0/6.0a/6.1.

Field Names:

1. MrMrs

2. FirstName

3. Initial

4. LastName

5. Title

6. Company

7. Address1

8. Address2

9. Address3

10.    City 

11.    State

12.    Zip

13.    Country

14.    Email1

15.    Email2

16.    Email3

17.    Email4

18.    Nickname

19.    Phone1

20.    Phone2

21.    Phone3

22.    Phone4

23.    Phone5

24.    Phone6

1.    Using Word Perfect 6.0/6.0a/6.1, create a form letter containing merge field names (listed above). 
Follow the mail merge instructions in your word processor manual. When finished, exit your word 
processor and save the form letter.



Please contact Word Perfect for any technical assistance regarding their word processing package.

Word Perfect 6.0/6.0a/6.1Mail Merge instructions: 

a.    Place the cursor within the document where you want the field to be inserted.

b.    Tools Menu

c.    Merge ...

d.    Form ...

e.    Click on None

f.    Click on OK

g.    Insert Field ...

h.    You will get the following message: No field names or records were found.

i.    Click on OK

j.    Place the cursor in the document where you want the field to be placed.

k.    Prompted for a Field: 

 Use the numbers associated with the fields listed above. Example, if you want company name, use #6.

k.    Click on Insert.

l.    Repeat steps j to k for each field.

m.    Click on Close when you are done with the Fields.

n.    Repeat steps g to k if you need to enter more fields into the document. 

o.    Be sure to SAVE the document and CLOSE your word processor when you complete the document.

2.    In Day-Timer Organizer, open the Address Book view and click on the addresses you want.

 ** To select multiple addresses, press the Ctrl Key while you click on each address.

 ** To select a range of adjacent addresses, click on the first address, then press the Shift key while you 
click on the last address.

 ** To select all addresses conforming to current search filters, use the Select All command on the Edit 
menu.

 ** To select all address filed under a category, use Category Search.

 

 

3.    Once addresses are selected, choose Mail Merge from the Tools menu. Click on Word Processor 
print style, then click on the pull down menu and choose Word Perfect 6.0/6.0a/6.1. Make sure the word 
processor directory PATH is correct, but do not change the Options or Macro lines.

 

4.    Day-Timer Organizer will start your word processor. When prompted by Word Perfect 6.0/6.0a/6.1, 
specify the document you created in Step 1. All you have to do is Preview and Print when the macro is 



complete.



External Mail Merge: Ami Pro 3.0 & Day-Timer Organizer

The following are the fields that are available to you when you do a mail merge between DTO 2.1 and Ami
Pro 3.0.

Field Names:

MrMrs

FirstName

Initial

LastName

Title

Company

Address1

Address2

Address3

City

State

Zip

Country

Email1

Email2

Email3

Email4

Nickname

Phone1

Phone2

Phone3

Phone4

Phone5

Phone6

Header File:            dtoaphd.sam                      (Located in the DTO 2.1 directory.)

1.    Using Ami Pro 3.0, create a form letter containing merge field names (listed above). Follow the mail 



merge instructions in your word processor manual. When finished, exit your word processor and save the 
form letter.

Please contact AmiPro for any technical assistance regarding their word processing package.

Ami Pro 3.0 Mail Merge instructions: 

a.    File

b.    Merge

c.    Create or edit a merge document

d.    Click on OK

e.    Do you want to use current document as the merge document? Yes or No. (If you select No, you will 
be prompted to open an existing document.) Select Yes if you were typing in the letter into the current 
document.

f.    Change the directory to where Day-Timer Organizer is installed.

g.    List files of type = Comma Delimited

h.    Select dtoaphd.sam

i.    Click on OK

j.    Field names list in

k.    Description File = 

Change directory to where DTO is installed.

Select dtoaphd.sam 

l.    Click on OK

m.    Now place the cursor within your document where you want the field to be placed.

n.    Select the field under Field Names

o.    Click on Insert

p.    Repeat steps m to o for each field you want within your document.

q.    Click on Close when you are done with the Field Names. To bring them back, repeat steps a to e.

r.    Be sure to SAVE the document and Close the word processor when done.

2.    In Day-Timer Organizer, open the Address Book view and click on the addresses you want.

 ** To select multiple addresses, press the Ctrl Key while you click on each address.

 ** To select a range of adjacent addresses, click on the first address, then press the Shift key while you 
click on the last address.

 ** To select all addresses conforming to current search filters, use the Select All command on the Edit 
menu.



 ** To select all address filed under a category, use Category Search.

 

 

3.    Once addresses are selected, choose Mail Merge from the Tools menu. Click on Word Processor 
print style, then click on the pull down menu and choose Ami Pro 3.0. Make sure the word processor 
directory PATH is correct, but do not change the Options or Macro lines.

 

4.    Day-Timer Organizer will start your word processor. When prompted by Ami Pro 3.0, specify the 
document you created in Step 1. All you have to do is Preview and Print when the macro is complete.



How Data is Stored and Exchanged
Day-Timer Organizer stores your data in a collection of files called a database.    These files contain all of 
the entries that you have created, linkages between data, and information that is created by Day-Timer 
Organizer to help manage, search through, and view your data.

When you create an entry, it remains in the database until you delete it.

While individual entries take up very little space, periodically (e.g. quarterly, semi-annually, or annually), 
you may want to archive and remove old data from the database to free space for new entries.    
Removing data also speeds searches since less data must be reviewed in searching.

The database is a set of several files.    You must be very careful when working with database files 
because damage to one file may make the entire database invalid.



Exchanging Data with Other External Systems
Day-Timer Organizer can import data from other systems.    The most common use for this facility is 
importing contact information from other organizer software programs or corporate databases.

Just as you may wish to import data from other systems, after entering large amounts of data in Day-
Timer Organizer, you may want to use that data in other systems.    The most common use for this facility 
is exporting names and addresses for use as mailing lists.

The means for data exchange with other systems is via specially formatted text files.    While there are no 
universal standards for data exchange, in PC-based systems, files are commonly converted to plain text 
for transfer to other systems.    These files are coded in ASCII character codes and hence are called 
ASCII text files.

Note that holidays are stored as part of the structure of the database itself.    If you have defined your own 
holidays, these will not be exported or imported.

Related Topics:
Creating an Export File
Importing Data Files
Reconciling Changes at Import Time
ASCII Import Options

Importing Data from Other Electronic Systems:
ACT! 1.0 and 2.0
Sidekick 1.0
Sidekick 2.0
ECCO Simplicity 1.1
Lotus Organizer 1.1
Lotus Organizer 2.0
Lotus Organizer 2.1



Creating an Export File
To copy entries from the current database (the one you are in right now) to an export file, select Export 
Entries from the File menu.    Click on desired Export File Type:

¨ Select Day-Timer/Win to format export data for another Day-Timer Organizer database (e.g. from
a multi-user, network database to a single user database on a portable computer).    You can also 
exchange data between Day-Timer Organizer databases with the File...Synchronize command 
as described in Coordinating Data Between a Portable Computer and the Central Database.

¨ Select ASCII to format export data for a program such as a spreadsheet or database which can 
import delimited ASCII data (for ASCII field formats, see Appendix B).

¨ Select IntelliLink if you have IntelliLink™ translator software for exchanging data between Day-
Timer Organizer and palmtop organizers 
HP IIP 95LX/100LX/200LX
Sharp Wizard YO600, OZ5500, OZ5600, OZ6500, OZ7000, OZ8000, OZ9000; Zaurus ZR5000
Casio 4000, 5000, 7000, 9000 series, SF-R10, SF-R20
US Robotics Pilot 1000 and 5000

or other programs (ACT!, Calendar Creator Plus, Commence, Current, dBase, Ecco, Excel, Lotus
123, Lotus Organizer, Packrat, Paradox, PC Tools, Schedule+, Sidekick, Microsoft Word, 
WordPerfect, or Word-Perfect Office).    For purchase information, contact IntelliLink Corp, One 
Tara Blvd, Suite 210, Nashua, NH 03062 (603) 888-0666.

¨ Select Archive to export (in Day-Timer Organizer format) and/or remove information that is no 
longer needed on a day-to-day basis (you can export and delete entries, export entries without 
deleting them, or delete entries without exporting them).

Related Topics:
Pre-Selecting Entries to Export
Date Filtering at Export Time
Export Search Options
Exporting Categories and Assignees
Export File Name
ASCII Export Options



Pre-Selecting Entries to Export
If you pre-select entries in the active view Before clicking on Export, the Which Entries selection in the 
export dialog box will default to the selected entries.    To pre-select entries, follow instructions below:

¨ To select a single entry, click on that entry.

¨ To select Multiple Entries, press the Ctrl key while you Click on each desired entry

¨ To select a Range of adjacent entries, click on the first entry, use the mouse and the scroll bar to 
move down the list, then hold down the Shift key while you click on the last entry

Any Search settings in the active view will be transferred to the export dialog box (where you may use, 
clear, or replace them).



Date Filtering at Export Time
You may filter the entries you export by any of the options below:

¨ Selected - exports entries you selected in the active view (see previous)

¨ All in Search - exports all entries conforming to search settings (or, if no search settings active, 
to default search) in the active view

¨ All - exports all entries in database (or, in the network version, all entries you have rights to view) 

¨ Modified Since - exports all entries added or changed since the date you specify (this makes it 
easy for a portable computer user to update the office database after a trip).

¨ Dated Before - use this option when exporting older data for archival purposes. 



Export Search Options
Search options in the export dialog box let you narrow the export focus (if there were search settings in 
effect in the active view, they will be automatically transferred to the export dialog box).    Search options 
are described in Searching.



Exporting Categories and Assignees
By default, Day-Timer Organizer exports only categories and assignees directly associated with the 
entries you export.    To include all categories and assignees in the export file (e.g. to synchronize 
category and assignee lists in two databases), select All categories and assignees in database.



Export File Name
Type the drive, directory path, and name of the file to which entries will be exported.    For example, to 
export a file to the floppy disk, enter the file name as

A:\MYFILE.EXP

To create an ASCII file on the C: hard drive, enter the file name as

C:\MYFILE.ASC

Note that you must specify the full name (including the drive letter and the extension of .ASC for ASCII 
files and .EXP for export files).



ASCII Export Options
If you choose ASCII export, Day-Timer Organizer will export entries to an ASCII text file, enclosing each 
field in Quotes, and using a Comma as the delimiter character between fields.

You may control field selection and field order for each entry type.    To Omit an included field, click on the 
field in the Include box, then click on the  button.    To Include an omitted field, click on the field in 
the Omit box, then click on the 

 button.    To change Field Order in the Include box, click on any field you want to move, then hold 
down the mouse button and Drag it up or down to the desired position.
First, you will need to determine exactly which entries you want to export out of Day-Timer Organizer.    
You can either highlight specific entries, or conduct a search.    Once the entries you wish to be exported 
have been selected;

Step 1: Go to the File menu, and choose "Export entries..."

Step 2: Under the "Export Type" now choose ASCII.

If you have selected or searched for entries, you can skip directly to setting the field order for the export 
file. Otherwise, you can search for entries.

Searching For Entries

To search out exactly which entries you want to export, use the Search buttons provided on the export 
screen.    They will allow you to set the criteria for selecting entries.    You can also click on the Modified 
Since option and enter a date.    This will only export the entries that have been modified since that date.    
Another option is to click on Dated Before and enter a date.    This will only export the entries entered 
before that particular date.

Choosing the Field Order

To select the order of the fields that will be in you export file;

Step 1: Fill in the "Field Ordering for _________" Choose which ever entry type - addresses, tasks, 
schedule, etc. you want to export.

Step 2: Now pick the order in which you want the fields exported.    This order is very important, for this is 
the order in which your data will get imported in your target program.    Begin by moving field names from 
the Omit box to the Include (in order) box.    Double click on the field name in the Omit box to move the 
field name to the Include box on the right.

Step 3: Continue to include all of the field names you wish to have in your export file.

Step 4: To change the order of the field names, click and hold down on the field name and drag it up or 
down to the desired location.    Make sure that you put the tip of the arrow of your mouse pointer exactly 
on top of the field name right below your desired spot.

Step 5: Export To: should be the path and file name to the directory or floppy drive that you want the file to
be exported to.    For example, you can name it Export.asc.    For an ASCII file, it should have an 
extension of ".ASC".



Step 6: Choose OK, and the export will begin

Now you can follow the import instructions for Day-Timer Organizer, and be able to understand the field 
order that you need to import your data correctly into Day-Timer Organizer.

Note:    Not every record (ie. address) has all the information for a particular field.    You may have some 
records (i.e. contacts or people) where there is no Company name.    The record should appear as 
follows:

(First Name)(Last Name) (Company Name) (Title) (Address) (City)    (State) (Zip)

"John","Smith","","Supervisor","2855 Campus Dr.","San Mateo","CA","94403"

Notice that the Company Name is not there, however there is a place holder of "".    This place holder tells
Day-Timer Organizer when it is reading the file, that the Company Name field is blank for that particular 
record, therefore go on to the next field and leave the Company Name field blank.    If you know that other 
records in your file do have company name information, then you MUST still assign Company Name as a 
field name for that blank when importing into Day-Timer Organizer. Otherwise, those company names will
NOT import into Day-Timer Organizer and you will get an error message.



Importing Data Files
To import entries into the Current database (the one you are in) from an export file, select Import Entries
from the File menu, and click on desired Export File Type.

¨ Select Day-Timer/Win when importing data from another Day-Timer Organizer database (e.g. 
from a network database to a single user database on a portable computer).

¨ Select ASCII when importing data from a program such as a spreadsheet or database which can 
export delimited ASCII data (for required ASCII field formats, see ASCII File Formats).

¨ Select IntelliLink if you have IntelliLink™ translator software and wish to import data from 
palmtop organizers (HP 95LX/100LX, Sharp Wizard, Casio BOSS, Psion) or other programs 
(ACT!, Calendar Creator Plus, Commence, Current, dBase, Ecco, Excel, Lotus 123, Lotus 
Organizer, Packrat, Paradox, PC Tools, Schedule+, Sidekick 2.0, Microsoft Word, WordPerfect, or
WordPerfect Office).    For support or purchase information, contact IntelliLink Corp, One Tara 
Blvd, Suite 210, Nashua, NH 03062 (603) 888-0666.

¨ Select Archive when importing data from a Day-Timer Organizer archive file.



Reconciling Changes at Import Time
When you export entries in Day-Timer Organizer format, the export time is stored for future reference.    
When you import entries in Day-Timer Organizer format, Day-Timer Organizer checks incoming entries to
see whether they already exist in the receiving database.    If so, the two copies are reconciled according 
to the following rules:

¨ If neither the incoming nor the existing copy has changed since you last exported, the incoming 
copy will be discarded.

¨ If the existing copy has changed but the incoming copy has not, the incoming copy will be 
discarded.

¨ If the incoming copy has changed but the existing copy has not, the incoming copy will replace 
the existing copy.

¨ If both copies have changed since you last exported, Day-Timer Organizer will display both 
copies together, listing fields where they differ.    You may keep the incoming copy, the existing 
copy, or both.



ASCII Import Options
If you choose ASCII import, Day-Timer Organizer will import entries from an ASCII file.

You may control field selection and field order for each entry type.    To do this, drag field names to the 
matching data.    You can view additional records by clicking on the Next >> button to verify that you have 
mapped the fields correctly.

By default, when importing an ASCII file, Day-Timer Organizer searches for files that end in .ASC in your 
directory.    If possible, we recommend that you name your ASCII files with a .ASC extension.

Opening an ASCII Export file

Step 1: Does the software package you are exporting from support a quote delimited, comma separated 
ASCII format, comma separated or a tab separated format?    This software package MUST export the 
field names so they look like one of the examples below.

Examples:

"Smith","John","12 Maple Lane","Hometown", "USA", "12345","123-555-1212"

Smith, John, 12 Maple Lane, Hometown, USA,12345,123-555-1212

Smith John 12 Maple Lane Hometown USA 12345 123-555-1212

[The first example is of Comma + quote delimited. The second example is Comma delimited. The third 
example is TAB delimited.]

How to determine if your export file is in a quote delimited, comma separated ASCII format:

* You will first need to look at the contents of the file. To do this:

1. Go into the Windows File manager or Windows Explorer.

2. Search for the export file that you created.

3. Once you have located the file, you may double click on it, and it should open up as a text 
document.

4. View the text, if it looks similar to the one of the examples above, then you have the right format 
and you can continue on with the import process.

Note: If you are still    not sure if the program you are exporting from supports one of these formats, you 
should contact the technical support staff for that program.

Choosing the Field Order

Step 1: What is the field ordering of the export file you created? When you import this file into Day-Timer 



Organizer, we need to know what order the fields are in.    (Please refer to the ASCII attachment for 
instructions on how to determine the field ordering for your export file)

IMPORTANT: You MUST write the field order down on a piece of paper so that you may use it later when 
you begin your import process into Day-Timer Organizer.

Also remember that if your export file contains address information as well as schedules, tasks or other 
information, you will need to know the field ordering for EACH entry type. For simplicity sake, we 
recommend you do each entry type into their own file. One file for addresses, one for schedules and one 
for tasks. 

Importing Data Into Day-Timer Organizer

Note: If you are using a word processing or spreadsheet program to alter the file it must be saved in a 
text-only format.    Consult that programs documentation if you are not sure how to save a file in text-only 
format.

Step 1: Start Day-Timer Organizer.

Step 2: From any view, choose from the File menu, select Import entries...

Step 3: Select the ASCII... option from the Import Types box.

Step 4: From the "Finding ASCII Import File" Dialogue box, navigate to the directory where the export file 
is located. Highlight the name of the export file you created from the other application, and click OK.

Step 5: A Delimiter Type dialog box will appear asking you to confirm the delimiter of the file you have 
selected. Compare your file to the examples above and select one of the following: Comma + quotes, 
Comma or TAB.

Step 6: From the "Importing from ASCII" screen, verify that the Entry Types field displays the correct type 
of entries that you are trying to import.

Note: If you separated each entry type (Addresses, To-dos, Schedule items, etc.) into separate export 
files then select the entry type that matches each export file (i.e. select Addresses as an entry type when 
importing the Address only file).    If you are importing a file with multiple entry types in one file, be sure to 
change the Type to Import = Mixed. If you do import a Mixed file, remember you will need to specify the 
field ordering for each type of entry. If the file contains schedules, tasks and addresses, then you need to 
specify field orders for all three. 



Step 7: The first record of your ASCII export file will be displayed under: Field values for one record in 
your import file. This will help you to determine the field ordering. Now look at the piece of paper that you 
used to write down the field order for the export file.

Step 8: Begin now by mapping field names to the incoming fields.    Look under the Unmapped fields 
scroll box for the name of the field that would match the field value at the top of the first record in your 
export file. 

For example, if the first field in your export file shows "Mr." , then you will want to go to the Unmapped 
fields side, and click and hold down on the Mr/Mrs field name and drag that over to the right on top of the 
field name "Mr.".    Make sure that you put the tip of the arrow of your mouse pointer exactly on top of the 
field, not the box with the Plus symbol in it.    You will notice now that the Mr/Mrs field type is off to the left 
of that first field in your record. 

(Note: the fields are not highlighted as you drag them. But the icon does change to a + when you get to 
the Mapped Fields column.) Continue to drag and drop until you have mapped all of the fields.    For those
spots that say empty, you need to determine by looking at your piece of paper exactly what field that is 
supposed to be.    In most cases people don't have a Mr. or Mrs. salutation, so they leave it blank.    You 
still have to map each incoming field, or you will get errors when attempting to import. Make sure you 
have the fields in the proper order as listed on your piece of paper.

Once the fields are in the Mapped Fields column, you can move them up or down if you accidentally 
dropped them into the wrong location.

Step 9. If the software program you exported from puts the field names into the export file as the first 
record, click on Skip First. Otherwise Day-Timer Organizer will import those field names as a record in 
your database.

Step 10: Now choose the Import button, and the file will begin to import.



ASCII File Formats
Day-Timer Organizer imports from (and exports to) comma-delimited ASCII files.    Fields must be 
contained within quotes, and separated by commas (e.g. "09/27/93","14:30").

ASCII - What is an ASCII File?

ASCII is the acronym for the AMERICAN STANDARD CODE for INFORMATION INTERCHANGE.    ASCII
characters are the most recognized and understood characters by other computers and software 
programs.    Different software programs use different methods of generating these files.    The one that we
support, more commonly used today, is CSV, or Comma Separated Value.

TERMINOLOGY YOU SHOULD UNDERSTAND

What is a record?:  A record is the entire collection of data for one person, company or entry in your 
address book.    i.e.:    First Name, Last Name, Company, Address, City, State.....etc.

What is a field?:    A field is just one piece of a record...i.e.: First Name or Last Name as shown in the 
example below.    These fields when exported to ASCII, in most cases need to be separated in a way that 
other programs can understand.

Example of a record in a CSV file:

(First Name) (Last Name)    (Company Name) (Title) (Address) (City)    (State) (Zip)

"John", "Smith", "Day-Timer Technologies, Inc", "Supervisor", "2855 Campus Dr.", "San Mateo", "CA", 
"94403"

Note that lines in the example above may be wrapped so that they display on two lines if your 
screen is not wide enough to display a single line. 

The " " (quote) represents the starting and end point for the fields named First Name, Last Name, and 
Company Name fields.    The comma is used to separate each field which tells the program reading the 
file, that the previous field has reached it's end point and no more information needs to be read for that 
particular field.

Field Order - What is field order?:    Field order is the logical order that your fields are put in (from left to 
right) when your ASCII file is generated.    Remember, the field order generated can vary from program to 
program.

Example:

(First Name) (Last Name)    (Company Name) (Title) (Address) (City)    (State) (Zip)

"John", "Smith", "Day-Timer Technologies, Inc", "Supervisor", "2855 Campus Dr.", "San Mateo", "CA", 
"94403"

The field order for this particular example is:

(1)First Name



(2)Last Name

(3)Company Name

(4)Title

(5)Address

(6)City

(7)State

(8)Zip

HOW TO DETERMINE FIELD ORDER

If you are looking at your ASCII file, and need to determine the field order of your file, this is how it is 
done.    Always read from left to right.    Some programs export their field order automatically and other do 
not, here is how to tell:

Option 1: If the program exported the field order automatically, you would see that field order is the first 
record of your export file.    Here is an example of what is would look like (remember, this varies from 
program to program):

"Organization","Last Name","First Name","Title","Work Address1","Work Address2","Work City"

"Day-Timer Technologies","Smith","John","President","2855 Campus Dr.","Suite 300","San Mateo",

The first line is your field order and the second line is your first data record:

Write this first line down on a piece of paper, like this:

(1)Organization

(2)Last Name

(3)First Name

(4)Title

(5)Work Address1

(6)Work Address2

(7)Work City

Option 2: Some programs do not export the field order, so your ASCII file will look similar to this:

"Day-Timer Technologies", "Smith", "John", "President", "2855 Campus Dr.", "Ste 300", "San Mateo"

Here you will have to determine on your own what the field order is by looking at your data.    For this 
example you would guess :

"Day-Timer Technologies" is the field name:            Organization or Company



"Smith" is the field name:              Last Name

"John" is the field name : First Name 

and so on.

If this scenario applies to you, make sure to write down on a piece of paper your field order for your export
file. When you write the field names down, number them like this:

(1)Organization

(2)Last Name

(3)First Name

(4)Title

(5)    Work Address1

(6)Work Address2

(7)    Work City

NOW YOU ARE READY TO WORK WITH ASCII FILES and Day-Timer Organizer.

When importing and exporting from Day-Timer Organizer, the following additional points should be noted.

¨ Time is formatted HH:MM format (e.g. "14:30").

¨ Date is formatted either MM/DD/YY or DD/MM/YY, depending upon the date format setting as 
specified by Windows.

¨ Advance Notice is formatted in days (e.g. "010d"), weeks (e.g. "002w"), or months (e.g. "003m").

¨ Amount and Mileage Rate are formatted $DD.cc (e.g. "$213.45").

¨ Mileage is formatted as integers (no decimal point)

¨ Expense Submitted is formatted as "Y" (if yes) or "N" (if no).

¨ Call Type is formatted as "O" (if outgoing) or "I" (if incoming).

When exporting, any Recurring Date is converted to its next occurrence.

Required ASCII import fields for each entry type are shown below.    If entries of more than one type (e.g. 
addresses and tasks) are included in the same import file, you must also preface each entry with an entry 
type field ("Schedule", "Task", "Note", "Address", "Expense", "Phone Call", or "Message").

Schedule: Date, Text

Task: Text

Note: Text

Address: Last Name (or Organization)

Expense: Date, Type, Amount, Mileage, Rate, Text

Phonecall: Name, Date, Time

Message: Date, Sender, Addressee, Subject



The sample ASCII file shown below contains several types of entries, a task, note and address.    Note 
that some of the fields are missing and therefore a null field ("") is inserted.
"Task","08/02/95","","000d","","No","0M","","","This is a task.","DAN","None"
"Note","","","000d","This is a note.","DAN","None"
"Address","","","000d","Last","First","Mr.","Title","Company","Add1","Add2","Add3",
"City","State","ZIP","Country","(415) 555-1212","","","","","","This is an address.
","DAN","None"



Exchanging Data Through the Clipboard
Your computer system has a clipboard¾a temporary storage area where you can place information for 
later retrieval.    A common method for exchanging small amounts of unformatted information between 
Windows applications (or between different components of a Windows application) is to select the desired
data and copy it to the clipboard.    Then at the destination, you can retrieve it from the clipboard and 
paste it at the current location.

Note that the clipboard can only contain one thing at a time.    Each subsequent copy to the clipboard 
overwrites the previous contents of the clipboard.

Related Topics:
Importing from Another Application
Exporting to Another Application
Exchanging Text Within   Day-Timer Organizer  



Importing from Another Application
To transfer text into Day-Timer Organizer from a Windows word processor (or other Windows program) 
via the Windows clipboard, proceed as follows:

1. In your word processor, click and while holding the left mouse button down, drag to highlight the 
desired text.

2. Select Copy option on your word processor's Edit menu.

3. Switch to Day-Timer Organizer.

4. Double click on the desired entry (or add a new one).

5. Position cursor where you want the text, then click on the right mouse button and select the Paste
command.



Exporting to Another Application
To transfer text out of Day-Timer Organizer into a Windows word processor (or other Windows program) 
via the Windows clipboard, proceed as follows:

1. In Day-Timer Organizer, double click on the entry which contains the text you want.

2. Click and drag to mark the desired text.

3. Click on the right mouse button and select Copy option.

4. Switch to your word processor.

5. Position cursor where you want the text, then select the Paste option on your word processor's 
Edit menu.

To transfer an entry (such as an address) from Day-Timer Organizer to the Windows clipboard, position 
the cursor over the entry, click on the right mouse button, and select Copy option.    Alternatively, click on 

the entry, then click on the  button.    You may then Paste the Windows clipboard contents into any 
other program that allows this.



Exchanging Text Within Day-Timer Organizer
Any information which can be transferred to other programs (see previous section) can also be 
transferred between Day-Timer Organizer entries.    Simply Copy desired information to the Windows 
clipboard, and Paste clipboard contents into the any Day-Timer Organizer field.



Converting Data from other Day-Timer Databases
Day-Timer Organizer will translate data from 

· Day-Timer Organizer version 1.0

· Day-Timer Address and Phone Directory format

· Day-Timer Address Book

This process will not alter the database which is being translated. 

If translating from Day-Timer Address and Phone Directory, before translating, make sure the program is 
not running (or resident in memory).    Also, make sure there is plenty of free disk space for your new 
database.    If you are translating a large network database, use the fastest computer available.    When 
ready, select the Translate option from the File menu, then click on the type of database you wish to 
translate from the secondary menu.

Next, select the database you wish to convert.    Click on the List Files of Type pulldown menu (located in
the lower left corner of the dialog box) and select the Version of your prior product.    Then click on the 
database you want converted.

¨ If the database is on a different disk drive, click on the Drive pulldown menu and select the 
correct disk drive.

¨ If the database is on a different directory, double click on the top item in the Directories box, then
double click on the desired directory and subdirectory, then click on desired database.

Translation time depends on the size of the prior database and the speed of your computer.    Large 
databases may take several hours to translate on slow machines.

After translating, select the Open Database option from the File menu to switch to your new database. 



Connecting to External E-mail
If you have a recent version of cc:Mail™ or Microsoft Mail™ which supports either VIM (vendor 
independent messaging) or MAPI (messaging application protocol interface) protocols, Day-Timer 
Organizer can send external e-mail messages.

For instructions on installing these products and making them available for third party applications such 
as Day-Timer Organizer, consult your e-mail product documentation or contact your e-mail supplier.

Once this foundation is in place, you may send an e-mail message from Day-Timer Organizer as follows:

1. Select Entry.    If you select an Address Book entry, Day-Timer Organizer will use the e-mail 
field in your address book entry as the e-mail address.    Note: if you select an address book entry
that does not contain a valid e-mail address, external e-mail will not work.    If you select a 
Schedule, Task, Note, or Message entry, Day-Timer Organizer will paste entry text into the 
message, letting you select an addressee in your third party e-mail application.    This is 
convenient for notifying non-Day-Timer Organizer users about meetings, tasks, etc.

2. Choose Send External Mail from the Tools menu.    Depending on your e-mail product, you may 
be asked for a log in name and password.

3. Type Message.    The dialog box will vary depending on the e-mail application you have.    Click 
on OK to send your message.



Coordinating Data Between a Portable Computer and 
the Central Database
If you are a licensed user of Day-Timer Organizer for Workgroups and you have a portable computer, you
can keep a copy of Day-Timer Organizer on the portable machine.    You can then make schedule entries, 
record addresses, maintain expense entries, etc. from the portable unit.

From time to time, you might then synchronize the database on the hard drive of your portable unit with 
the centralized database on the network.    When you synchronize the databases, Day-Timer Organizer 
automatically transfers your new entries to the centralized database and updates the local database with 
any changes from the centralized database.

For example, while travelling with your portable, you might create new schedule entries, record contact 
information (e.g. addresses, phone numbers, etc.), enter a variety of expense records, create several 
notes, etc.    You could even assign work to other network users.    Then when you return to your office, 
you would synchronize the database on your portable computer with the centralized system.    

When you synchronize your portable computer with the central database, all of your entries are 
transferred to the central system, where they can be viewed by other users as you have allowed.    Of 
course, your entries are still private, in the usual manner, unless you explicitly allow someone else to 
access them.    If some of the addresses in the shared    central files have been updated while you were 
away, those updates will be transferred to your portable computer's hard drive to keep that system up to 
date.

Related Topics:
Setting Up The Portable Computer
Synchronizing the Portable Computer with the Central Database
Resolving Conflicts Manually
Using the Portable Computer as a Workstation

Accessing a Multi-User Database from a Single Copy of Day-Timer Organizer



Setting Up The Portable Computer
To set up the portable computer, you must

· install the Day-Timer Organizer program files onto the portable computer's hard disk

· create a new database on the portable computer's hard disk

· transfer data from the centralized database to the database on the portable computer

Related Topics:
Installing the Programs
Creating a Database on the Portable Computer's Hard Disk
Initializing the Portable Computer's Database



Installing the Program
If you have already been using the portable computer as a network workstation running Day-Timer 
Organizer, you will already have the programs installed and you can skip this step.

If you are going to synchronize a portable computer with your centralized Day-Timer Organizer files, the 
portable computer must be able to connect to the network to access the data files.    To set up the portable
computer, first connect to the network and install the Day-Timer Organizer programs in the usual manner 
for workstations.    Workstation installation is described in the Day-Timer Organizer Workgroup Guide.



Creating a Database on the Portable Computer's Hard Disk
Once you have installed the programs, you must create a new database that will be stored on the hard 
disk of the portable computer.    Creating new databases is described in Working with Databases.    Be 
sure to click on the Multi-user database check box when creating the new database if you wish to retain 
the user names of other users on the network.

The default name for the central database is Office and you should choose a different name for your 
database.    

Once you create your database, the new database becomes active and the database name should 
be displayed on the status bar.



Initializing the Portable Computer's Database
When the database is initially created, it is empty.    You must synchronize it with the central database to 
load all of the central data onto your local hard drive.    Note that only data that is visible to you will be 
copied to the local data files.    Private data that belongs to other users (e.g. expense records or notes) will
not be transferred.    

To transfer data from the central database to your portable computer's database files, choose the 
File...Synchronize command.    

You will be prompted to specify the database name and disk drive where the centralized database is 
located.    Once you have specified the central database, Day-Timer Organizer will scan the local 
database and the central database and update the data.    

Once you have initialized the local database in this manner, you can end your applications and disconnect
from the network.    You now have a complete Day-Timer Organizer program with up to date database 
files that you can use anywhere.



Synchronizing the Portable Computer with the Central Database
Once you have made entries on your portable computer, you may want to synchronize your database with
the central database files so that you can access the data from your desktop workstation or so that other 
network users can access the data.

To synchronize the currently open database with the central database, choose the File...Synchronize 
command.    

The first time that you synchronize databases, you will be prompted to specify the location of the central 
database.

Day-Timer Organizer will then proceed to scan the local database and the central database and prepare 
to update the data.    This step can take some time, because Day-Timer Organizer must evaluate the 
updates that have been entered in each database since the last synchronization.

Once the scan is complete, Day-Timer Organizer will attempt to synchronize all of the changes in the two 
databases.

Related Topics:
Understanding Conflicts
Resolving Conflicts Automatically



Understanding Conflicts
When you are synchronizing database, a conflict can arise when you have changed the entry on your 
portable unit and someone has changed the same entry in the shared database.    For example, if you 
spoke with a co-worker and they gave you an updated address, you might change it on your portable 
computer and they might have made a change in the central files as well.

If there are conflicts in your databases, you will see a dialog box and you can select your preferred 
options for resolving them.    You can resolve conflicts in two ways:

· specify the method for resolution and have Day-Timer Organizer resolve all conflicts

· view each conflicting record and manually choose how to resolve each conflict on a case by case 
basis



Resolving Conflicts Automatically
When conflicts are detected, a dialog box will be displayed.

If there are conflicts, you must resolve them by deciding which correction to keep.

You can choose to have Day-Timer Organizer decide which corrected entry is the correct one by selecting
one of the radio buttons at the top of the screen.    If you then click on Proceed, all conflicts will be 
resolved by the method you have chosen.
Method Result
Keep Newest The MOST RECENTLY MADE 

correction will be kept; for 
example, if you made an address 
correction on August 1 and your 
assistant made a change to that 
same address entry on August 2, 
then your assistant's correction will
be kept and your entry would be 
discarded

Keep Oldest The OLDER corrections will be 
kept; for example, if a co-worker 
updated a note entry in the office 
on July 15 and you modified the 
same note entry on July 20, your 
corrections would be discarded 
and your co-worker's updates 
would be kept

Keep All from database 1 The changes in the centralized 
database would be kept and 
changes in the portable computer's
database would be discarded; this 
would mean that for all conflicts, 
the entries in your portable 
database would be discarded and 
the corrected entries in the central 
database would be retained

Keep All from database 2 The changes in the portable 
computer's database would be 
kept and changes in the 
centralized database would be 
discarded;

Ignore Any Individual Selections Any manually made selections (as 
described below) will be discarded 
and ALL conflicts will be resolved 
according to the other method 
chosen

Resolving Conflicts Manually
You may choose to review each conflict and decide on a case by case basis which correction should be 
kept.    When the synchronization dialog box is displayed, the first conflict will appear in the windows at the
bottom of the screen, showing how the entry appears in each database.

To select which entry should be retained, click on the Keep check box above that entry.

To accept that selection and proceed to view the next conflict, click on the Next Record button.



Once you have reviewed all of the conflicts and resolved them, click on Proceed to update the database 
files.



Using the Portable Computer as a Workstation
If you use your portable computer as a workstation on the network, you should be especially careful about
which database is in use when the portable unit is connected to the network.

When you are using a portable computer connected to the network, you have access to two 
databases, one on the portable computer's hard disk, and one on the network.    The name of the 
currently active database is displayed on the status bar so that you will know which database is in
use.

When you return to your office and want to use your portable computer as a workstation, you should first 
synchronize to the central database.    Then, you should use the File...Open command to make the 
central database active so that any work that you do on the network goes directly into the centralized 
database.

Whenever you need to remove the portable computer from the network, you should be sure to 
synchronize with the central database before disconnecting.    This ensures that you have a current copy 
of the database before using the portable computer remotely.



Importing from ACT! 1.0 and 2.0
Note: You must open the ACT! database from which you wish to export entries.    This process must be 
repeated for each separate database that you have created in ACT! These instructions cover exporting 
information of Address type only and will not transport information such as Status or other time-related 
material.

In ACT:

1. Choose File...Save As.

2. Next choose All Contacts and click OK.

3. Choose Save File as Type: Delimited

4. Type in a file name with a .ASC extension.

5. Click OK.

6. In the Exporting Options window, chose Comma as your delimiter. Do not put an X in the Export 
Secondary Fields box or Export Field Names. Day-Timer Organizer does not have enough fields 
vacant to support your user fields.

7. Click OK. The document will then begin exporting.

In Day-Timer Organizer:

1. Start Day-Timer Organizer and select any view.

2. Choose File...Import Entries.

3. Select ASCII...

4. Select the ASCII import file you created above and click OK.

5. Set the Delimiter Type = Comma.

6. Under Entry Types, choose Address Book:

7. Drag and drop with your mouse the field names under the Unmapped Fields column to the fields 
you want them mapped to in the Mapped Fields column (reading down each column):

Organization

Last Name

Work Address1

Work Address2

Work Address3

Work City



Work State

Work Zip

Office Phone

Fax

Extension

Fax Extension

Title

Custom Field 1

First Name

Custom Field 2

Custom Field 3

Custom Field 4

(Note: Custom fields may be pre-defined by using the Setup/Custom Fields/Address section of 
Day-Timer Organizer).

8. When you have all the fields mapped in the correct order under the Mapped Fields column, click 
on the Next button a few times to view all the records in your import file and verify the fields are 
mapped correctly. 

9. When you are ready to import the entries, click on the Import button to begin importing your 
entries into Day-Timer Organizer.



Importing from Sidekick 1.0

These instructions will walk you through the process of exporting Cardfile entries from Sidekick and then 
importing them into the Address Book section of Day-Timer Organizer.

1.          Double click on the Sidekick icon labeled Export Cardfile.

2.          Change the Source to the Sidekick Cardfile containing your name and addresses.

Target = c:\dto21\files\sidekick.asc

Target File Type = Comma Delimited (*.csv)

(Note: The drive and directory may be different if you installed Day-Timer Organizer under 
Windows 95 or elsewhere. Be sure to remember where you put the .asc file.)

Click on Export.

3. Next a Field Selection dialog box will come up. Use the Select All button to put all of the Source 
Fields into the Target Fields. The fields should be in the following order:

Salutation

First_Name

Last_Name

Title

Company

Address1

Address2

City

State

Zip

Phone

Extension

Fax

@Email

Comments



Click on OK.

You will be asked if you wish to export another file, click on NO unless you have other Sidekick 
Cardfiles you wish to move over to Day-Timer Organizer.

4. Open Day-Timer Organizer. Select File...Import entries from the menu.

5. Select ASCII...

6. Select the file you created. c:\dto21\files\sidekick.asc

7. Set the Delimiter Type = Comma.

8. Entry Type = Address Book

9. Drag-n-drop with your mouse the field names under Unmapped Fields to the Mapped Fields 
column. The first entry of your import file is displayed to help you match the field names to your 
data.

(Note: you may want to select Skip First if the field names are listed instead of your first data entry.)

The Mapped Fields column should be close if not exactly matching the following:

Mr/Mrs

First Name

Last Name

Title

Organization

Work - Address 1

Work - Address 2

Work - City

Work - State

Work - Zip

Office Phone

Office Extension

FAX

E-Mail Address 1

Text

You can substitute Home for Work if the addresses are home addresses. Also Home for Office for 
home numbers.



10.          Click on Import when you are ready to import the entries.



Importing from Sidekick 2.0

1.    Double click on the Sidekick icon labeled Export Cardfile.

2.    Change the Source to the Sidekick Cardfile containing your name and addresses.

Target = c:\dto21\files\sidekick.asc

Target File Type = Comma Delimited (*.csv)

(Note: The drive and directory may be different if you installed Day-Timer Organizer under 
Windows 95 or elsewhere. Be sure to remember where you put the .asc file.)

Click on Export.

3.    Next a Field Selection dialog box will come up. Use the Select All button to put all of the Source 
fields into the Target fields. The fields should be in the following order:

Salutation

First Name

Last Name

Apartment/Unit #

Address1

Address2

City

State

Zip

Country

Home Phone

Alternate Phone

Company

Spouse

Birthday

Children

Hobby

Group



Notes/Comments

Please note that if you have added or modified the fields in your Sidekick database they will not 
match the list above. Make a note of the fields you exported and match them up to the fields on 
the import. Follow this example to see how this procedure is done.

Click on OK.

You will be asked if you wish to export another file, click on NO unless you have other Sidekick 
Cardfiles you wish to move over to Day-Timer Organizer. 

4.    Open Day-Timer Organizer.    Select File..Import entries from the menu.    Select ASCII.

If this is your first import, you will be prompted for the file name first, then click on OK. Otherwise, 
click on the Browse button after the Delimiter dialog box.

Set the Delimiter Type = Comma.

Import File = C:\dto21\files\sidekick.asc

Entry types: Address Book

Use your mouse to drag and drop the fields from the Unmapped column to the Mapped column. 
Match up our field names to the field names listed in the Field values Sidekick.asc column shown 
in the diagram below.

The Mapped column fields should be in the following order:

Mr/Mrs

First Name

Last Name

Work - Address 3

Work - Address 1

Work - Address 2

Work - City

Work - State

Work - Zip

Work - Country



Home Phone

Office Phone

Organization

Custom Field 1

Custom Field 2

Custom Field 3

Custom Field 4

Custom Field 5

Text

You can substitute Home for Work if the addresses are home addresses. Also phone number 
fields can be changed to match what was exported.

Be sure to check Skip first to make sure the field names are not imported as a record in your 
Address Book.

Click on Import.



Importing from ECCO Simplicity 1.1

These instructions will walk you through the process of exporting PhoneBook entries from ECCO 
Simplicity and then importing them into the Address Book section of Day-Timer Organizer.

Step 1:

1.          Open your ECCO Simplicity program.

2.          Go to your PhoneBook that you want to export the information over to Day-Timer Organizer.

3.          File...Export

Items to Export = Entire PhoneBook

(Warning: This will also include Appointments and other odd entries. You can delete these later within 
Day-Timer Organizer.)

Format = CSV (comma separated)

Keep DOS Text checked.

Click on <Create Set ...>

You want the Fields Chosen to be the following and in this exact order:

Last Name

First Name

Mr./Mrs.

Job Title

Company

Address1 - Business

Address2 - Business

City - Business

State - Business

Zip - Business

Country - Business

Work #

Home #

Fax #

Cell #

Alt #

Address1 - Home



Address2 - Home

City - Home

State - Home

Zip - Home

Country - Home

When this is complete, you can Add the Field Set to Menu if you expect to be exporting to Day-Timer 
Organizer again. Do not forget to name your field set.

Click on OK.

Export to File: Enter the drive, directory and filename of where you want to

place the export file. If unsure, use the following: C:\Names.asc.

4.          Close ECCO Simplicity.

Step 2:

1.          Open Day-Timer Organizer.

2.          Open the database you want these names and addresses if it is different than the one you are in.

3.          File Menu / Import entries

4.          Choose ASCII

5.          Select the import file using Browse, should be c:\Names.asc. Click OK.

6.          Select the Delimiter Type = Comma.

7.          Drag-n-drop with your mouse the field names under Unmapped Fields to the Mapped Fields 
column. The first entry of your import file is displayed to help you match the field names to your data. The 
Mapped Fields must follow this exact order:

Last Name

First Name

Mr/Mrs

Title

Organization

Work - Address1

Work - Address2

Work - City

Work - State



Work - Zip

Work - Country

Office Phone

Home Phone

FAX

Other Phone 1

Other Phone 2

Home - Address1

Home - Address2

Home - City

Home - State

Home - Zip

Home - Country

8.          Click on Next to view each record of your data from your import file and to verify that your data is 
mapped to the fields you want within Day-Timer Organizer.

9.          When the data is in the correct order, click on Import. This will start the import process.



Importing from Lotus Organizer 1.1

These instructions will walk you through the process of exporting entries from Lotus Organizer 1.1 and 
then importing them into Day-Timer Organizer.

Converting Lotus Organizer 1.1 addresses to Day-Timer Organizer Address Book

1.          Open Lotus Organizer 1.1.

2.          Select File Export from the menu.

From section = Address

Export file = c:\dto21\files\address.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

Click on OK.

3.          Now we need to select the fields to export. Map the fields in the following order:

Title = Field 1

First Name = Field 2

Last Name = Field 3

Position = Field 4

Company Name = Field 5

Address = Field 6

Zip = Field 7

Phone = Field 8

Extn = Field 9

Fax = Field 10

User 1 = Field 11

User 2 = Field 12

Notes = Field 13

Type = Field 14 (optional)*

(Note: The Type field is equivalent to our Category field. If you wish to bring this over, make sure you 
have added all of the types you have in Lotus Organizer 1.1 as Categories in Day-Timer Organizer. )



Click on Export.

4.          Lotus Organizer 1.1 will bring up a dialog box telling you how many entries it has exported. Click 
on OK.

5.          Close Lotus Organizer 1.1 and open Day-Timer Organizer.

6.          Select File...Import entries from the menu.

Select ASCII

Import From = c:\dto21\files\address.asc (exactly what you entered when you exported).

Set the Delimiter Type = Comma + quote

Set Entry Type = Address Book

7.          Drag-n-drop with your mouse the field names under Unmapped Fields to the Mapped Fields 
column. The first entry of your import file is displayed to help you match the field names to your data.

The Mapped Fields column should be close if not exactly matching the following:

Mr/Mrs

First Name

Last Name

Title

Organization

Work - Address 1

Work - Zip

Office Phone

Office Extension

FAX

Custom Field 1

Custom Field 2

Text

Category (optional)*

*Only include Category if you included Type in the export from Lotus Organizer 1.1.

**If a home address instead of work address; make the following substitutions:



Home - Address 1                    for                    Work - Address 1

Home - Zip                              for                      Work - Zip

***If a home phone number, make the following substitutions:

Home Phone                    for                    Office Phone

Home Extension                    for                    Office Extension

Click on OK.

Converting Lotus Organizer 1.1 Notepad entries to Day-Timer Organizer Notebook

Follow the same steps as outlined above but with these changes.

1.          In Lotus Organizer 1.1:

Select File Export

From section = Notepad

Export file = c:\dto21\files\notes.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

Click on OK.

2.          Map the following fields:

Title = Field 1

Bits = Field 2

Type = Field 3 (optional)*

*Type field is equivalent to our Category field. If you wish to bring this over, make sure you have added all
of the types you have in Lotus Organizer 1.1 as Categories in Day-Timer Organizer. )

.

Click on Export.

3.          In Day-Timer Organizer:

Select File...Import entries



Select ASCII

Import From = c:\dto21\files\notes.asc (exactly what you entered when you exported).

Set the Delimiter Type = Comma + quote

Entry Types = Notes

The Mapped Fields column should be in this order:

Title

Text

Category (optional)*

*Only include Category if you included Type in the export from Lotus Organizer 1.1.

Click on OK.

Converting Lotus Organizer 1.1 Calendar, To Do, Planner, Anniversary entries

(Note: To convert the data from your Lotus Organizer 1.1 Calendar, To Do, Planner and Anniversary 
section you must use another piece of software to convert the dates and times into formats that we will 
accept.)

For example:

5/6/95          must be converted to                      05/06/95

1/20/95          must be converted to                      01/20/95 (all dates have to be 2 digits)

8:30 AM          must be converted to                      08:30

3:15 PM          must be converted to                      15:15 (all times have to be military and drop the AM or PM)

These changes can be done with a word processing package or a spreadsheet program using the Find 
and Replace options.

Since Lotus Organizer 1.1 keeps track of the duration of a scheduled event and we record the end time. 
We are unable to accept the duration of the appointments for an end time.

Converting Lotus Organizer 1.1 Calendar entries to Day-Timer Organizer's Schedule

1.          In Lotus Organizer 1.1:



Choose File...Export

From section = Calendar

Export file = c:\dto21\files\cal.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

Click on OK.

2.            Map the following fields:

Date = Field 1

Time = Field 2

Text = Field 3

Click on Export.

3.          In Day-Timer Organizer:

Choose File...Import entries...

Select ASCII

Import From = c:\dto21\files\cal.asc (exactly what you entered when you exported).

Set the Delimiter Type = Comma + quote

Entry Types = Schedule

The Mapped Fields column should be in this order:

Date

Begin Time

Text

Click on OK.

Converting Lotus Organizer 1.1 To Do entries to Day-Timer Organizer Tasks

1.          In Lotus Organizer 1.1:

Choose File Export



From section = To Do

Export file = c:\dto21\files\todo.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

Click on OK.

2.          Map the following fields:

Due Date = Field 1

Priority = Field 2

Text = Field 3

Click on Export.

3.          In Day-Timer Organizer:

Choose File Import entries

Select ASCII

Import From = c:\dto21\files\todo.asc (exactly what you entered when you exported).

Set the Delimiter Type = Comma + quote

Entry Types = Tasks

The Mapped Fields column should be in this order:

Date

Priority

Text

Click on OK.

Converting Lotus Organizer 1.1 Planner entries to Day-Timer Organizer Schedule

1.          In Lotus Organizer 1.1:

Choose File...Export

From section = Planner



Export file = c:\dto21\files\planner.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

Click on OK.

2.          Map the following fields:

Date = Field 1

Time = Field 2

Text = Field 3

Click on Export.

3.          In Day-Timer Organizer:

Choose File...Import entries

Select ASCII

Import From = c:\dto21\files\planner.asc (exactly what you entered when you exported).

Set the Delimiter Type = Comma + quote

Entry Types = Schedule

The Mapped Fields column should be in this order:

Date

Begin Time

Text

Click on OK.

Converting Lotus Organizer 1.1 Anniversary entries to Day-Timer Organizer Schedule

1.          In Lotus Organizer 1.1:

Choose File...Export

From section = Anniversary

Export file = c:\dto21\files\ann.asc



(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc files.)

Click on OK.

2.          Map the following fields:

Date = Field 1

Text = Field 2

Click on Export.

3.          In Day-Timer Organizer:

Choose File...Import entries 

Select ASCII

Import From = c:\dto21\files\ann.asc (exactly what you entered when you exported).

Set the Delimiter Type = Comma + quote

Entry Types = Schedule

The Mapped Fields column should be in this order:

Date

Text

Click on OK.



Importing from Lotus Organizer 2.0

These instructions will walk you through the process of exporting entries

from Lotus Organizer 2.0 and then importing them into Day-Timer Organizer

for Windows.

Converting Lotus Organizer 2.0 Address entries to Day-Timer Organizer Address Book.

1.          Open Lotus Organizer 2.0.

2.          Select File...Export from the menu.

From section = Address

File name = c:\dto21\files\address.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

List files of type = ASCII Text (*.TXT, *.CSV)

3.          Click on Mapping to select the fields to export.    Click on Clear All to clear the current mappings.

The fields should be mapped in the following order:

First Name = Field 1

Last Name = Field 2

Title = Field 3

Job Title = Field 4

Business Company = Field 5

Business Street = Field 6

Business City = Field 7

Business State = Field 8

Business Zip = Field 9

Business Country = Field 10

Business Tel1 = Field 11

Business Ext = Field 12



Business Fax = Field 13

Business Email = Field 14

Business Tel2 = Field 15

Business Notes = Field 16**

Home Street = Field 17

Home City = Field 18

Home State = Field 19

Home Zip = Field 20

Home Country = Field 21

Home Tel1 = Field 22

Home Tel2 = Field 23

Home Fax = Field 24

Home E-mail = Field 25

Home Unused 1 = Field 26

Home Unused 2 = Field 27

Home Notes = Field 16**

These are optional fields that you can map and bring over to Day-Timer Organizer:

Categories

Assistant

Spouse

Children

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the categories you have in Lotus Organizer 2.0 as Categories in Day-Timer Organizer.)

**You want to map both Business Notes and Home Notes to Field 16 to combine them.

Field mapping name = Address

Click on Add to save the mappings you have defined.

Click on OK to close the dialog box.

Now click on OK to export the entries.

4.          Close Lotus Organizer 2.0 and open Day-Timer Organizer.



Select File...Import entries from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\address.asc

Set the Delimiter Type = Comma

Then click OK.

Entry Type = Address Book

5.          Drag-n-drop with your mouse the field names under Unmapped Fields to the Mapped Fields 
column. The first entry of your import file is displayed to help you match the field names to your data.

The Mapped Fields column should be close if not exactly matching the following:

First Name

Last Name

Mr/Mrs

Title

Organization

Work - Address 1

Work - City

Work - State

Work - Zip

Work - Country

Office Phone

Office Extension

FAX

E-Mail Address 1

Mobile Phone

Text

Home - Address 1

Home - City

Home - State

Home - Zip

Home - Country

Home Phone

Other Phone 1



Other Phone 2

E-Mail Address 2

Custom Field 1

Custom Field 2

These are optional fields that you can map and bring over to Day-Timer Organizer:

Category

Custom Field 3

Custom Field 4

Custom Field 5

Click on OK.

Converting Lotus Organizer 2.0 Notepad entries to Day-Timer Organizer Notebook

Follow the same steps as outlined above but with these changes.

1.          In Lotus Organizer 2.0:

Choose File...Export

From section = Notepad

Export file = c:\dto21\files\notes.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

List files of type = ASCII Text (*.TXT, *.CSV)

2.          Click on Mappings... then on Clear All.

Field mapping name = Notes

Map the following fields:

Title = Field 1



Notes = Field 2

Categories = Field 3 (optional)*

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the Categories you have in Lotus Organizer 2.0 as Categories in Day-Timer Organizer.)

Click on Add save the field mappings.

Click on OK then OK again to export.

(Note: You will need to drop the End Date when converting the date and time fields.)

3.          In Day-Timer Organizer:

Select File.. Import entries from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\notes.asc

Set the Delimiter Type = Comma

Entry Type = Notes

The Mapped Fields column should be close to, if not exactly matching, the following:

Title

Text

Category*

*Only include Category if you included Categories in the export from Lotus Organizer 2.0.

Click on OK.

Converting Lotus Organizer 2.0 Calendar, To Do, Calls, Planner, and Anniversary entries to Day-
Timer Organizer Schedule

(Note: To convert the data from your Lotus Organizer 2.0 Calendar, To Do, Calls, Planner and Anniversary
section you must use another piece of software to convert the dates and times into formats that Day-
Timer Organizer will accept.)



For example:

Start date time = 1995-01-23 09:00:00 must be converted to 2 separate fields = 01/23/95 and 09:00.

All dates have to be in the format of mm/dd/yy with 2 digits each.

All times have to military and in the format of hh:mm.

Examples:          1995-01-03 12:40:00 convert to 01/03/95, 12:40

                    1995-12-08 08:00:00 convert to 12/08/95, 08:00

These changes can be done with a word processing package or a spreadsheet program using the Find 
and Replace options. The same process must be done for End date time, From Date, Start Date and any 
other date or time fields.

Converting Lotus Organizer 2.0 Calendar entries to Day-Timer Organizer Schedule.

1.          In Lotus Organizer 2.0:

Choose File...Export...

From section = Calendar

Export file = c:\dto21\files\cal.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

List files of type = ASCII Text (*.TXT, *.CSV)

2.          Click on Mappings... then on Clear All.

Field mapping name = Calendar

Map the following fields:

Start date time = Field 1

End date time = Field 2

Description = Field 3

These are optional fields that you can map and bring over to Day-Timer



Organizer:

Categories*

Customer Code

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the Categories you have in Lotus Organizer 2.0 as Categories in Day-Timer Organizer. 

Click on Add save the field mappings. Click on OK then OK again to export.

(Note: You will want to drop the End Date when converting the date and time fields.)

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\cal.asc

Set the Delimiter Type = Comma

Entry Type = Schedule

The Mapped Fields column should be close if not exactly matching the following:

Date

Begin Time

End Time

Text

These are optional fields that you can map and bring over to Day-Timer Organizer:

Category

Custom Field 1

Click on OK.

Converting Lotus Organizer 2.0 To Do entries to Day-Timer Organizer Tasks.

1.          In Lotus Organizer 2.0:



Choose File...Export...

From section = To Do

Export file = c:\dto21\files\todo.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

List files of type = ASCII Text (*.TXT, *.CSV)

2.          Click on Mappings... then on Clear All.

Field mapping name = Tasks

Map the following fields:

Due date = Field 1

Description = Field 2

Priority = Field 3

Completion date = Field 4

This is an optional field that you can map and bring over to Day-Timer Organizer:

Categories*

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the Categories you have in Lotus Organizer 2.0 as Categories in Day-Timer Organizer. 

Click on Add save the field mappings.

Click on OK then OK again to export.

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\todo.asc

Set the Delimiter Type = Comma

Entry Type = Tasks

The Mapped Fields column should be close if not exactly matching the following:

Date



Text

Priority

Date Finished

Click on OK.

Converting Lotus Organizer 2.0 Calls entries to Day-Timer Organizer Phone Calls.

1.          In Lotus Organizer 2.0:

Choose File...Export...

From section = Calls

Export file = c:\dto21\files\calls.asc

(Note: The drive and directory may be different if you installed Day-Timer

Organizer 2.1 under Windows 95 or elsewhere. Be sure to remember where you

put the .asc file.)

List files of type = ASCII Text (*.TXT, *.CSV)

2.          Click on Mappings... then on Clear All.

Field mapping name = Calls

Map the following fields:

Start date time = Field 1

Description = Field 2

Telephone Number = Field 3

First Name = Field 4

Last Name = Field 4

Company = Field 4

Status = Field 5

Click on Add save the field mappings.

Click on OK then OK again to export.



3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\calls.asc

Set the Delimiter Type = Comma

Entry Type = Phone Log

The Mapped Fields column should be close if not exactly matching the following:

Date

Begin Time

Text

Phone

Name/Company

Status

Click on OK.

Lotus Organizer 2.0 Planner entries to Day-Timer Organizer Schedule.

1.          In Lotus Organizer 2.0:

Choose File...Export...

From section = Planner

Export file = c:\dto21\files\planner.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

List files of type = ASCII Text (*.TXT, *.CSV)

2.          Click on Mappings... then on Clear All.

Field mapping name = Planner

Map the following fields:



From date = Field 1

Description = Field 2

Click on Add save the field mappings.

Click on OK then OK again to export.

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\planner.asc

Set the Delimiter Type = Comma

Entry Type = Schedule

The Mapped Fields column should be close if not exactly matching the

following:

Date

Text

Click on OK.

Lotus Organizer 2.0 Anniversary entries to Day-Timer Organizer Schedule

1.          In Lotus Organizer 2.0:

Choose File...Export

From section = Anniversary

Export file = c:\dto21\files\ann.asc

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .asc file.)

List files of type = ASCII Text (*.TXT, *.CSV)

2.          Click on Mappings... then on Clear All.



Field mapping name = Ann

Map the following fields:

Start date = Field 1

Description = Field 2

Click on Add save the field mappings.

Click on OK then OK again to export.

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\ann.asc

Set the Delimiter Type = Comma

Entry Type = Schedule

The Mapped Fields column should be close if not exactly matching the following:

Date

Text

Click on OK.



Importing from Lotus Organizer 2.1

These instructions will walk you through the process of exporting entries from Lotus Organizer 2.1 and 
then importing them into Day-Timer Organizer.

Converting Lotus Organizer 2.1 Address entries to Day-Timer Organizer Address Book.

1.          Open Lotus Organizer 2.1.

2.          Select Export... from the File menu.

From section = Address

File name = c:\dto21\files\address.txt

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .txt file.)

List files of type = ASCII Text (*.txt)

3.          Click on Mapping... to select the fields to export 

Click on Clear All to clear the current mappings.

The fields should be mapped in the following order:

First Name = Field 1

Last Name = Field 2

Title = Field 3

Job Title = Field 4

Business Company = Field 5

Business Street = Field 6

Business City = Field 7

Business State = Field 8

Business Zip = Field 9

Business Country = Field 10

Business Tel1 = Field 11

Business Ext = Field 12

Business Fax = Field 13



Business E-Mail = Field 14

Business Tel2 = Field 15

Business Notes = Field 16**

Home Street = Field 17

Home City = Field 18

Home State = Field 19

Home Zip = Field 20

Home Country = Field 21

Home Tel1 = Field 22

Home Tel2 = Field 23

Home Fax = Field 24

Home E-Mail = Field 25

Home Unused 1 = Field 26

Home Unused 2 = Field 27

Home Notes = Field 16**

These are optional fields that you can map and bring over to Day-Timer

Organizer:

Categories

Assistant

Spouse

Children

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the categories you have in Lotus Organizer 2.1 as Categories in Day-Timer Organizer. 

**You want to map both Business Notes and Home Notes to Field 16 to combine them.

Field mapping name = Address

Click on Add to save the mappings you have defined.

Click on OK to close the dialog box.

Now click on OK to export the entries.

4.          Close Lotus Organizer 2.1 and open Day-Timer Organizer.



Select Import entries... from the File menu.

Select ASCII...

Select the file you created. c:\dto21\files\address.txt

Set the Delimiter Type = Comma + quote

Then click OK.

Entry Type = Address Book

5.          Drag-n-drop with your mouse the field names under Unmapped Fields to the Mapped Fields 
column. The first entry of your import file is displayed to help you match the field names to your data.

The Mapped Fields column should be close if not exactly matching the following:

First Name

Last Name

Mr/Mrs

Title

Organization

Work - Address 1

Work - City

Work - State

Work - Zip

Work - Country

Office Phone

Office Extension

FAX

E-Mail Address 1

Mobile Phone

Text

Home - Address 1

Home - City

Home - State

Home - Zip

Home - Country

Home Phone

Other Phone 1



Other Phone 2

E-Mail Address 2

Custom Field 1

Custom Field 2

These are optional fields that you can map and bring over to Day-Timer Organizer:

Category

Custom Field 3

Custom Field 4

Custom Field 5

Click on OK.

Converting Lotus Organizer 2.1 Notepad entries to Day-Timer Organizer Notebook

Follow the same steps as outlined above but with these changes.

1.          In Lotus Organizer 2.1:

Choose File...Export

From section = Notepad

Export file = c:\dto21\files\notes.txt

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .txt file.)

List files of type = ASCII Text (*.txt)

2.          Click on Mappings... then on Clear All.

Field mapping name = Notes

Map the following fields:

Title = Field 1



Notes = Field 2

Categories = Field 3 (optional)*

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the Categories you have in Lotus Organizer 2.1 as Categories in Day-Timer Organizer. 

Click on Add save the field mappings.

Click on OK then OK again to export.

(Note: You will need to drop the End Date when converting the date and time fields.)

3.          In Day-Timer Organizer:

Select File.. Import entries from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\notes.txt

Set the Delimiter Type = Comma + quote

Entry Type = Notes

The Mapped Fields column should be close to, if not exactly matching, the following:

Title

Text

Category*

*Only include Category if you included Categories in the export from Lotus Organizer 2.1.

Click on OK.

Converting Lotus Organizer 2.1 Calendar, To Do, Calls, Planner, and Anniversary entries to Day-
Timer Organizer Schedule

(Note: To convert the data from your Lotus Organizer 2.1 Calendar, To Do, Calls, Planner and Anniversary
section you must use another piece of software to convert the dates and times into formats that Day-
Timer Organizer will accept.)



For example:

Start date time = 1995-01-23 09:00:00 must be converted to 2 separate fields = 01/23/95 and 09:00.

All dates have to be in the format of mm/dd/yy with 2 digits each.

All times have to military and in the format of hh:mm.

Examples:          1995-01-03 12:40:00 convert to 01/03/95, 12:40

                    1995-12-08 08:00:00 convert to 12/08/95, 08:00

These changes can be done with a word processing package or a spreadsheet program using the Find 
and Replace options.    The same process must be done for End date time, From Date, Start Date and 
any other date or time fields.

Converting Lotus Organizer 2.1 Calendar entries to Day-Timer Organizer Schedule.

1.          In Lotus Organizer 2.1:

Choose File...Export...

From section = Calendar

Export file = c:\dto21\files\cal.txt

(Note: The drive and directory may be different if you installed Day-Timer Organizer  under Windows 95 
or elsewhere. Be sure to remember where you put the .txt file.)

List files of type = ASCII Text (*.txt)

2.          Click on Mappings... then on Clear All.

Field mapping name = Calendar

Map the following fields:

Start date time = Field 1

End date time = Field 2

Description = Field 3

These are optional fields that you can map and bring over to Day-Timer Organizer:



Categories*

Customer Code

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the Categories you have in Lotus Organizer 2.1 as Categories in Day-Timer Organizer.

Click on Add save the field mappings. Click on OK then OK again to export.

(Note: You will want to drop the End Date when converting the date and time fields.)

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\cal.txt

Set the Delimiter Type = Comma + quote

Entry Type = Schedule

The Mapped Fields column should be close if not exactly matching the following:

Date

Begin Time

End Time

Text

These are optional fields that you can map and bring over to Day-Timer Organizer:

Category

Custom Field 1

Click on OK.

Converting Lotus Organizer 2.1 To Do entries to Day-Timer Organizer Tasks.

1.          In Lotus Organizer 2.1:

Choose File...Export...



From section = To Do

Export file = c:\dto21\files\todo.txt

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .txt file.)

List files of type = ASCII Text (*.txt)

2.          Click on Mappings... then on Clear All.

Field mapping name = Tasks

Map the following fields:

Due date = Field 1

Description = Field 2

Priority = Field 3

Completion date = Field 4

This is an optional field that you can map and bring over to Day-Timer Organizer:

Categories*

*Categories field is equivalent to our Category field. If you wish to bring this over, make sure you have 
added all of the Categories you have in Lotus Organizer 2.1 as Categories in Day-Timer Organizer. 

Click on Add save the field mappings.

Click on OK then OK again to export.

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\todo.txt

Set the Delimiter Type = Comma + quote

Entry Type = Tasks

The Mapped Fields column should be close if not exactly matching the following:

Date

Text



Priority

Date Finished

Click on OK.

Converting Lotus Organizer 2.1 Calls entries to Day-Timer Organizer Phone Calls.

1.          In Lotus Organizer 2.1:

Choose File...Export...

From section = Calls

Export file = c:\dto21\files\calls.txt

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .txt file.)

List files of type = ASCII Text (*.txt)

2.          Click on Mappings... then on Clear All.

Field mapping name = Calls

Map the following fields:

Start date time = Field 1

Description = Field 2

Telephone Number = Field 3

First Name = Field 4

Last Name = Field 4

Company = Field 4

Status = Field 5

Click on Add save the field mappings.

Click on OK then OK again to export.

3.          In Day-Timer Organizer:



Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\calls.txt

Set the Delimiter Type = Comma + quote

Entry Type = Phone Log

The Mapped Fields column should be close if not exactly matching the following:

Date

Begin Time

Text

Phone

Name/Company

Status

Click on OK.

Converting Lotus Organizer 2.1 Planner entries to Day-Timer Organizer Schedule.

1.          In Lotus Organizer 2.1:

Choose File...Export...

From section = Planner

Export file = c:\dto21\files\planner.txt

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .txt file.)

List files of type = ASCII Text (*.txt)

2.          Click on Mappings... then on Clear All.

Field mapping name = Planner

Map the following fields:

From date = Field 1

Description = Field 2



Click on Add save the field mappings.

Click on OK then OK again to export.

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\planner.txt

Set the Delimiter Type = Comma + quote

Entry Type = Schedule

The Mapped Fields column should be close if not exactly matching the following:

Date

Text

Click on OK.

Converting Lotus Organizer 2.1 Anniversary entries to Day-Timer Organizer Schedule

1.          In Lotus Organizer 2.1:

Choose File...Export

From section = Anniversary

Export file = c:\dto21\files\ann.txt

(Note: The drive and directory may be different if you installed Day-Timer Organizer under Windows 95 or
elsewhere. Be sure to remember where you put the .txt file.)

List files of type = ASCII Text (*.txt)

2.          Click on Mappings... then on Clear All.

Field mapping name = Ann

Map the following fields:



Start date = Field 1

Description = Field 2

Click on Add save the field mappings.

Click on OK then OK again to export.

3.          In Day-Timer Organizer:

Select File...Import entries... from the menu.

Select ASCII...

Select the file you created. c:\dto21\files\ann.txt

Set the Delimiter Type = Comma + quote

Entry Type = Schedule

The Mapped Fields column should be close if not exactly matching the following:

Date

Text

Click on OK.



Backing Up Your Data
Day-Timer Organizer database files normally reside in directory \dto21\files.    

Each database consists of 9-12 separate files.    All files in a database begin with the same name, and 
should not be separated from each other.    During installation, Day-Timer Organizer creates a single user 
database named Main or a multi-user databases named Office.    You may have chosen a different name 
for your database.

To safeguard against data loss, you should back up regularly.    Then in the event of a hard drive problem 
or data corruption in the database, you can restore to the previous database.

To backup your database, choose the File...Backup Database command.    You will be prompted to 
specify a name for the backup file and a location.    We recommend that you back up to another disk drive 
or a network drive.    Once you have specified the name of the backup file, all of the database files will be 
compressed together into a single file that you can restore with the File...Restore Database command.

Related Topics:
Restoring Data from a Backup



Restoring Your Data from Backup
If your database is corrupted, you can restore from a previous backup by issuing the File...Restore 
Database command.    You will be prompted for the name and location of the backup file.    This 
restoration process will restore the entire database to its state just prior to issuing the backup command.

Related Topics:
Backing Up Your Data



Archiving and Deleting Data
Day-Timer Organizer database files are very economical in their use of space.    In addition, users derive 
the most benefit from Day-Timer Organizer if ongoing files are maintained online so that they can be 
searched and reviewed as required.    For these reasons, we do not recommend that you delete old data.

If hard disk storage is a concern, you can archive old data with the File...Export Entries command, using
the Archive command from the sub-menu.

Archiving entries will not immediately create free space on your disk.    It will remove entries from the Day-
Timer Organizer database files, if requested, but the files will not be compressed.    However when 
additional entries are created, they will be inserted in the freed space and no additional space will be 
used.

The Archive dialog box allows you to use Search Options to specify the range of data to be archived.    In 
addition, you can simply archive by date:

· Click on Modified Since and specify a date; all data that has been created or updated since the 
specified date (e.g. the last archive date) will be archived.

· Click on Dated Before and specify a date; all data older than the specified date will be archived.

In addition, you can choose what to do with the archived data:

· Export Entries but do not delete - specified data will be archived but will remain in the Day-
Timer Organizer database

· Export and Delete Entries - specified data will be archived and removed from the database

· Delete Entries but do not export - specified entries will be deleted only (not archived)

The Export To field specifies the file name for the archive file.    You can use the Browse button to select 
a location or you can type the full path name (including disk drive) to specify the file for the archived 
entries.    For example

A:MYFILE.ARC

would archive the data to the floppy drive.    Alternately, specifying

C:\ARCHIVE\0797.ARC

would create a file on the C: hard drive.

Related Topics:
Creating an Export File



Working with Databases
In general, you do not need to have more than one single-user database (standalone systems) or one 
centralized multi-user database (networks).

Unless you change the default during installation or when creating a new database, Day-Timer Organizer 
files are stored in directory \dto21 and its subdirectories (see below).

Related Topics:
How Files are Stored
Creating a New Database
Opening a Different Database
Changing the Database Name
Deleting a Database



How Files are Stored
By default, when you install Day-Timer Organizer, the program files are stored in the directory \DTO21 
and its subdirectories.    The database files are stored in \DTO21\FILES and should be backed up 
regularly.    The subdirectory \DTO21\FILES may also contain export files (which end with .exp).    These 
may be deleted when they are no longer needed.    

Figuring Out the Name of My Database

The name of the database you are working in is displayed in the middle of the status bar (the third item 
from the left).    

Each Day-Timer Organizer database consists of several files, all of which begin with the database name.  
When you copy a database, be sure you copy all of the files    

Do not attempt to edit any of these files yourself.    If you do, you may corrupt your database.



Creating a New Database
You can create a new database with the File...New Database command.    The dialog box that appears 
will prompt you for a name and location for the database.    You must choose a new name (one that has 
not been used before).

You must also specify whether the database is to be Single User or Multi User.    The differences 
between single- and multi- user databases are described in A Note on Saving Your Data.

You may choose to save the database in a different location.    By default, the database will be stored in \
DTO21\FILES.    Note that if you create a multi-user database, you will be considered the database 
manager.



Opening a Different Database
If you have created multiple databases, you can switch to a new database by issuing the File...Open 
Database command.    Once you have specified the correct drive and directory, your database name(s) 
will show in the large window at the left.    Click on the name of the designated database so that it moves 
up to the smaller window on the left side.    Click on the OK button to accept your choice.

When you switch to a new database, any alarms that were set in the previous database are 
deactivated.    You will not receive alarms for schedule events in a database that is not open.



Changing the Database Name
You can change the current database name by choosing the File...Rename Database command.    
Choose a name that is not already used in the list that is displayed.    Only the supervisor or database 
manager can change the name of a multi-user database.



Deleting a Database
To permanently delete the current database, choose the File...Delete Database command.    Deleting a 
database removes all data and files associated with the database.    Only the supervisor or database 
manager can delete a multi-user database.



Rebuilding a Corrupted Database
If Day-Timer Organizer repeatedly displays a Data Integrity Error, proceed as follows:

1. Check your hardware to make sure it is running properly.

2. Use the utility specified by your network operating system or hard disk manufacturer to verify your
hard disk.    Alternately, you may choose to run CHKDSK or ScanDisk (described in your DOS 
manual), Norton Disk Doctor, or a similar program to diagnose and repair any disk errors.    Bad 
sectors, lost allocation units, cross-linked files, and other similar errors can result in a database 
failing to rebuild.

3. Restore your database from a recent backup.

4. If you have no recent backup, rebuild the database following the instructions below. 

For multi-user databases, you must be the supervisor to rebuild or restore the database.    

Before you Rebuild
1. Try to find and correct the cause of the corruption.    Common causes include hardware problems,

disk compression utilities, delayed write disk caches, and users who turn their computers off 
before a disk write operation is complete (or before a disk cache is flushed). 

2. Check for sufficient free disk space.    You should have free space equal to twice the size of the 
database you are rebuilding (half for the new database, and half for temporary files).

3. Verify that there is a Files=60 (preferably more) statement in the Config.sys file in your root 
directory (see your DOS manual).

How To Rebuild
Rebuilding a large database is time-consuming, and should be done overnight (over the weekend for a 
very large network database).    When rebuilding a network database, use the fastest workstation 
available. 

1. Select the Rebuild option from the File menu.    To rebuild a shared network database, you must 
be logged in as Supervisor (see Day-Timer Organizer Workgroup Guide) and ensure that no 
users are using the databases.    Users must not attempt to access the database during the 
rebuild process.

2. Choose Recurring Entries (if you are experiencing a problem with recurring or multi-day entries) 
or Entire Database. 

3. Select the database you want to rebuild.    The database name is displayed on the status bar at 
the bottom of the screen (third box from the left).

4. The rebuilt database will keep the original database name.    Type a name for the backup copy of 
the corrupted database (delete this after successful rebuild).

After you Rebuild
1. Retry the commands that made you decide to rebuild.    If the problem persists, call Technical 



Support.

2. Keep the backup database for a few days to be sure the rebuild was successful, then delete it.

Rebuild May Not Recover:
1. Assignee and Category descriptions, group membership settings, default search and default 

assignment settings.

2. Note positioning information.

3. New holidays that you have created yourself.

4. New entry default rights for all users.



Common Technical Questions
In addition to the problems listed below, erratic and unpredictable Day-Timer Organizer behavior can be 
caused when a user attempts to edit program, database, system, or Windows initialization (.INI) files.    Do
not attempt to edit these files yourself.

Problem: You receive a Too many open files message.

Cause: The number of open files currently allowed by DOS on your system is too small.    To expand this 
number, see Files command instructions in your DOS manual.    Files should be set to 60 or more.

Problem: Your computer locks up with a Black Padlock on screen.    

Cause: (1)You are waiting for a network resource locked by another user.    On peer-to-peer networks 
such as LANtastic, this often indicates an insufficient number of available locks (see Day-Timer Organizer
Workgroup Guide).    

(2)Your database has become corrupted.    You must restore or rebuild the database.

Problem: Dates you type are not accepted or are misinterpreted.

Cause: The Date Format is set improperly.    Consult your system documentation for information about 
choosing between Month/Day and Day/Month formats for date input and display.

Problem: Entries seem to disappear.

Cause: (1)Current Search Settings have filtered out the missing entries.    Click on the broom to clear all 
search settings.    If necessary, reset Default Search to include all Assignees and Categories (for details, 
see Using Search Options).    Another possibility for Network Users is that the owner of the missing 
entries did not grant rights to view them to other users (see Sharing Entries With Others).

(2)Your database index has become corrupted.    You must restore or rebuild the database.

Problem: After importing entries into your database, you are unable to find them on any view screen.

Cause: Refer to "Entries seem to disappear", above.

Problem: Reports do not print, or print incorrectly.

Cause: Make sure your printer has been Installed into Windows (see your Windows manual).    Your 
printer should be on, connected to your computer, and set to OnLine.    Many printing problems are 
caused by faulty or outdated printer driver software - ask your printer manufacturer whether the driver for 
your printer has been updated.    If printing to a network printer, make sure your printer selection is 
redirected to a network print queue.

Problem:    You receive a Day-Timer Organizer Data Integrity Error.

Cause: You may have a data corruption problem.    You can generally ignore these messages if they 



occur only once and do not specifically instruct to rebuild your database.    See Rebuilding a Corrupted 
Database.

Problem:    You are unable to dial phone numbers.

Cause:    Check modem and com port settings (see Telephone Settings).    An "Invalid Comm.Drv" 
message means a communications program designed for Windows 3.0 replaced Comm.drv with a driver 
incompatible with Windows 3.1.    Ask your software supplier for an updated driver.

Problem:    External e-mail does not function properly.

Cause:    Make sure your third party E-Mail software supports either VIM or MAPI protocols.    Your 
WIN.INI file should contain a [MAIL] section with the line SMI=1 (if using VIM) or MAPI=1 (if using MAPI). 
Make sure the E-Mail program directory is listed in the DOS path statement.    In addition, you need to be 
sure that your workstation are time synchronized with the file server.

Problem:    Non-English or special characters are not handled properly.

Cause:    Refer to the Character Map section of your Microsoft Windows manual for instructions on using 
special characters.



Technical Notes
Day-Timer Technologies has compiled a series of technical documents that address a variety of specific 
issues.    These are available in several ways as described below.

At publication time, documents included technical notes about 

· importing/exporting data from/to a variety of specific systems 

· rebuilding a damaged database

· common technical problems.

You may find an answer to your questions in one of the technical notes.
By Fax
Through Online Services
On the Day-Timer Technologies Bulletin Board System
On the World Wide Web



Technical Notes By Fax
In the U.S. and Canada, technical notes are available through a fax-back system, 24 hours per day.    You 
can request a current index of documents available at any time.    To use the fax-back system, dial the 
following number from any phone.

800 / 362-9927

and press 1 to access our 24-hour automated fax retrieval system.    You will be prompted to specify the 
document number that you wish to receive.    The index is document number 101.

You will also be asked to specify the phone number of the fax to which the technical note(s) should be 
sent.



Technical Support
There are many ways to receive technical support for your Day-Timer Organizer software:

Free Online Support
Free Email Support (via the Internet)
Day-Timer Technologies Bulletin Board System

By Phone
By Fax

Free Technical Information



Technical Support By Fax
You can fax your questions to Day-Timer Technologies' technical support group 24 hours per day at 
415/572-9675.    We will attempt to respond to all faxed questions by the next business day.    In the UK, 
fax to 0800 966671; in Australia, 1800 124 520; in New Zealand, 0800 449 445; no additional country 
code required.



Technical Support Through Online Services
Day-Timer Technologies maintains support forums on CompuServe and America Online.    You can send 
your support questions to Day-Timer Technologies Technical Support or you can access the following 
information:

· Product and company information (brochures, feature lists, pricing, and availability)

· Press releases with information about new product features

· Maintenance upgrades for the latest versions of our products

· Technical support notes

· Frequently asked questions and answers

To access the Day-Timer Technologies support forum on CompuServe, from any prompt, type

go daytimer

To access the Day-Timer Technologies support forum through America Online, use the keyword

DAYTIMER

Technical Notes On the World Wide Web
Technical notes and support are available on the World Wide Web at

http://www.daytimer.com



Technical Support by Email (via the Internet)
Send Email requests for technical support to

support@dtt.daytimer.com

We will attempt to respond via Email by the next business day.



Technical Support On the Day-Timer Technologies Bulletin Board 
System
The Day-Timer Technologies Bulletin Board system (BBS) is available 24 hours per day.    You can 
download 

· the latest maintenance release of Day-Timer Organizer

· a single user trial version of Day-Timer Organizer which will work for 30 days

· printer drivers for select printers

· technical notes

To access the BBS, use any standard telecommunications package such as the Terminal program in 
Windows.    You must use a standard Hayes compatible modem.    Set the communication parameters to

· 8 bits

· No parity

· 1 stop bit

and dial 

415 / 572-4728

When you first dial in to the BBS, you will be asked for your login name.    If you have never called before, 
enter the login name

new
and a new account will be created for you.    Once an account is set up, you can call in again to see if a 
newer release has become available.



Technical Support By Phone
Dial 800-235-7355 (in the U.S. and Canada) for

¨ Free start-up help with installation and initial setup questions

OR

¨ to use our free automated support system (available 24 hours per day; touch tone phone 
required)

For all other questions, technical support is available at US$2.00 per minute (charged to your credit 
card).    Dial 800-235-7355 (U.S. and Canada) and follow the instructions.    Note:    You will only be billed 
for actual time spent talking with a technical support consultant.

The technical support phone center in California is staffed from 7 a.m. to 5 p.m. Pacific Standard Time.    
When you call, you should be at your computer and have the following information ready for our 
representative:

¨ Exact text of error messages (if any) that you encountered

¨ Make and model of computer system, monitor, graphics card, printer

¨ Operating system software version number 

¨ Day-Timer Organizer version number 

¨ Location of Day-Timer Organizer program and data files

¨ Names and version numbers of other software (if applicable)

¨ Amount of memory you have



Using the Uninstall Icon
If you wish to remove Day-Timer Organizer from your system, you can
click on the Uninstall icon in the Day-Timer Organizer program group.  
This process removes all of the program files from your hard disk.

The uninstall procedure DOES NOT remove the data files that you have created in Day-Timer 
Organizer.    This is a safety feature to prevent accidental loss of valuable data.    Data files will 
only be removed at your explicit command and we strongly recommend that you back up the data 
files before deleting them.



Removing Databases
To remove a database when you are certain that you will no longer need Day-Timer Organizer, you must 
use the Windows File Manager or DOS commands.    The data files are stored by default in \DTO21\
FILES as discussed in How Files are Stored.    

Data files will only be removed at your explicit command and we strongly recommend that you 
back up data files before deleting them.



 Setting the Screen Font
The amount of data visible on the view windows depends upon the size of the screen font you select.    To 
change the screen font, select User Preferences from the Setup menu, and scroll down the options list 
until the Screen Fonts graphic appears.    Click on the button for the view of your choice, and select the 
font, style, and point size that's best for you.



The System Menu
The System menu is a standard feature for Windows applications that allows you to close the application 
as well as resize and move the application's window.    The Minimize command iconizes the application.    
The Maximize command enlarges the window to cover the entire screen.    From this menu, you can 
switch to another application or to the Windows Program Manager.



Tips and Shortcuts
General

Schedule

Notes

Address Book

Phone Call

Internet

Email

Tasks



General Shortcuts
Entering a weekday or follow-up date

As an alternative to selecting a date from the calendar button, you can enter it as a weekday. If a 
weekday is not preceded by this, next, or last, the next occurrence is used by default. Typing the single 
letter, t, n, or l is a faster way of indicating this, next, or last. Weekdays may also be represented by a 
single letter unless there may be ambiguity(Tuesday/Thursday and Saturday/Sunday), in which case two 
letters are needed.

Examples:

l w means last Wednesday

n tu means next Tuesday

t f means this Friday

This shortcut applies to the Event Date field in the Address Book section, the Due Date field of a Task, the
Follow-up Date field of a Note or Schedule item, the Call Date field of a Phone Call, and the Date field in 
the Expense section.

Entering dates as time intervals

You may enter a time block in any of the date fields as 'time remaining until its occurrence'. For example, 
2w means: 2 weeks from the current date. To adjust an existing time block, type a time interval preceded 
by a Plus (+) or Minus (-) sign to indicate whether you are increasing or decreasing the present time 
block.

Examples:

+4d means 4 days from the current date

-3w means minus 3 weeks from the current date

2m means 2 months from the current date

(Where d represents day, w represents week, and m shows month.) 

This shortcut applies to the Event Date field in the Address Book section, the Due Date field of a Task, the
Follow-up Date field of a Note or Schedule item, the Call Date field of a Phone Call, and the Date field in 
the Expense section.

Transferring information between views

If you have more than one view open at once, it's easy to transfer information between them simply by 
dragging an entry from one view over to the desired location in the other. For example, if you click on a 
contact name in your Address Book and drag it to the schedule section of the daily planner view, a new 
meeting will be created with that contact on the day and time you select.

Adjusting a time    block by a time interval

You may alter a time block by typing a time interval preceded by a Plus (+)or Minus (-) sign in the 'Begin 
and End Time' field in the Schedule pane.

Examples:

+20m means add 20 minutes to the existing time

-1h means subtract 1 hour from the existing time





Schedule Shortcuts and Tips
Quickly schedule a meeting

To quickly schedule a meeting in the daily planner view, click and hold on the desired start time, then drag
the cursor to the desired end time and release. Enter the title of the meeting and it's done.

Rescheduling a meeting with Drag & Drop

Click on a meeting, then hold the mouse button while you drag the event to the new desired time (in the 
daily planner view) or new desired date (in the monthly calendars to the right of the daily planner screen), 
then release the button. Fast Drag & Drop rescheduling also works in the weekly and monthly planner 
views.

Scheduling a meeting with someone in your address book

Open both the Address Book and Daily Planner views and use the Window...Tile command to display 
them side by side, click on the desired address, and drag it to the desired time on the schedule pane (the 
meeting will be automatically linked to your address entry).

Set a Follow-up date for someone in your address book

Either enter in the follow-up date on the Address book dialog box, or simply drag a contact from the 
Address List view onto any date on the monthly calendar to the right of the daily view, onto the To-Do 
section of the daily planner view, onto the weekly view, or onto the monthly planner view.



Notes Shortcuts and Tips
Dialing a phone number stored in a Note

To dial a phone number in the Notes field of any entry (schedule, task, address, expense, or message) or 
in the Notebook section proceed as follows:

a) position the cursor at the start of the number

b) hold down the button and highlight the number

c) press the right mouse button and select Phone Dialer (Ctrl+P) from the menu

d) click on the dial button; when prompted, pick up your handset.

Launching into a website stored in a Note

To launch into a website address listed in the Notes field of any entry(schedule, task, address, or 
expense), or in the Notebook section do the following:

a) position the cursor at the beginning of the website address

b) highlight the address by holding down the button

c) hold down the right    mouse button and select Web Launcher from the menu.

d) your Browser (Netscape Navigator or Microsoft Explorer) will automatically be launched to the 
highlighted website.

Launching into an Email address stored in a Note

To launch into an Email address listed in the Notes field of any entry (schedule, task, address, or 
expense), or in the Notebook section do the following:

a) position the cursor at the beginning of the Email address

b) highlight the address by holding down the button

c) hold down the right    mouse button and select Send External Email from the menu.

d) watch your Email package appear with a pre-addressed Email message ready to send!



Address Book Shortcuts and Tips
Scheduling a meeting with someone in your address book

Open both the Address Book and Daily Planner views, use the Window...Tile command to display them 
side by side, click on the desired address, and drag it to the desired time on the schedule pane (the 
meeting will be automatically linked to your address entry).

Fast launch into a contact's website

To launch into the top website listed in the Email/Web tab of a contact in your Address Book, do the 
following:

a) click on the contact of your choice

b) click on the Web Launcher button displayed on the Menu 

c) your Browser (Netscape Navigator or Microsoft Explorer) will automatically be launched to that 
contact's website.

Fast access to a contact's Email

To launch into the top Email listed in the Email/Web tab of a contact in your Address Book, click on the 
chosen contact click on the Email Launcher icon shown on the Menu Bar. Your Email system is now    
automatically launched and the message is pre-addressed with your contact's Email address.



Phone Call Shortcuts and Tips
Dragging a contact to the Phone Dialer on the Menu Bar

To dial a number listed in the Phone Number tab of any of your contacts in the Address Book section, do 
this:

a) click on the desired contact from the Address List view on the Menu Bar

b) click on the dial button on the Menu Bar

c) highlight the correct number

d) select dial

e) when prompted, pick up your handset.

Dialing a phone number stored in a Note

To dial a phone number in the Notes field of any entry (schedule, task, address, expense, or message) or 
in the Notebook section proceed as follows:

a) position the cursor at the start of the number

b) hold down the button and highlight the number

c) press the right mouse button and select Phone Dialer (Ctrl+P) from the menu

d) click on the dial button; when prompted, pick up your handset.



Internet Shortcuts and Tips
Fast launch into a contact's website

To launch into the top website listed in the Email/Web tab of a contact in your Address Book, do the 
following:

a) click on the contact of your choice

b) click on the Web Launcher button displayed on the Menu 

c) your Browser (Netscape Navigator or Microsoft Explorer) will automatically be launched to that 
contact's website.

Launching into a website stored in a Note

To launch into a website address listed in the Notes field of any entry (schedule, task, address, or 
expense), or in the Notebook section do the following:

a) position the cursor at the beginning of the website address

b) highlight the address by holding down the button

c) hold down the right    mouse button and select Web Launcher from the menu.

d) your Browser (Netscape Navigator or Microsoft Explorer) will automatically be launched to the 
highlighted website.

Inserting today's date and time in a note

To add today's date or the time in the Notes field of any entry (schedule, task, address, expense, or 
message) or in the Notebook section proceed as follows:

a) in the notes field, hold down the right mouse button

b) highlight Insert

c) select Insert Date, or Inside Time

d) watch the date or time appear instantly!



Email Shortcuts and Tips
Fast access to a contact's Email

To launch into the top Email listed in the Email/Web tab of a contact in your Address Book, click on the 
chosen contact click on the Email Launcher icon shown on the Menu Bar. Your Email system is now 
automatically launched and the message is pre-addressed with your contact's Email address. 

Launching into an Email address stored in a Note

To launch into an Email address listed in the Notes field of any entry (schedule, task, address, or 
expense), or in the Notebook section do the following:

a) position the cursor at the beginning of the Email address

b) highlight the address by holding down the button

c) hold down the right    mouse button and select Send External Email from the menu.

d) watch your Email package appear with a pre-addressed Email message ready to send!

Changing months on the monthly planner view

Here are three ways to change the months on the monthly planner view:

1) Click on the monthly tabs at the bottom of the screen

2) Use the fast forward (and reverse) buttons at the bottom of the window to move by month or year, or

3) Use the scroll bar -- as you drag the scroll bar's thumb, Day-Timer Organizer will display the month 
corresponding to the thumb position.

Keeping track of Birthdays

Enter in all your friends, co-workers and families' birthdays once, and Day-Timer Organizer will remind 
you of their birthday's each year.    Click on the Add button from the Menu Bar and select Task.    Set the 
task as a yearly recurring event, and give it a week advanced notice so that you remember to send a gift 
or card etc.



Task Shortcuts and Tips
2 ways to reschedule a Task

To reschedule a task from today to tomorrow, click on the task in the To-Do list and drag it to the 
Upcoming Events list in the daily planner view.    To reschedule a To-Do to another date, Drag the Task to 
any date on the Monthly calendars on the side of the daily planner view.



System Requirements
In order to use Day-Timer Organizer, you must have certain minimum hardware and software 
configurations as described below.

Network
Day-Timer Organizer for Workgroups runs on Novell NetWare (Version 2.15 or later), IBM LAN Manager, 
Microsoft LAN Manager, LANtastic, NetWare Lite, Windows for Workgroups, other NetBIOS compatible 
networks as well as AppleTalk networks.

Note that instant messaging will not span network types (e.g. Novell to AppleTalk).

Day-Timer Organizer for Workgroups requires approximately 5 MB of disk space on a network drive for 
the program, help, and utility files.

If you have LANtastic, NetWare Lite, Windows for Workgroups, or any other peer-to-peer network, 
configure the network to allow at least:

· 17 open files per Day-Timer Organizer for Workgroups user

· 34 available locks per Day-Timer Organizer for Workgroups user (insufficient locks may penalize 
performance)

Workstation (IBM-compatible)
· An IBM 386 or higher or 100% compatible computer

· Windows version 3.1 or higher running in enhanced mode

        OR

Windows 95

        OR

Windows NT version 3 or higher

        OR

Windows for Workgroups version 3.1 or higher

· At least 4 megabytes of RAM memory

· A hard disk with 3 MB of available space

· A laser or inkjet printer supported by Windows if you plan to print calendars, address books, 
organizer pages, or other reports

Workstation (Macintosh)
· At least a 68020 processor with 32-bit addressing enabled

· A color or gray-scale capable Macintosh

· System 7.0 or higher

· At least 2 megabytes of available RAM memory; 4-6 megabytes are recommended



· A laser or inkjet printer if you plan to print calendars, address books, organizer pages, or other 
reports

Capacity Limits
Day-Timer Organizer's capacity limits are as follows:

· 240 categories plus 16 groups

· 500,000 entries per database

· 60,000 characters of text per entry

Network capacity limits are:

· 64 private names and 16 private groups per user

· 720 shared assignee or user names or resources and 48 shared groups 

· 240 private categories and 16 private category groups per user

· 700 shared categories and 48 shared category groups



 The Tools Menu
The Tools menu provides a collection of features:

Setting the Date from the Calendar
Dialing
Using the Speed Dialer
Caller ID
MailMerge
Speedup Text Search
Send External Email
Total Time and Expenses
Launch Applications 



Locking Error
An error has occurred in accessing your data.    Contact Day-Timer Technologies Technical Support.



Rebuilding Recurring Entries
This command allows you to rebuild the recurring entries in your database.    This is useful if your regular 
meetings and events are no longer being correctly scheduled and you suspect that there are problems in 
your data files.



Adjusting the Column Displays in List Views
In list views, you can adjust the columns that are displayed by clicking on the button in the top right 
corner.    A list of undisplayed columns will be shown and you can select the column(s) to be added to the 
display.



Entering Passwords
If a password has been set for your user login name or for the entire database, you will be prompted to 
enter the password when you attempt to login (and access the database).



Entering the Mail System Password
If you send mail from within Day-Timer Organizer and the mail is to be routed through an external mail 
system, you may be required to specify the user name and password that authorize you to send mail 
through that system.



 Error in ASCII File Conversion
There has been an error in converting an ASCII file.    Check at the line indicated to verify the problem and
correct it.



 Importing New Users During Data Import
In the process of importing entries, an entry was detected that belonged to an unknown user.    You can 
choose to create that user in the current database.



 New Features in Version 2.1
Version 2.1 of Day-Timer Organizer has many new features:

Top New Features

· Day-Timer Organizer is now Internet-enabled!    In the address book, you can now store Email or 
Web addresses.    Then, with a single click, you can launch your Email package or Windows 95 
Explorer/NetScape Navigator Web browser to either send mail to the specified Email address or 
to directly access the requested Web page.    You can also directly access a Web page from an 
address typed as part of a note.

· Quick fill data entry:    As you begin typing, Day-Timer Organizer will recognize what you are 
typing and fill in the rest of the word; if the match is incorrect, simply continue typing until a 
correct entry appears or you have typed the entire text.    For example, if you are entering a 
company name and you begin typing Day, if you had previously used the company name Day-
Timers, Inc., that name will be filled in automatically for you.

· Easy name finder (address view):    Now in addition to the quick letter tabs at the right, you can 
type the first few letters of a name in the Find field at the bottom of the view to quickly find a 
name in the address book.

New Planner Features

· Multi-day events are more clearly displayed in monthly view, as banners across the appropriate 
range of days.

· At midnight, any open planner views will automatically advance to the next day unless the 
program actively being used or the calendar is already displaying a future date.

· The start and end times are now entered on a single dialog to simplify specifying time for 
schedule items.

Enhanced Phone Calls and Logging

· When adding a Phone Call, you can set the call time to be in the future and click on the Set 
Alarm box.    This is a convenient way to remind yourself of a call you must make at some later 
time, because you will then receive an alarm at the specified call time.    The phone call is not a 
task or a scheduled item and therefore will not appear on the planner view.

· If you have a modem, you can auto-dial phone numbers directly from the Phone Calls tab.

· You can now specify extensions in the Phone Calls dialog box.

Updated Printing Features

· Depending on whether you are printing home or work addresses from the address book, the 
output will be sorted by the zip code of the appropriate address.    If printing both addresses, you 
can select which one prints first.



· Printing Ranges:    You can request a range of addresses for your printout (e.g. E-J) or a range of 
names (e.g. Brown-Jones).

· Printing Letter Headings on Address Pages:    You can now request that a letter heading be 
printed at the top of each page.

· Expanded List Formatting:    You can now ask for a title on the first page as well as 
headers/footers for each page of list printouts.    Text can be positioned to the left, centered, or to 
the right.

· Expanded Planner Options:    Scheduled time will be printed shaded on your planner printouts.    
Multi-day events will now automatically be printed as banners on the monthly printout to better 
visualize multi-day commitments.    You can now specify the time increments to be printed on daily
planner pages (e.g. 1/2 hours, 15 minutes, etc.).

· Option to exclude the assignee name on the printout.

· You can now change the default position for address and return address to be printed on 
envelopes.

New Notebook Feature

· A new field at the top of the note entry template allows you to create a title for your note.    The 
title of the note will be displayed in the list view for better organization.

· You can now sort the notebook alphabetically by note title, in addition to sorting by position or by 
due date.

Other Updates and Highlights

· When entering a new address, by default, the Phone tab will be displayed ; you may request that 
a different tab be displayed.

· Time tip of the Day:    A popup box of tips, including shortcuts and examples.    These tips are also 
displayed on our Web page.

· New icons have been added to provide more intuitive information on the list views.    These icons 
display in the Category column, and if they are not visible, simply resize the column appropriately
so that they are displayed.

· You can set your favorite programs to be icons within Day-Timer Organizer so that you can 
launch them with a single click.

· Extended name lengths:    up to 20 characters for categories and assignees allow for more 
descriptive names.

· The new Easy Back Up option backs up and compresses databases for storage on diskette or in 
another file.    Restore allows you to restore data from these backups quickly and easily.

· The on-line Help system has been greatly enhanced to answer your questions and help you find 
out more about Day-Timer Organizer.

· Based on user feedback, Day-Timer's software engineers have made numerous other updates to 
enhance the useability, speed and general friendliness of the Day-Timer Organizer interface.



 Internet Access (Email/Web)
When entering an address entry, from the address entry, click on the Email/Web tab to specify Internet 
addresses.    You may then specify up to four addresses.    Day-Timer Organizer detects whether the 
specified address is for Email or for the Web, and an icon will be displayed beside the address (a lightning
bolt for email, a W for Web addresses).

Running Email Directly
If you click on the lightning bolt, Day-Timer Organizer will launch your Email package and initiate a 
message, pre-addressed to the specified address.    You can simply complete the message and send it.

Accessing the Web
If you click on the W icon, Day-Timer Organizer will launch either the Windows 95 Explorer or NetScape 
Navigator and access the specified Web page.

Launching the First Email/Web address from the Address List view
Even simpler, you can click on an address entry from the address list view and then click on the Web icon
(W) on the button bar.    The first entry on the Email/Web tab for that address will be launched (either into 
your Email package, or your Web browser).

Related Topics:
Accessing Web Addresses Embedded in Notes Text



 Accessing Web Addresses from Note Text
If you have a Web address (URL) entered as part of the text of a note, you can launch that Web page 
automatically.    To do that, first highlight the Web address and then click the right mouse button.    From 
the popup menu, select Launch Web Browser, your Web browser will be launched and you will access 
the specified page.



 Setting the Delimiter For ASCII Transfers
When ASCII files are imported, the data in them can be delimited in three different ways:

· Comma + quotes

· Comma

· Tab

The delimiter type specifies how the text fields are to be separated (whether with a comma or a tab 
character) and whether or not the text fields should have quote marks around them.

Related Topics:
ASCII File Formats



 Launching Other Applications from Day-Timer 
Organizer
You can launch other applications from within Day-Timer Organizer.

Opening the Applications Launcher Toolbar
To open the applications launcher toolbar, choose the Tools...Launch Applications command.    When 
you first open the toolbar, it will be empty except for a garbage can icon.

Adding Applications to the Toolbar
To add an application icon to the toolbar, click on the control box in the upper left corner of the applcations
launcher toolbar.    From the pull-down menu, select Add Application(s).    Then choose the application to
be added by specifying the name and location of the program file.    You can also choose the location of 
the program icon on the list by specifying the Insert Before field.

Launching Applications
When an application is displayed on the toolbar, you can launch that application by simply clicking once 
on the program icon.

Deleting Applications from the Toolbar
To delete an application icon from the toolbar, drag the icon to the trash.

Displaying the Toolbar Vertically or Horizontally
You can change the toolbar from a horizontal bar to a vertical bar by clicking on the control box in the 
upper left corner of the toolbar and choosing Orientation from the pull-down menu.    You can then 
choose whether the display should be vertical or horizontal.



Merging Deluxe Databases
If you have purchased the Deluxe version of Day-Timer Organizer, you can merge one of the auxiliary 
databases into your main working database.    The Merge command allows you to select the database to 
merge.    The information will appear in your standard views, as though you had entered it in the usual 
way.




